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About this guide 

This guide describes workflow, concepts and procedures for using the Infor Distribution 
FACTS Purchase Orders module. 

Intended audience 
This guide is for FACTS end users, managers, in-house analysts, and trainers who require 
an understanding of the product and how to use it. 

Organization 
This table shows the chapters of the guide: 

Section Description 

About this guide Lists the intended audience as all users. 
Describe the purpose and the related 
documentation.  

Overview The overview section described the 
purpose of the application in terms of the 
business solutions that it provides, 
program listings, and menu trees, as 
applicable to the application.  

Work Flows & Program Concepts This section includes process flows for 
each module, program descriptions and 
concepts that are key to using this FACTS 
module. 

Transaction Procedures This section contains daily, weekly and end 
of year procedures as well as step-by-step 
processing information for entry, inquiry 
and transaction programs. 
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Related documents 
You can find the documents in the product documentation section of the Infor 
Support portal, as described in "Contacting Infor" on page 9. 

Refer to the contents of the FACTS Version 9.3 & Incrementals folder located at 
https://support.infor.com/. Click Search>Browse Documentation>FACTS> Version 9.3 
& Incrementals to view a document tree like this. 

o FACTS Version 9.3 & Incrementals
 Installation and Administration Guides

• Installation Guide
• Product Compatibility Matrix
• Hardware Guide

 Release Notes
• 9.3.0 Release Overview
• Incremental Release Notes

 Integrations
• Infor Solutions

o Infor Distribution Storefront
o eCommerce

• Credit Card
o CenPOS

• WMS
o Accellos

• Document Management
o Unform

 User Guides
• Implementation Guides
• Standard modules User Guides

Contacting Infor 
IIf you have questions about Infor products, go to Infor Concierge at https://
concierge.infor.com/ and create a support incident. 

The latest documentation is available from docs.infor.com or from the Infor Support 
Portal. To access documentation on the Infor Support Portal, select Search > Browse 
Documentation. We recommend that you check this portal periodically for updated 
documentation. 

If you have comments about Infor documentation, contact documentation@infor.com. 
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Chapter 1 Overview 

The Purchase Orders module is composed of these menus. 

PO Entry programs allow you to enter, print, and track planned special order and normal 
purchase order entry documents. 

PO Receiving programs allow you to record merchandise shipments you received, as well as 
enter goods that are received for which no purchase order exists, such as orders placed over 
the phone that have not been entered into the system. This allows you to enter and receive a 
purchase order at the same time. 

Invoice Receiving programs allow you to enter vendor invoices for merchandise received on 
a purchase order. 

Cost Contracts programs more accurately track special prices to reduce errors and ensure 
that all available price breaks are taken. 

Inquiries programs give you a way to look up past information on vendors, items, items-in-
process, and PO documents. 

Reports & Prints help you manage purchase orders effectively. The PO Status Report prints 
open purchase orders, backorders, received purchase orders or all purchase orders in 
document, vendor or item number order. The Receiving Schedule lists open purchase orders 
by promised delivery date. The Cash Requirements Report lists future payments due to 
vendors based on open purchase orders. 

End of Period programs enable you to update the system and close out Purchase Orders. 

File Maintenance programs allow you to enter, change and delete data in the system. You 
will use some of these file maintenance programs often, such as Vendor/Item F/M and Ship-
From F/M. However, most of these programs are used once during installation. We refer to 
these as Infrequent File Maintenances, which are located on the Infrequent File 
Maintenances menu. 

Infrequent File Maintenances are programs you use to set up initial data for the Purchase 
Orders system. 
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Posting to general ledger from purchase orders 
You can set transactions from Purchase Orders automatically post to General Ledger. The 
PO to GL Posting Control F/M program contains settings, which determine how to post to GL 
for PO receipt transactions. 

There are standard entries made to General Ledger when posting receipts. For example, 
when an item is received, one debits the inventory account and credits the receipts account. 
When the invoice is received for the purchase order, one debits the receipts account (i.e., a 
wash account), the tax and freight accounts and credits the accounts payable account. You 
must set up where these standard GL account numbers will come from, what they are, and 
how they are to be used. 

Receipt Register processing  
When you update the Receipt Register in the Purchase Orders module, the system can post 
a journal entry to General Ledger to debit the inventory account and credit the Receipts 
account. The invoice receipt GL posting does not take place until the AP Document Entry 
Register is updated (which is where invoice receipts GL information is carried over). At the 
time you update the AP Document Entry Register, the system debits the Receipts account (i.e., it 
is a wash account) along with the tax and freight accounts (if applicable) and credits the 
accounts payable account. 

GL account number structure and setup  
In the PO to GL Posting F/M (POF970) program you enter account number information for 
postings purchase orders to the general ledger. You must set the department and branch 
flags, to indicate whether you want the system to insert the department and branch numbers 
into the GL number when applicable. If you imbed the department and/or branch within the 
GL account number, the system looks at the department and/or branch assigned to each. 
For example, if the G/L number to post is 415-00-00 (department is fourth and fifth digits, 
branch is sixth and seventh digits), the department is 01 and the branch is 02, then the 
system posts to 415-01-02. The system inserts the department and/or branch in the proper 
place within the GL account number. You must also set up a default GL account number. 
Even if the default is not to be used, it must be entered. For each account type, you must 
select the basis, i.e., to use the default and/or use the account number from the item GL 
posting table. 
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Posting to job cost from purchase orders 
During the Purchase Order Entry program, you can post the adjustment to a job number for 
job cost. If job cost information is entered the debit (expense) account number comes from 
one of two places. If the Post Work-In-Process flag is set to Y in the JC to GL Posting F/M, 
the debit account number is a work-in-process account number. Depending on the Basis 
flag set in this record for work-in-process, the default number is used or the work-in process 
account number is assigned to the cost type for the GL posting table assigned to the job. If 
the Post Work-In Process flag is set to N in the JC to GL Posting F/M program, the 
expense account number posted is the non-stock inventory G/L number.  

The non-stock inventory account is posted from the PO to GL Posting Control F/M record 
unless the account basis is set to I and the non-stock inventory account is posted from the 
temporary inventory in the item’s GL posting table. The credit posted is not the PO receipts 
account but the JC receipts account. The JC receipts account is posted from the JC to GL 
Posting Control F/M record unless the Basis is set to J indicating the JC receipts is posted 
from the JC GL posting table assigned to the job. 

The JC Receipts account is debited in Accounts Payable (i.e., is washed in AP). 

The work-in-process or non-stock inventory GL number also posts into the Job Cost Job 
Posting Entry file. The Job Posting Register is then run which updates the WIP or non-stock 
inventory GL number to the Job Cost transaction file. This transaction file is used for billing 
purposes. 

Once billing takes place, the JC Invoice Register is printed along with the Invoice Register 
GL distribution.
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Chapter 2 Work flow and program concepts 

Purchase order entry menu 
Use the Purchase Order Entry subsystem to enter purchase orders into FACTS. Once 
entered, you can inquire on existing purchase orders, make corrections, and print as often as 
needed until the order is completely received. You can print purchase orders as you enter 
them or in batches. When entering purchase orders, you can import planned special order 
POs and convert them to actual POs. 

Work flow 
It is a good idea to run the Buyers Control Center (BCC) before entering a PO for a vendor. 
Using the BCC, you can order any items that demand action (below order point) and if the 
vendor has buying targets, any items that are below line point. 

The system does not allow you to enter a non-stocked item on a PO. If you decide to 
purchase a non-stocked item, it must first be on a work order. You can then import the sales 
order line using the special order option. The logic behind this is simple: if it is not an item 
that you want to stock (set up in the item file) and it is not sold, then why purchase it? 

You can correct and/or inquire about any existing purchase order. You can edit the purchase 
order as often as needed until it is completely received. You have the option of entering a 
purchase order number to view a particular order, or bypass this field and enter a vendor 
number if the PO number is not known. When you enter a vendor number, the system 
displays a listing of purchase orders for that vendor. You can select any displayed purchase 
order for editing or inquiry. 

Purchase orders may be printed and reprinted as often as needed up until the time that the 
purchase order is completely received. Orders may be printed as they are entered or 
corrected if they have never been printed; or they may be added to a reprint file and 
reprinted by batch. After a purchase order is printed, it must be reprinted from that point on. 
During correction and inquiry you can indicate that the PO is to be reprinted by putting the 
purchase order in the reprint file. The next batch of purchase orders reprinted includes that 
purchase order. When reprinting purchase orders you can then choose to print all purchase 
orders that were placed in the reprint file during correction. 
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Program concepts 
The Buyers Control Center (BCC) is used to analyze items for replenishment.  

The Exception Control Center is used to provide buyers with a method for addressing items 
that may require changes to replenishment parameters, gap analysis, and outstanding 
vendor returns. 

PO Entry (POE120) is used to enter vendor purchase orders into the Purchase Orders 
system and to update on-order quantities in inventory. If necessary, you can import planned 
special order PO’s during PO Entry for the vendor and warehouse you selected in the header 
portion of the screen. Each item on a planned special order purchase order optionally 
becomes a line-item on the actual purchase order. 

NOTE: It is recommended that you run the Buyers Control Center before entering a PO for a 
vendor. With the report in hand, you can order any items that demand action (below order 
point) and if the vendor has buying targets, any items that are below line point. 

PO Print (POP110) is used to print or reprint purchase orders in the purchase order file. The 
printed orders include all pertinent header and line-item information, addresses and totals. 
You can: print an alignment check, all purchase orders not yet printed, selected purchase 
orders not yet printed or reprint selected purchase orders or all purchase orders in the reprint 
file and specify warehouse(s) to print. The printing format of purchase orders is determined 
by PO Static Control F/M, this includes the depth of the purchase order is determined as well 
as whether the form is preprinted. If the vendor has a vendor ship-from address on file, this 
address is printed on the purchase order rather than the accounts payable vendor address. 

You can select to print only the vendor-item number (and not the FACTS item number) on 
the PO. If you elect to do this and the item on the PO does not have a vendor-item number 
setup in the FACTS system, then the system prints blanks on the PO in that column. 

The PO Print program can archive information to UnForm. The program saves all copies and 
reprints of purchase orders and includes bar coding information and sequencing sub-ids. 

Purchase Order Review (POE230) program, which is used to display, place or release 
documents from debit or service hold. Documents may be displayed by warehouse, order 
type, order status, origin, priority, request date and buyer. 

Document Priority 
Standardized document priority functionality is available throughout the Sales Orders, 
Purchase Orders, Inventory Control and Manufacturing Control modules. 

These document priority indicators are available for transfers, purchase orders, BOM and 
formulation production tickets and purchase orders: Normal, Rush and Service Hold.  

For purchase orders, PO Debit Hold processing is available. PO Debit Holds can be set by 
creating a debit limit for vendors in Vendor FM. An override password and security code are 
available for this function in PO Static Control FM. During PO document entry, accumulated 
currently open PO document totals for the specified vendor are checked against the vendor’s 
debit limit. When that vendor’s open PO document total exceeds a specified limit, the PO 
debit limit action is triggered for the vendor. 
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Service Hold and PO Debit Hold prevents both printing a ticket or an order and entry for 
confirmation. Changes to priority after confirmation have no restrictive effect on further 
processing of that ticket. 

The BCC provides for a Rush bump value to be added to the indicated color-coded sort 
priority. The Rush bump is set in PO Static Control FM on the BCC tab. The bump value 
increases the defaulted sort color and value on the BCC detail screen. This allows for lower 
ranked and lower priority items to shift higher in the BCC Detail hierarchy of presented rows. 
In the BCC, when calculating non-special orders to be pulled in based on backorders from 
existing SO docs, the resulting single BCC detail line is the accumulated total needed across 
all relevant SO docs. The rush value is not set on that single accumulated detail line. The 
accumulated multiple docs may have a variety of priority settings. 

Special orders originating in SO then processed by the BCC, set the BCC Rush column to 
selected if the special order has a Rush priority and the special order is not already in the 
BCC. Checking and unchecking the BCC Rush column checkbox does not change a tied 
special order SO document priority. When the BCC Rush column is checked and the PO, 
transfer, or production ticket is created from the BCC, the created document is set to Rush 
priority as the default. To create a Rush priority purchase order or transfer from the BCC, all 
lines on the BCC detail screen that are set to Buy or Transfer must be set as Rush. A 
mixture of rush and non-rush lines results in the purchase order or transfer not having rush 
priority.  

Alerts are available for document priority processing. If you are subscribed to one of these 
alerts you can access the Alert Control Center (POE410) to view and optionally dismiss the 
alerts. The alerts are raised when S4 background program, BK610, checks the 
svc_alert_action field in the corresponding document header records, or the dbt_alert_action 
field for PO debit hold actions. When a debit hold or service hold alert action or release alert 
action is issued, the alert is raised and subscribed users are directed to corresponding Order 
Review program, based on the type of alert. Refer to the Infor Distribution FACTS System 
Alerts User Guide for details.  

Planned Special Order purchase orders and transfers (TRs) 
Generally speaking, planned special order purchase orders (POs) should no longer be used 
for stocked/replenished items. The BCC will automatically pick up backordered lines and 
special orders for both purchase orders and transfers, and the existence of planned special 
order POs can actually make the replenishment process more cumbersome. 

For non-stocked items, planned special order POs can be helpful for some reporting, but are 
not required for the BCC. 

For temporary items, planned special order POs should continue to be used. 

It is recommended that you turn off planned special order PO and TR handling in SO Entry 
Options F/M (SOF915) for Stocked, Nonstocked and Uninventoried items. 

Replenishment type planned special order POs and TRs are no longer used in FACTS. 

There are several uses of planned special order TRs which are automatic: 
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• When requesting a surplus transfer to supplement or replace a recommended PO or 
TR, a planned special order TR will be created. 

• When a customer return must be sent to a consolidation warehouse for return to the 
vendor, a planned special order TR will be created. 

The Planned Special Order PO Entry (POE110) program allows you to add, change or delete 
records in the planned special order purchase order file. In Planned Special Order PO Entry, 
while viewing the planned special order POs, if the SO is on hold, an asterisk will appear 
beside the SO Doc number. This asterisk also appears on the Planned Special Order PO 
Report, and the system prints a caption at the end of the report as follows: *=SALES ORDER 
CURRENTLY ON HOLD. 

In FACTS, you can create planned special order orders by two methods: using the Planned 
Special Order PO Entry program and via any of the Sales Orders entry programs by line-item 
(where the order amount is greater than the on hand amount). 

Planned special order POs 

When a planned special order PO is created, the system checks to make sure that a planned 
special order transfer does not already exist for that sales order and line and that the order 
and line do not already exist on another planned special order PO. The vendor from the 
planned special order PO is updated back to the sales order line. When a planned special 
order PO is deleted, the sales order receipt line (SORSOL) vendor field is reset to the item’s 
primary vendor. In the S column in the browser in the lower portion of the screen you can 
also review the status of the sales order that created the planned special order PO; the S 
column displays the sales order status: H-hold, L-locked or D-deleted. Replenishment type 
planned special order POs and TRs are no longer used in FACTS. 

Special order overrides 

Special order overrides allow authorized users to manage special order quantities outside of 
normal FACTS processing. Override quantity changes are at the users own risk. The 
override ability applies to quantity and unit changes only. Override ability does not affect 
system behavior for non-special-order quantities and units from stock. Special-order stock 
still cannot be used on non-special-orders. Non-special-orders still cannot use special-order 
stock.  

Special order override privileges and messaging display are set in User Code F/M 
(SMF950). Overrides provide the ability to create situations where special-order receipt 
records are over- or under-received. This creates OS type receipt records, even when the 
special-order receipt remains under- or not utilized. Use the Item Balancing Register to clean 
up OS type records for over and under situations. 

Messages can be displayed to users with override ability to special order quantity changes. 
This provides knowledge of potential issues. Messages can be turned off, per user with 
override ability. Users without override ability will also see the relevant messages when 
changing quantity if that quantity changes falls outside allowed ranges.  

Infor recommends that the override messages are left on for all users with override ability. 
This allows users to be forewarned that their changes should be carefully considered. 
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Using the Planned Special Order PO Report as a worksheet, you can make any necessary 
changes to the items and quantities calculated by the planned special order program, before 
entering them as actual PO’s. The Planned Special Order PO Report (POR110) is used to 
print a report of planned special order purchase orders by vendor. You can use this report as 
a worksheet to edit planned special order quantities. You can specify: beginning and ending 
vendor to print, warehouse(s), planned special order orders for restocking orders and/or 
special orders. 

Report information includes: vendor number, name, review cycle, date of last PO, buying 
targets (dollars and pounds), item number and description, planned special order quantity, 
cost, cost extension, and weight. 

Non-stock items without a sales order tie 

During the quantity validation routines, the Planned Special Order PO Entry (POE110) 
program checks the Allow Purchase without SO flag located on the Main view of 
Warehouse/Item F/M (ICF920). If the flag is set to "No" and the PO is a request for a positive 
number of non-stock items, then the system displays a message indicating that non-stock 
items cannot be purchased without a sales order tie. If the flag is set to "Yes" or the request 
is for a negative amount of non-stock items, the system completes the purchase order 
processing for the non-stock items without them being tied to a sales order. 

Note that Planned Special Order PO Entry (POE110) also allows un-inventoried items to be 
purchased without a sales order tie. 

During the quantity validation routines, PO Entry (POE120) checks the Allow Purchase 
without SO flag located on the Main view of Warehouse/Item F/M (ICF920). If the flag is set 
to "No" and the PO is a request for a positive number of non-stock items, then the system 
displays a message indicating that non-stock items cannot be purchased without a sales 
order tie. If the flag is set to "Yes" or the request is for a negative amount of non-stock items, 
the system completes the purchase order processing for the non-stock items without them 
being tied to a sales order. 

Note that PO Entry (POE120) also allows un-inventoried items to be purchased without a 
sales order tie. 

During the quantity validation routines, Receipt Entry (POE210) and Non PO Receipt Entry 
checks the Allow Purchase without SO flag located on the Main view of Warehouse/Item F/M 
(ICF920). If the flag is set to "No" and the PO or Non-PO receipt is a request for a positive 
number of non-stock items, then the system displays a message indicating that non-stock 
items cannot be purchased without a sales order tie. If the flag is set to "Yes" or the request 
is for a negative amount of non-stock items, the system completes the purchase order Non-
PO receipt processing for the non-stock items without them being tied to a sales order. 

Notes 
During processing, the system automatically displays urgent notes for purchase order 
headers and lines, vendors and items based on your settings on the Notes tab of PO Entry 
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Options F/M. Refer to the Viewing/Entering Notes from Purchase Order Programs topic for 
details. 

You can enter document notes for existing non-PO receipt headers and lines. PO Document 
and line notes are available to view/edit (according to the user’s security) for all open 
documents. You also have the option to print the note on the Purchase Order. When you run 
the PO Receipt Register, the system copies document notes to the past PO record. 

You can edit all planned special order PO entry records through this program, regardless of 
how you created them. 

Vendor returns processing 
You cannot change the return quantity in Purchase Order Entry programs.  The serial/lot 
numbers are displayed from the SOCLOT file and cannot be changed. 

You can process returns for temporary items in the Buyers Control Center (POE400), 
Purchase Order Entry (POE120), Receipt Entry (POE210) and Non-PO Receipt (POE220) 
programs.   

PO Returns processing for temporary items 

You can process returns for temporary items in the Buyers Control Center (POE400), 
Purchase Order Entry (POE120), Receipt Entry (POE210) and Non-PO Receipt (POE220) 
programs. You can enter a temporary item having a negative quantity with no tie to any 
document.   

In the PO Entry Program Suite the entry of purchase orders for >0 quantities are not allowed 
for temporary items. All quantities entered for temporary items must be negative quantities. 

PO document lines tied to CRS cannot be edited; this includes lines for temporary items tied 
to CRS as well. 

When processing a CRS temporary item that is a return action of “Repair” it is possible to 
enter a Unit of Measure that does not exist for the CRS Repair Item.  When that repair is 
processed from the BCC (creating a PO), if the Unit of Measure entered in CRS is not a valid 
Unit of Measure for the CRS repair item, you will be prompted in the PO Entry Program 
Suite, to enter that missing unit of measure in UM Code F/M (ICF910) and then in Item UM 
F/M for the CRS repair before being allowed to continue with the PO. 

Vendor Return type (V-Type) records 

Entry of a temporary item in the Buyers Control Center (POE400) program creates a CRS 
Vendor Return (“V”) type document/line record just like for IC Master table (ICMAST) items.  
Entering a temporary item in the Customer Returns System in the Sales Order module also 
creates CRS Vendor Return (“V”) type document/line records.   

However, temporary item entry in the PO Entry, Receipt Entry and Non-PO Receipt 
programs does not create V-type document/line records.  In order to track a temporary item 
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return, it is necessary to create the return in Customer Returns Entry (SOE810) or via the 
Buyers Control Center (POE400). 

Refer to the following procedures for entering returns for temporary items in the Buyers 
Control Center (POE400), Purchase Order Entry (POE120), Receipt Entry (POE210) and 
Non-PO Receipt (POE220) programs: 

Adding temporary items to returns in the BCC 

Entering return (Negative qty) POs for temporary items 

Entering return (Negative qty) PO receipts for temporary items 

Entering return (Negative qty) Non-PO receipts for temporary items 

Surplus returns management 
Return surplus management is available in the Purchase Orders module for stocked, active, 
warehouse/items that are replenished if the Returns Tracking check box is selected on the 
Returns view of PO Static Control (POF980). These existing purchasing screens were used: 
Buyers Control Center Detail (POE405), PO Entry, Receipt Entry, and Non-PO Receipt 
Entry. Reporting and inquiry options were also added. Long-term and short-term surplus 
alerts when warehouse/item quantities enter a surplus condition were included in this 
enhancement. 

In the Buyers Control Center (POE400) and BCC Detail screen (POE405), auto-creation of 
surplus return records via background processing occurs if the Auto Calculate Nightly for 
Returns checkboxes are checked in PO Static Control F/M. Otherwise, auto creation of any 
return surplus records in the BCC can only be initiated by clicking “Recalculate” in the 
Returns selection. When any VRS line is created/entered within the BCC, if a free VRS 
document exists and is not tied to an existing CRS within that document already, then, that 
existing VRS document is added to rather than create a new VRS document for each VRS 
line entry. 

To return surplus on the BCC Returns Detail (POE405) screen, click Return Surplus to 
import items from 1 of 6 options: 

1 buyer long term surplus (buyer specific -always uses displayed buyer/whse/vendor 
specific) 

2 buyer short term surplus (buyer specific -always uses displayed buyer/whse/vendor 
specific) 

3 vendor long term surplus (not buyer specific -always uses displayed whse/vendor 
specific) 

4 vendor short term surplus (not buyer specific -always uses displayed whse/vendor 
specific) 

5 whse long term surplus (not buyer nor vendor specific -always uses displayed whse 
specific) 

6 whse short term surplus (not buyer nor vendor specific -always uses displayed whse 
specific) 
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Click OK to display the Import Program POE151 with the surplus (per the number 1-6 
selected) displayed.  

In the PO Entry (POE120), PO Receipt Entry (POE210), Non-PO Receipt Entry (POE220), 
the Return Surplus feature is available from the Options menu. When selected, the selection 
dialog to import items from 1 of 6 options is displayed. After selected an option, click OK to 
display the Import Program (POE151) with the surplus (per the number 1-6 selected) 
displayed.   

Surplus stock is not “tagged” as either short- or long-term surplus in FACTS. Only a 
calculation determines if some stock, as a whole, is identifiable as either short- or long-term 
surplus. If you have stock in both situations and choose to return only some of it, then 
surplus stock as a whole is reduced. Long term surplus is reduced before short term surplus. 

Entry processing  
The Purchase Order Entry processing takes place in three sections: Header, items, and 
footer processing. The upper portion of the screen is called the header portion where you 
enter the purchase order number, vendor, order date and other general information.  

After the system creates the header record, all header fields except the purchase order 
number, vendors, and Ship-From are accessible through the change header routine. The PO 
number, vendor, type, and ship-from values can only be changed by deleting and re-entering 
the PO. Refer to the PO Entry Header Information topic for field/field descriptions. 

The lower portion is called the line item portion where you enter the item number, quantity 
and cost. You have the option of changing, adding, removing line items or deleting the 
purchase order at any time during the entry process. Purchase orders can be open 
(entered), partially received, received, and deleted by line item. They can also be voided. 

The ending routine consists of final fields prior to completion of the purchase order. The 
ending routine is not accessible if you have not entered line items for the PO. At the end of 
the ending routine, the new total represents the total amount of the purchase order.  

Additional features 

All of the features available in the PO Entry program are also available in the PO Receipt 
Entry program. You can: 

• enter direct shipments. Purchase orders can be direct shipped to any customer in the 
Accounts Receivable system. You can also enter any new addresses for direct 
shipments. You can perform a credit limit check for direct ship customers. 

• enter vendor/item numbers or item interchanges in lieu of inventory control item 
numbers. The corresponding inventory item number is retrieved and displayed along 
with on hand, on order and committed quantities. 

• receive serial/lot items on purchase orders 
• import planned special order POs. 

For EWMS processing, the Purchase Order Entry (POE120) program checks to determine if 
the purchase order you are going to change has been waived by Radio Beacon. If it has you 
will not be able to modify it, if it has not, the system sends a ‘nuke’ record to Radio Beacon 
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causing this purchase order to be removed. It then needs to be reprinted in order to get it 
sent back down to Radio Beacon. 

PO Side Bar feature 
Use the PO Side Bar to display additional ordering information while in the PO Entry 
(POE120), PO Receipt (POE210), and Non-PO Receipt Entry (POE220) programs for quick 
item selection and viewing. This provides information about purchasing habits for the 
specified vendor and information about items in the line item section of PO Entry, PO 
Receipt, and Non-PO Receipt Entry to facilitate efficient purchasing choices. 

Click Show/Hide to toggle the Side Bar display off and on. Select a view from the drop box. 
For views with drag and drop functionality, click and drag one or multiple lines at a time to 
the line item section. Click Reload to refresh the contents displayed in the Side Bar area list 
box. Scrolling and go to page options are available in the lower right corner of the list box. 

You can use the Side Bar for research and review after you specify an item. Limiting, 
scrolling and double click actions, when available, are also enabled during line entry. Drag 
and Drop during line entry is not allowed. 

Refer to this table for the available Side Bar views: 

View Description  

Drag / 
Drop 
available Functionality 

B-PO 
companion 
items  

Displays all top-level PO companion items for 
all items currently on the purchase order. 
Parent items are also listed. This is item-
specific and contents change with items 
ordered. 

X Double click a line to 
launch the Item Inquiry 
(ICI610) Warehouse 
view for the item 
selected.  

S-standard 
buy  

Displays the standard buy lines for the 
vendor. This is vendor-specific and does not 
change with item selection. 

X Double click a line to 
launch Standard Buy 
Entry (POE250). The 
side bar list box is 
updated and redisplayed 
when you exit Standard 
Buy Entry.  

T-Contacts Displays contacts corresponding to the 
vendor and ship-from of this purchase order. 
The Type column indicates if the contact is 
“V” a customer contact or “S” a ship-from 
contact. This is vendor-specific and does not 
change with item selection. 

  There is no further 
action in this view. 

W-
Warehouse 
quantities 

Displays the warehouse quantities for that 
selected line. All warehouse’s quantities for a 
selected item on the order are displayed. 
This is item-specific and contents change 

  There is no further 
action in this view. 
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View Description  

Drag / 
Drop 
available Functionality 

with items ordered in Purchase Order Entry. 

N-Notes Displays notes based on vendor and item. 
This is vendor-specific and item-specific. The 
contents related to the vendor will not 
change, but content may change with item 
selection in Purchase Order Entry. 

  Select a note and 
double-click to launch 
the Note Entry 
(SME710) for the line 
and type (vendor or 
Document (header); 
Line or Item (line). 

s-Substitute 
Items 

Displays substitute items for the selected 
item. The item description, quantity and 
buying UM are also displayed. 

X Double click a substitute 
item to launch the 
Change Substitute Item 
Quantity window for the 
selected substitute item.  

O-SO 
companion 
items  

Displays all top-level SO companion items for 
all items currently on the purchase order. The 
parent item name is also displayed. This is 
item-specific and contents change with items 
purchased. 

X Double click a line to 
launch the Item Inquiry 
(ICI610) Warehouse 
view for the item 
selected.  

r-Resources Displays resources for the vendor, item and 
item class and the item’s primary vendor. 
Vendor-specific as well as item-specific. The 
contents related to the vendor will not 
change, but content may change with item 
selection.  

  Select a line and double 
click to launch the 
Supplemental Resource 
Manager (SMC910).  

t-Timeline Displays the selected item’s current timeline 
for that single item (and its receiving 
warehouse). Temporary items are omitted. 
This is item-specific and contents change 
with items ordered.  

  Select a line and double 
click to launch the 
inquiry corresponding to 
the selected line type (if 
the document is 
available). 

L-Long 
Term 
Surplus 

Displays items with long term surplus in the 
Receiving Warehouse. Alternate warehouses 
with long term surplus are included if the Use 
Surplus check box is selected in PO Static 
Control F/M and are valid for PO in 
Warehouse F/M (ICF970). If the vendor has 
purchased this item in the past, the indicator 
column displays “Y” and the quantity. 
Negative values (returns) are changed to 
positive. This is vendor-specific and does not 
change with item selection. 

X Double click a line to 
display the Change 
Long Term Surplus 
Quantity window to 
change the order 
quantity. Click Refresh 
to reset all quantities 
and values to their initial 
amounts.  
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View Description  

Drag / 
Drop 
available Functionality 

V-Vendor 
Items 

Displays items for this vendor. This is vendor-
specific and does not change with item 
selection. 

  Double click a line to 
launch the Vendor/Item 
F/M (POF910). 

C-Cost 
Options 

Displays the selected item’s current cost 
options. Temporary items are omitted. This is 
item-specific and contents change with items 
ordered. 

  There is no further 
action in this view. 

c-Cost 
Contracts 

Displays cost contracts for the vendor or 
vendor cost class, as well as any contract for 
all vendors. The displayed contracts are not 
item specific and can include items, classes 
and other information, which is not specific to 
this purchase order. 

  Double click a line to 
launch the Cost 
Contract Entry 
(POE510) (as inquiry 
only).  

P-Past 
Purchases  

Displays prior purchases by vendor. This is 
vendor-specific and does not change with 
item selection. 

X Double click a line to 
launch PO Document 
Inquiry (POI620) for the 
selected PO receipt.  

p-Open 
Purchases 

Displays the selected item’s current open 
purchase orders for that single item. This is 
item-specific and contents change with item 
selection. 

  Double click a line to 
launch the PO 
Document Inquiry 
(POI620) for the line 
selected.  

b-BCC 
Activity 

Displays the current records in the Buyers 
Control Center (POE400) for this selected 
buyer+warehouse+vendor combination.  

  There is no further 
action in this view. 

 

Buyers Control Center  
The initial screen of the Buyers Control Center (BCC) is referred to as the summary screen. 
The summary screen is launched from the Purchase Orders, Inventory Control, and 
Manufacturing Control modules with the appropriate activity code selected. The columns and 
options differ slightly based on the Activity selected, but the process is very similar.  

These five BCC menu options are available in FACTS.  

Path  Menu option Activity code  

Purchase Orders>Entry  Buyers Control Center 
Purchase  

Procurement 
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Purchase Orders>Entry  Buyers Control Center 
Return 

Returns 

Inventory Control>Warehouse 
Transfers  

Buyers Control Center 
Transfer 

Transfers  

Manufacturing Control>Bill of Materials  Buyers Control Center BOM Build Bill of Materials  

Manufacturing Control>Formulation  Buyers Control Center FML Build Formulation 

Upon entering the BCC, buyers can specify a buyer code and warehouse to review the 
current actions. 

From the Activity pull down you can choose Procurement, Transfers, Returns, Build Bill of 
Materials, or Build Formulation to perform. User security must be set in Program Security 
Maintenance (SMF420) for each user and activity code.  

A prioritized summary of each ARP or warehouse activity is displayed. 

These activities are available in the BCC: 

Procurement  

Transfers  

Returns  

Build Bill of Materials  

Build Formulation  

Procurement  
Use the Buyers Control Center (BCC) to analyze items for replenishment.  

Replenishment basically comes down to answering three questions:  

• When should I place an order/transfer for an ARP? 
• What items should I order when I do place the order?  
• How much of each item should I order? 

All of the replenishment controls and values exist to answer these three questions quickly 
and accurately, and the Buyer’s Control Center is the primary place the questions are 
answered. 

The initial screen of the BCC is referred to as the summary screen. It allows you to identify 
the buyer code and activity (Procurement, Transfers or Returns) you want to perform, then 
presents a prioritized summary of each ARP’s activity. 

Upon entering the BCC, buyers can specify a buyer code and warehouse to review the 
current buying actions. 

The columns and options differ slightly based on the Activity selected, but the process is very 
similar. The Activity pull down will allow the buyer to choose Transfers to review the planned 
special order transfers. Similar to the Procurement process, a prioritized view of the items for 
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transfer will be displayed with the recommended quantities. A transfer for a warehouse can 
also be assembled and created from within the BCC. For now, we will focus on the 
Procurement activity. 

Each ARP assigned to the selected buyer will be displayed and color coded to indicate the 
priority of the replenishment activity needed for items in the ARP. The summary data 
includes three sections: general data, buying targets, and prioritization: 

The general data section includes the ‘To’ warehouse, vendor # and name, the purchasing 
line and the established review cycle. 

Determining When, What and How Much involves some significant data analysis and math. 
FACTS reviews every item in every ARP assigned to the buyer, and uses the replenishment 
controls which were calculated the night before to answer those three questions. 

That analysis also looks at current open orders for any backorder or special order needs, so 
it can take some time, especially on systems with a high number of SKUs, so it is not done 
automatically. At least daily, buyers should run the “Recalculate All” option, which performs 
the analysis on all ARPs and redisplays the prioritized results. 

The summary screen of the BCC primarily answers the question “When to buy?”, though it 
does also provide the achieved amounts for the recommended order, which combines the 
“What” and “How Much” questions. 

Vendor returns can also be viewed and processed from the BCC by selecting the Returns 
option from the Activity pull down. Once selected, the items pending for Vendor return will 
appear and can either be consolidated or processed as needed for return shipment. Items 
that are returning to alternate warehouses will available and a Warehouse Transfer can be 
created from the Source Detail for processing. Procurement is the default activity for the 
screen. 

In the Filters Section, you can further define the browser line display by specifying vendor 
code, whether to display the achieved amount, weight and cubes as a quantity or a 
percentage of the targets. For the Show setting, specify the type of activity to display in the 
browser: All Activity or Actionable activity to indicate whether to display lines that do not 
require replenishment so you can initiate on demand purchase orders. 

Browser display 

After you specify information in the header portion of the screen, replenishment lines for the 
warehouses and vendors specified are displayed in the browser.  

In the Include section, the checked prioritization categories indicate the types of orders that 
are displayed in the Lines browser. Click Change ARP Filter to modify what is included in 
the Lines display for each individual line. Note: When a line is recalculated, the ARP filters 
are reset to the default settings.  

The prioritization filters include information on how the ARPs were prioritized and includes 
the number of items/lines that fall into the following categories (Note: PNA is “Purchasing Net 
Available” and equals On Hand - Committed - Backordered + On Order): 

Spec Ord – Items with existing special orders. For an uninventoried, temporary or catalog 
item that is back-ordered, the item will be picked up as a special order in the Buyers Control 
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Center, unless the document is placed on service hold, credit hold or the document is 
currently in use. 

Backorder – Items that have open backorders. 

Critical – Items where PNA is less than safety stock quantity. 

Neg PNA – Items where PNA is negative. (i.e. if all open purchase orders arrived now, there 
would still not be enough to fill current needs) 

Replenish – Items where PNA is at or below order point. 

Show Items Above Line Point- All of the items in this ARP, even if they are not ready to be 
ordered. Items that are not ready to be ordered will be displayed with a Purchase Quantity of 
0, but it can be useful to see all of the items in the ARP, and it allows you to investigate why 
FACTS is not recommending you purchase an item. 

Rank - filter the display by a specified rank, for stocked and replenished items. 

Note: Any item that does not fall within one of the above categories will be color coded white. 
For example, an item that is above order point but below line point would show up colored 
white. 

Buying targets 

The buying targets section includes: 

Ach Amt – “Achieved Amount” is the total cost of the current recommended order. 

Target Amt – This is the buying target for cost as identified in Review Cycle Setup. 

Ach Weight – “Achieved Weight” is the total weight of the current recommended order. For 
this value to be accurate, you must have entered and maintained weights for each item and 
UM in Item F/M, UM F/M. 

Target Wgt – This is the buying target for weight as identified in Review Cycle Setup. 

Ach Cubes – “Achieved Cubes” is the total cubes of the current recommended order. For this 
value to be accurate, you must have entered and maintained cubes for each item and UM in 
Item F/M, UM F/M. 

Target Cubes – This is the buying target for cubes as identified in Review Cycle Setup. 

The prioritization section includes information on how the ARPs were prioritized and includes 
the number of items/lines that fall into the following categories (Note: PNA is “Purchasing Net 
Available” and equals On Hand - Committed - Backordered + On Order): 

Spec Ord – Items with existing special orders 

Backorder – Items that have open backorders 

Critical – Items where PNA is less than safety stock quantity. 

Neg PNA – Items where PNA is negative. (i.e. if all open purchase orders arrived now, there 
would still not be enough to fill current needs) 

Replenish – Items where PNA is at or below order point 
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Surplus Tr – Items that are on a planned special order surplus transfer 

Note: Any item that does not fall within one of the above categories will be given a fixed sort 
value of “10”, and color coded white. For example, an item that is above order point but 
below line point would show up with a sort value of “10” and colored white. 

You can double click a line to access the Buyers Control Center Detail screen to view 
detailed information about the replenishment path; make changes, or create purchase 
orders, transfers or returns. 

When to place an order 
Any ARP that is color-coded on the summary screen should be reviewed for whether an 
order should be placed. Generally speaking, the higher the ARP appears in the summary 
screen, the more urgent it is that an order be placed. 

Typically, an order should be placed when any “worthy” item in the ARP is at or below order 
point. There are exceptions, and buyers will sometimes delay placing an order depending on 
their willingness to risk stock outs of the items in question. 

When deciding “When” to place an order, we do not consider where we are in the ARP’s 
review cycle. If we have worthy items that will stock out before the next planned order, we 
don’t want to just let the stock out happen because we didn’t expect to place another order 
this soon. FACTS analyzes all of the items in the ARP and presents needed replenishment 
activity regardless of where they are in their review cycle. 

However, as you will see, review cycle is far more important to answering “What” and “How 
Much”. It’s just not used to determine “When”. 

What to order 
Once it’s determined that you should place an order with a vendor or distribution center 
(remember, that is based on having any worthy items at or below order point), the next 
question is “which items should I order?” 

To answer this question, we need to revisit Line Point. 

Line point = order point + (review cycle days times average daily usage), and is generally 
considered to be the stocking level we want to order up to, with some possible adjustments 
like economic order quantity (EOQ) and vendor or transfer rounding (more on that when we 
get to “How Much”). 

Normally, when placing an order, we should be ordering all items that are below line point. 
This keeps the entire line of products for this ARP balanced with each other, making it easier 
to make buying targets regularly. 

At this point, we need to take a closer look at the Buyer’s Control Center Detail screen. You 
get to this screen by double-clicking one of the ARPs on the summary screen. 
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When you return to the Buyers Control Center from the Buyers Control Center Detail screen, 
the replenishment lines you accessed display at the top of the browser with the warehouse 
highlighted. 

You can select View>Replenishment Math to see values and detailed calculations for a 
warehouse/item combination for the replenishment line highlighted in the browser. 
Replenishment Math information includes calculations for: Order Point, Line Point, Order 
Quantity and Recommend Order Quantity. 

Line-buy processing 
The Buyers Control Center uses line-buy processing. That is buying everything in the 
product line that you purchase from this vendor or vendor/to whse / purchase line 
combinations and increase all purchase quantities up to line point (the amount of stock you 
purchase up to for an item). 

After using the Recalculate All function in the Buyers Control Center, double click a browser 
line to drill down to perform a 'line-buy, an emergency buy, or a below order point buy.' 

You can also perform an ‘emergency buy’ on any line on the Buyers Control Detail screen by 
right-clicking and selecting Set All Buy to No so that you only purchase critical items & 
special orders. 

Using default buyers for approved replenishment paths 
In Replenishment Parameter Maintenance (ICF990) you can specify a default buyer under 
the Review Cycle parameter. By doing this, you create a default buyer for a warehouse, so 
that if a buyer does not exist for an approved replenishment path (ARP), a default is 
available for returns, purchase orders (procurement) and transfers to be processed in the 
Buyers Control Center. For example, the new default buyer can be used for special orders 
and Order-as-Needed (OAN) items for a path that is not part of the normal replenishment 
process. The default buyer will also be applied for transfers if the Review Cycle does not 
exist for a given ARP (Warehouse + From Warehouse). 

Using the default buyer setup for a warehouse, you can select Recalculate All to display lines 
for each ARP associated with the default buyer. These lines are the ‘temporary’ ARP for the 
given Warehouse + Vendor or Warehouse + From Warehouse and do not have a specific 
Warehouse + Vendor or Warehouse + From Warehouse scope set up in Replenishment 
Parameter Maintenance. The lines will not appear in the Buyers Control Center until you 
select the Recalculate All option and will remain unprocessed without further action. 

Example Scenario: 

Complete the following to create a Default Buyer for alternate an ARP. 

Create the Default Buyer for Warehouse 01 in Replenishment Parameter Maintenance. Set 
the Buyer code to 100. 

Specify a sales order for item I100 for warehouse 01. Note: In our example, the item is a 
non-stock item from vendor V100 and a quantity is entered and backordered. 
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[Note: A Review Cycle does not exist for Warehouse 01 + Vendor V100 in the 
Replenishment Parameter Maintenance for scope "D - Warehouse + Vendor".] 

Access the Buyers Control Center and select buyer 100 and Procurement activity 

[ *** The replenishment path for warehouse 01, vendor V100 will not appear in the BCC list 
view ***] 

Click the Recalculate All action. 

[The system will locate the item I100 and create the line for Warehouse 01 / Vendor V100.] 

The line is displayed in the grid and can then be processed and a PO created using the 
same methods for established ARPs. 

Using Surplus Inventory to fill Replenishment 

Surplus selection is enabled by setting the Use Surplus setting in PO Static Control F/M. 
When the flag is set, the Buyers Control Center will display an additional column for Surplus 
for each item.  

When there is surplus stock available in an alternate warehouse, the Surplus column cell will 
show the total surplus quantity and will be highlighted yellow. If the receiving warehouse 
already is in a “surplus” state then the Surplus cell is colored red to indicate that the PO or 
transfer, if created/completed, would increase the warehouse’s surplus. 

Clicking on the yellow or red Surplus cell presents you with a list of the alternate 
warehouses that have long- and short-term surplus and the quantities. From any non-
highlighted warehouse with surplus, you can select the quantity and create the transfer 
immediately. 

Returns 
The Buyers Control Center integrates with the Customer and Vendor Returns system to 
show items for transfer to a consolidation warehouse, transfer to an alternate warehouse, or 
return to a vendor. The items are displayed when you access Buyers Control Center Return 
on the Entry menu. The Activity defaults to Returns. 

The integration with the Customer and Vendor Returns system allows the Buyers Control 
Center to maintain proper document and item flow. The Customer and Vendor Returns 
system will supply the action code for the item’s return processing method. The Buyers 
Control Center will prompt for actions as defined by these settings. The action can be a 
direct return to the vendor or returning of the item to a consolidation warehouse as an 
example. Once the appropriate action has been taken, the Customer and Vendor Returns 
system will be updated to reflect the new status of the item. 

You can initiate returns processing for additional vendor/warehouses by clicking Add Return 
Vendor on the Buyers Control Center (POE400). A dialog displays for entry of the From 
Warehouse and To Vendor. 

Note: The addition of a consolidation warehouse for an item will prompt the buyer if deviating 
from the designated return path. The system will display an alert message and allow the 
buyer to continue processing as needed. The consolidation warehouse is maintained in the 
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Vendor File Maintenance and if omitted, warehouse transfers for item returns will not 
generate this message. 

When processing returns in the Buyers Control Center, any buyer, by default, can view all 
open returns and assume any return. In the Buyers Control Center, when you specify a 
buyer and select Returns, drilling to the detail of the return automatically ties the return to the 
buyer and when creating purchase orders, the buyer will be entered on the purchase order. If 
you back out of the detail view without creating a PO, the return path (Warehouse + Vendor) 
will become available to other buyers. You can also process returns for temporary items. On 
the BCC Detail screen, you can specify temporary item in BCC Return Grid and manage 
temporary items entered from the Customer Returns System in the Sales Orders module.  

You can initiate returns processing for additional vendor/warehouses by clicking Add Return 
Vendor on the Buyers Control Center (POE400). A dialog displays for entry of the From 
Warehouse and To Vendor. 

Transfers 
Transfer processing verifies that planned special order transfer lines still exist when loading 
the line grid or when creating transfers from the Buyers Control Center Transfer. If the 
planned special order transfer was used (from the Customer Returns System, etc.) and is no 
longer on file, the system displays a message prompting you to review the changes. Be sure 
to specify the Ship Via for the carrier for transfers on the BCC Detail screen. 

MC Production tickets 

Exception Control Center  
The PO Exception Control Center (ECC) provides the buyer(s) with a method for addressing 
items that may require changes to replenishment parameters, gap analysis, and outstanding 
vendor returns. You must enter a buyer and warehouse to review the data. The ECC is 
populated using the System Alerts and Background Process. Processes will periodically 
execute update routines for the alerts to display. These alerts are classified as type “<ECC>” 
and contain reference information for display and processing. For example, an alert 
corresponding to frozen controls about to expire would include the scope information and 
direct the user to the Replenishment Parameters Maintenance for review and updating. 

The System Management system alert and background processing routines facilitate any 
actions needed to feed into the Buyers Control Center and Exception Control Center. The 
system has a defined set of routines and the update interval required to perform the 
exception and replenishment calculations. In addition, order point and line point adjustment 
routines receive updates during system register processes. Receipt of items adjusts the 
order point based on lead time changes for example, and occur automatically at preset 
intervals. The background processing agent is responsible for handling these updates and 
providing the data to the system. 

The alert system notifies via the Exception Control Center and additionally can be configured 
to notify users via email for certain conditions. A buyer may want to be notified of abnormal 
lead times upon receipt of items via email. This is accomplished by a buyer subscribing to 
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specific alert types and supplying their user code and email information. When an alert is 
generated, the alert system records the information for display in the Exception Control 
Center and sends a summarized message to the user’s inbox. 

The system background processes have various settings applied based on the business 
need. For example, expiring T-Min and Frozen Controls are updated in daily intervals by 
default, whereas Frozen Products with Hits can be updated hourly. These settings are 
tunable and can be adjusted by business, system resource, or other needs as determined by 
the environment. 

Receiving  
The purchase orders receiving menu allows you to receive items from purchase orders and 
non-purchase orders. You can change receipt information any time before you update the 
Receipt Register. 

You can access the following programs from the PO Receipts menu: 

The Document Fill Report is used to print a report and check whether purchase order 
receipts should be stocked in the receiving warehouse or used to fill open customer orders. 
After running this report, you can run the Receipt Register to provide an audit trail and 
update all receipts and inventory quantities. 

The Receiving Document Print program is used to print a report of the items on the original 
purchase order to use when reconciling items purchased against the items received at the 
time of delivery. The Receiving Document Print should be run just prior to the receipt of 
goods. This report enables the user to reconcile the goods arriving with those on order. 
Report information includes PO number, warehouse, promised date, and vendor. For each 
line item information includes; item number, item description, quantity, unit of measure, bin 
location, sales order number, and line number for special orders or the job number to post to, 
if one exists. 

The Receipt Entry program allows you to receive purchase orders created through the PO 
Entry program. You can enter receipt numbers manually or let the system assign them. You 
can automatically set the received quantity equal to the order quantity or you can enter it 
manually. If you don’t know the purchase order number, you can search for it by vendor. 
Backordered items remain in the purchase orders file after receipt. You can also receive non-
stocked items. Once a purchase order is received in full, it is no longer available through the 
PO Entry program. Once you create a receipt, you access it via the Document Inquiry 
program make change to the receipt document via the Purchase Orders Receipt Entry 
program. You cannot change purchase order receipts that have been updated by the 
Purchase Orders Receipt Register. 

The PO Receipt Entry screen is very similar to the PO Entry screen. In addition to the 
common header information, PO receipts include a receipt number and receipt date. In 
Receipt Entry, purchase orders and backordered purchase orders with a status of "P" or "R" 
can be received and edited. Once you receive a purchase order, it is no longer available 
through the PO Entry program. However, changes to received purchase orders may be 
made prior to the Receipt Register through this Receipt Entry program. 
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For EWMS processing, the Receipt Entry (POE210) program does not allow modifications to 
the receipts quantities of radio beacon controlled lines. You are allowed to change costs. 
You are not allowed to enter new stocked items to receipts, but you can enter non-stocked 
items. 

The Non-PO Receipt Entry program is used to receive items not listed on a purchase order. 
Non-PO Receipt Entry is useful for phone orders or other situations where purchase orders 
may not exist. This program allows you to enter and receive a purchase order at the same 
time. You can manually assign this type of receipt a non-purchase order number or allow the 
system to automatically assign non-PO receipt numbers. You can enter either the item 
number or vendor-item number. You can also enter non-stocked items in this program. This 
program does not change on-hand inventory item quantities--inventory quantities are not 
updated until you update the Receipt Register. 

Use the non-PO Receipt Entry program to receive purchase order merchandise from 
purchase orders not generated through the Purchase Orders system. For example, if an 
order is placed over the phone but never entered into the system, when the merchandise 
arrives it must be received. Such receipts are assigned non-purchase order numbers. The 
non-purchase order number may be manually assigned or automatically assigned by the 
system. Non-PO numbers begin with the letters, ‘NP’ and behave as follows: the NP portion 
moves to the left as the number grows past 4 digits, so, the default for non-pos less than or 
equal to 9999 will be ‘NP4321’ and as the number increases the NP will slide left, like 
NP54321, NP654321, etc. Smaller numbers are zero filled, like, NP0023, so that there will 
always be four digits after the NP. The biggest NP number can be NP9999999999 – after 
that the number will reset to ‘1’, e.g. NP0001. 

For EWMS processing, the Non-PO Receipt Entry (POE220) program does not let you 
receive stocked items into a Radio Beacon Controlled warehouse. 

The PO Receipt Entry and Non-PO Receipt Entry programs allow more than one receipt on a 
PO without running the PO receipt register in between, based on settings in PO Static 
Control F/M (POF980). Using the Update feature, when the user (with proper security) 
accesses the footer, the program provides the option to update the receipt, which adjusts 
item and warehouse quantities during PO receipt processing. This allows the received items 
to be sold or shipped immediately. Refer to the PO Receiving Feature: Multiple Receipts on 
a PO topic for details. 

Once you enter receipts, use the Document Fill Report (ICR350) to check customer orders 
and see if received purchase order items are to be warehoused for inventory or used to fill 
open customer orders. Use this program to advise warehouse personnel of what backorders 
can be filled with the incoming merchandise (received purchase orders and transfers) before 
the Transfer Receiving Register is run. The report can be run for special order lines (those 
tied to an SO) and/or restocking (those not specifically tied to an SO). Received Purchase 
Orders print first and then the received Transfers. The program prints a page break between 
the two types of documents. In addition, because transfers entry now has the capability to 
backorder quantity, the document lines that could be filled by incoming stock will also include 
transfers. The backordered sales order lines will print first and then the backordered transfer 
lines. The alternate bin locations are print on the report based on the IC Static Control F/M 
setting, Print Alt Locations on Transfer Fill. 

The Receipt Register is used to provide a complete audit trail of all receipts. From this 
program, you can also create and print the General Ledger distribution, if needed. The 
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update portion of the Receipt Register updates on-hand quantities and costs, activities, 
history files and period receiving files and also optionally updates General Ledger. Once you 
enter regular and non-purchase order receipts and run/review the PO optional Fill Report, 
you should the PO Receipt Register. 

Use the Receipt Register program to: print a register of purchase order and a non-purchase 
order receipts; optionally build and print a general ledger distribution, based on settings in 
the PO to GL Posting F/M; post to general ledger, if needed, copy PO document notes to 
past PO notes and deletes notes when PO document is deleted or line complete, and update 
inventory quantities (if needed), costs and activities, purchase order history files, the 
purchase order period receiving file, the purchase order receipts file and the job cost files. If 
the cost is a contract cost, the system does not update the last cost with the contract cost 
value and sets the contract cost flag for the line. 

Purchase Orders with receipts that were updated in PO Receipt Entry or Non-PO Receipt 
Entry still need to go through the Receipt Register to update GL and invoice files. For 
purchases orders updated in PO Receipt Entry and Non-PO Receipt Entry, the Receipt 
Register skips updating inventory but updates all other files in the register. If a receipt was 
not updated in PO Receipt Entry or Non-PO Receipt Entry, the Receipt Register updates on-
hand inventory files as well as GL and invoice files. 

Lead Time: The PO Receipt Register flags abnormal (A) lead time for stocked items where 
the Replenish flag (on the Main screen of Warehouse/Item F/M (ICF920)) is "Y" before 
checking all other conditions that would flag the item with an abnormal lead time. 

Templates that store "current period" (or similar values like "system date") resolve to the 
"current period at the time the report is run" rather than what the "current period" was at the 
time the template was created. For example: If you save a template for the PO Period 
Receipts Report and select "Current Period" for the Period field, when that template is 
selected to run again (either manually or via Job Stream) the current period is determined 
using the setting of Current period in the PO Non-Static F/M. 

Purchase orders tied to special orders NOTE: When the system updates purchase orders 
tied to special orders in Sales Orders, i.e., the line item on the PO is directly tied to the line 
item on the SO, it also updates the sales orders. The special order line item on the sales 
order (optionally including serial number) becomes committed by the quantity received on 
the line item of the PO. 

Receipt Register information includes the following: purchase order number, receipt number, 
vendor, ship-to and buyer. For each line item on the order, the item number, description, 
requested date, promised date, received date, ordered, received and backordered quantities, 
cost and extension and total (including tax and freight) are displayed. The report also 
includes totals of line-item extensions and purchase order receipt totals. 

Returns processing 

Based on the Auto Create Docs setting in CRS Control F/M (SOF980), credit memos and 
sales orders are created during the AP Document Entry and Adjustment Register and PO 
Receipt Register updates when document/line processing is complete.  Then, if any CRS 
doc lines were updated those CRS docs’ lines can be created on a single credit memo 
and/or sales order (allowing multiple lines of a single CRS doc which may be spread across 
multiple POs to create a single CM/SO for all applicable/matching CRS doc/lines). Note that 
auto-creation of docs is an “All or nothing” setting. Either the docs are auto-created or the 
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user, after processing the registers, must access CRS Entry and click Create Docs (for each 
relevant CRS doc) to create the docs that would have been created had the auto-create 
setting been selected in CRS Control F/M. Use the CRS Status Report (SOR820) to 
determine which CRS docs to access in CRS Entry (SOE810) and click Create Docs. 

Note: If during register processing for auto creation, there is a CRS doc and line which would 
create a credit memo/sales order, but, later after this CRS line was created, an additional 
‘new CRS line’ was created and its acknowledgment was printed (but the user chose not to 
create the credit memo/sales order when prompted in CRS Entry), both the original line 
found during the register and the new line which was not yet decided to create credit 
memo/sales order for will be available for processing, and both lines will be created on the 
credit memo/sales order. 

Return Surplus Management: If the Returns Tracking setting on the Vendor Returns tab of 
PO Static Control (POF980) is selected the PO Receipt Register Update writes information 
to the Returns File. This information (item, description, warehouse, returns code, purchase 
order number, etc.) can be printed by the PO Returns Report. 

Multiple bin locations on receiving documents 

If the PO Static Control F/M setting, Alternate Locations on Receiving Document, is set to 
yes and the item has alternate bin locations, the Receiving Document Print program prints a 
second line listing all of the alternate locations and then prints a blank line after. If the PO 
Static Control F/M setting, Alternate Locations on Receiving Document, is set to no or the 
item does not have alternate locations, no additional lines print on the receiving document. 

Direct shipments 

You can enter direct shipments. Non-PO Receipts can be direct shipped to any customer in 
the Accounts Receivable system. You can also enter any new addresses for direct 
shipments. You can perform a credit limit check for direct ship customers. 

You can enter vendor/item numbers or item interchanges in lieu of inventory control item 
numbers. The corresponding inventory item number is retrieved and displayed along with on 
hand, on order and committed quantities. 

You can automatically assign serial numbers. 

Invoice receiving  
The Purchase Orders Invoice Receiving menu allows the user to enter vendor invoices for 
merchandise received on a purchase order. A register may be run to list and update all 
invoice receipts. A report may also be run to list all purchase order receipts for which no 
invoice has been received. 

Invoices for the receipt of merchandise from purchase orders may be entered through the 
purchase orders Invoice Receipt Entry. You can modify or delete invoice receipts until they 
are run through the Invoice Receipt Register. It is available only if the Use Invoice Receipts 
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flag in the PO Static Control F/M is activated. Invoice Receipt Entry replaces the Document 
Entry program in Accounts Payable and is used to enter only invoices for merchandise 
received on a purchase order. As with the Accounts Payable Document Entry program, the 
invoice is entered and must be expensed to one or more general ledger account numbers. 

The information you enter via this program appears on the Invoice Receipt Register. The 
number of units received, the number of units invoiced, the cost of the item when it was 
received and the cost of the item on the invoice are all stored in the invoice receipts file. 
Information on the cost and number of units received is retrieved from the purchase order 
receipts file and stored in the invoice receipts file. During Invoice Receipt Entry these 
amounts are compared to locate discrepancies between received and invoiced amounts. Any 
discrepancies may be reported through the Period Discrepancy Report. This feature provides 
a method to ensure that invoice amounts match the amounts actually received. 

The Invoice Receipt Entry screen consists of two sections. The upper portion of the screen is 
called the header portion where the document number, date, amount, vendor and other 
general information are entered. The lower portion of the screen is called the line item 
section where line-item corresponds to a particular received purchase order line-item and 
contains information (purchase order number, receipt number, item number, cost, etc.) 
specific to that item. If the cost is a contract cost, the system sets the contract cost variable 
for the line that includes a contract cost for an item. If you modify the cost on a line, the 
contact cost flag is not updated. 

The Invoice Receipt Register provides a complete audit trail of invoices to be posted to 
accounts payable. Invoices are not posted until the Invoice Receipt Register is updated. If, 
when running the register, it is incorrect; the user may choose not to update it, go back into 
the entry program correct the receipts and run the register again. You can use this report as 
a tool to locate discrepancies in invoice amounts and actual received amounts. The optional 
update creates documents in the AP document entry file, updates the PO receipt line status 
to complete in various purchase orders files, and once all lines on a receipt are completed, 
removes invoice receipt and purchase orders receipt records. This program is available only 
if the Use Invoice Receipts flag in the PO Static Control F/M is activated. 

Report information includes the following information: vendor number, document (invoice) 
number, branch, total amount, period, due date and payment terms. Each line of the invoice 
includes purchase order number, receipt number, item number, description, received 
quantity, invoiced quantity, cost at time of receipt, cost on invoice, the extension (invoice 
quantity multiplied by the invoice cost) and the GL account number. An asterisk (*) is printed 
on any line where the invoiced amount is unequal to the received amount. Vendor and 
register totals are also included. 

If the cost is a contract cost, the system does not update the last cost with the contract cost 
value and sets the contract cost flag for the line. 

NOTE: This register does not print a GL distribution or post to General Ledger. During the 
update, the program writes documents to the AP document entry file. You should run the AP 
Document Entry and Adjustment Register immediately following this update. The AP register 
prints the documents to post into the open payables file and prints the GL distribution (if 
used). The update posts documents to the open payables file and optionally posts to General 
Ledger. 

The Uninvoiced Receipts Report output lists all purchase orders which have been received, 
but for which no invoice has been entered. After the Invoice Receipt Register has been run 
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only un-invoiced receipts remain on file. This program is only available if the Use Invoice 
Receipts flag in the Purchase Orders Static Control F/M is activate. 

The Invoice Receipt Register update removes, from the purchase orders receipts file, all 
purchase orders for which invoices have been entered. Therefore, only un-invoiced purchase 
orders remain in the file after the Invoice Receipt Register Update has been run. Those 
records are available for printing through the Uninvoiced Receipts Report. 

You can specify: beginning and ending vendor, and warehouses to print, beginning and 
ending received dates to include, and whether to print vendor totals and summary or detail 
information. 

Report information includes the following: 

Summary: vendor number, name, purchase order number, receipt number, received date, 
warehouse and total amount of the purchase order. 

Detail: summary information plus item number and description, units and cost for each 
purchase order. 

Vendor Totals: totals for purchases (including factored freight), freight and tax. 

Cost contracts  
Many vendors offer special prices (the distributor’s cost) for items or groups of items. You 
can use Cost Contracts to more accurately track special prices to reduce errors and ensure 
that all available price breaks are taken. 

Access Cost Contract Entry (POE510) to enter contracts. When you add lines to purchase 
orders, the default cost is calculated. If you override that cost during the entry process, the 
cost override flag is set and the origin of any cost entered is captured and stored in the 
purchase order line item file. That cost and origin is also transferred to the past purchase 
order line file. You can view the cost origin in the line detail of the PO Document Inquiry or 
during line detail in the PO entry programs. Use the Contract Listing program to print the 
detail of contracts that are on file. As contracts expire, they can be purged using the Cost 
Contract Removal (POU510) program. Inquiries are available for viewing contracts on file for 
a vendor. 

You can access the following programs from the PO Cost Contracts menu: 

Cost Contract Entry (POE510) is used to enter contracts for specified vendors. This program 
allows you to enter cost contracts for vendors. You can store cost contract information by 
vendor, including costs that get calculated from other values, like list price. Cost contracts 
establish the default cost that gets entered on purchase orders. Cost contracts can be based 
on specific items, items of a specific cost class, or all items, and the default cost must be 
selectable by vendor. Contracts can be specific to a warehouse or valid for all warehouses, 
and they can only be valid when selling to a specific customer (via a special order). When 
you enter contract lines, the Scope determines the entry fields that display (e.g. Item or Cost 
Class). After you enter the warehouse, effective date, scope and customer information, the 
system displays the Contract detail screen so you can enter quantity break/costing 
information for the contract line. 
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Cost hierarchy  

For each vendor, you can specify which contract scopes take precedence on the Costing 
view of Vendor F/M (APF910). The Contract Scope options are "specific item contracts", 
"cost class contracts", "all item contracts", and "standard cost (per PO Static Control)". 

You can set the order in which the costs are considered, so that if the first one isn’t found the 
next one is taken and indicate whether the lowest cost is always taken, regardless of the 
hierarchy. 

Cost contracts for the specific warehouse placing the order are always considered before 
contracts for all warehouses (unless the select lowest flag is set and an "all" warehouses 
contract is lower than the specific warehouse contract). 

Cost contracts for the specific customer being sold to on a special order PO are always 
considered before contracts that aren’t for a specific customer. 

Cost contracts are selected in the following order: 

Specific Customer Contracts per the hierarchy – check required flag 

Specific Warehouse Contracts per the hierarchy 

All Warehouse Contracts per the hierarchy 

Cost Contract Listing (POR510) is used to print the detail of contracts that are on file. You 
can select to print Current, Future, and/or Expired contracts and optionally include actual 
costs for contracts for specific items that are basis/multipliers. 

Cost Contract Removal (POU510) is used to purge contracts as they expire. You can use 
this program to remove batches of related contracts — for example, all contracts for a 
specific customer, a specific item, expired contracts, etc. It may be helpful to first run the 
Cost Contract Listing program to generate the list of contracts to delete. 

You can specify: whether to remove based on warehouse, customer or item scope, 
warehouse scope, customer or item scope beginning and ending expiration and effective 
dates, and remove expired, current, future or all contracts. 

Inquiries  
The Purchase Orders Inquiry menu allows the user to view purchase order information by 
vendor, item and document. 

You can access these programs. 

Vendor Inquiry, which is used to view purchase order information by the vendor chosen. 
Information includes open purchase orders, past purchase orders, planned special order 
purchase orders, receipts, vendor notes, items, vendor-item numbers, returns and ship-
froms, document priority and PO debit and costing information. This inquiry is separate from 
the AP Vendor Inquiry program. 

Document Inquiry, which is used to view purchase order documents in detail by the type and 
status selected. The type options are: open purchase orders, backorders and non-invoice 
receipts. The various status codes include: purchase orders entered, but not printed, 
purchase orders printed, received purchase orders, deleted purchase orders and voided 
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printed purchase orders. Inquiry information includes an overview of the document’s current 
status, whether the PO has been confirmed, the actual document as it appeared at time of 
entry (with updated amounts and units) and as purchase orders are line item receivable, 
each receipt per line may also be displayed. 

This program allows you to view purchase order documents (past and current) in detail. 

You have the option to view PO documents by warehouse. The system also displays a 
detailed history of a line item for a PO or past PO. 

In Document Inquiry, if you enter a purchase order that has been completely received and 
updated, the system displays the message: "Updated PO XXXXXX can be viewed in Receipt 
Entry programs". To view a purchase order that has been completely received and updated, 
access Receipt Entry (POE210) and Non-PO Receipt Entry (POE220) as appropriate for the 
PO. Select the icon to search for purchase orders. If the "Update in Receipt Entry" option is 
set to yes in PO Static Control F/M (POF980), the PO Search window contains an Updated 
PO button that displays a search window containing purchase orders that been completely 
updated in the PO Receipt Entry or Non-PO Receipt Entry programs. If you select a 
purchase order from this search, the system displays the PO Receipts Search Window 
where you can select to view a receipt. Refer to the PO Receipts Search window for detailed 
information about this feature. 

For open purchase order documents and past invoices, document and line notes are 
available to view or edit, based on your user security access. For past documents, notes are 
only available to view/edit (, based on your user security access) from the Receipts view 
(accessed by clicking Receipts) of Document Inquiry. 

Items-in-Process Inquiry is used to inquire about the status of a purchase order item. This 
inquiry displays in item order all the purchase orders that contain the selected item. The user 
chooses the beginning item to view. Information includes item, type, status, order amount, 
unit of measure, cost and warehouse. Inquiry information for each item in process includes 
item number and description. The number of each purchase order with the item is then listed, 
giving the following information: document number, type, status, date, vendor, name, 
quantity ordered, received and backordered, buying unit of measure, cost, and costing unit of 
measure. 

You have the option to select: 

• the SO (sale order) or PO (purchase order) items in process for the inquiry. 
• the document type(s) to display: -open orders, direct entries or confirmed orders, 

credit memos, backorders, counter sale invoices for SO documents and open 
purchase orders, backorders, and non-PO receipts for PO documents. 

• the document status code(s) to display (stage in the sales orders or purchase order 
processing cycle). 

• the beginning item to display. 

NOTE: When the user first enters the PO Items-in-Process Inquiry program, any saved user 
preferences for the warehouse and filter values will be set and the FIRST ITEM to match 
these criteria will now display. The user is still able to enter a different beginning item or click 
Next Item to page through all items that match the warehouse, document type and status 
selected. If the user enters an item that does not match any of the filter settings, the next 
matching item will be displayed. To get to the first matching item, the user can either clear 
out the beginning item field or click the new "First Item". 
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If there is a specific way that you most often view items in this inquiry, the filter values can be 
set by clicking Change Filters and then click Save Filter Values from the User Pref menu to 
save these settings and restore them each time the user enters the inquiry. 

Item Inquiry is used to display specific information for items in the Inventory Control Item File. 
Items may be displayed individually or sequentially. You have the option to display general 
information, packaging information, warehouse information, open purchase order 
information, costing information, pricing information, sales history information and item 
activity information. This inquiry is also found on the inventory control inquiries menu. This is 
the same Item Inquiry found in the Inventory Control module. 

Use Catalog Item Inquiry (ICI290) to review information for catalog items within inventory. 
When you first access Catalog Item Inquiry, the upper portion of the screen contains a Go to 
field, which is used locate specific items. The Go to field is case sensitive. This means that if 
you enter i100 to lookup a item number when someone entered it as I100, the item record 
you are looking for will not appear in the browser. 

There are two views available in the lower portion of the screen: 

General Displays the following information from the item’s master file: item class; item price 
class; vendor; vendor item; interchange item number, weight, model number and standard 
package size associated with this catalog item and the date the item was established 
(entered) in the system. 

Pricing Displays pricing information including current and suggested list price and manual 
cost, the pricing unit of measure, the current and suggested standard price, current and 
suggested pricing for levels used by the system (1-6 as set in the IC Static Control F/M), and 
quantity break prices in both the default Pricing and Quantity Break UM (if available). 

Reports and prints  
The Purchase Order Reports and Prints programs allow you to print hard copy information 
about purchase orders. This information can help you manage purchase orders. Using the 
programs in this section, you can view open orders, backorders and future cash 
requirements based on purchase orders, as well as information on vendor-item numbers. 

These programs are available. 

Status Report allows you to view and/or print all entered and printed purchase orders by 
vendor, document, or item. This report is warehouse specific. 

Past Purchase Order Report allows you to print selected past purchase order data, by 
vendor or by purchase order, using selected criteria to filter output. 

Receiving Schedule allows you to view and/or print a report of open purchase orders by 
expected receiving dates. You can print this report by date, vendor, or item. This report is 
warehouse specific. The printout format can be in summary (PO number’s and totals) or 
detail (PO number’s and each line-item). This report is helpful in determining when incoming 
shipments will arrive, so that you can fill customer orders on time. 

Cash Requirements Report allows you to view and/or print a report showing future payments 
due to vendors for purchases made through the Purchase Orders system. This report is 
helpful in cash management and budget planning. The report lists the amounts due for each 
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vendor. Your report selection can be based on due date or discount date, and you can select 
a range of dates to use for the printout. Report payment information includes purchase 
orders or registered receipts. You can print this report in summary or summary or detail 
formats. 

Vendor/Item Listing prints vendor-item numbers by vendor or by item. The report is useful in 
viewing general information from the vendor-item records on file. 

Vendor/Item History Report allows you to view and/or print a report of the historical 
information in the vendor/item file. You can set the report to print by vendor or by item. This 
report is helpful in locating active or inactive vendors or items and determining vendors or 
items to purge from the file. It may also be useful in viewing purchasing patterns. Month-to-
date, year-to-date and prior year figures may be included in the report. 

PO Code List prints a listing of all buyer codes and their descriptions on file. 

The PO Returns Report program allows you to print a report of all items returned, as well as 
the returns code for the item. This report is designed to track returns. It provides the user 
with the document information from the return, the item information and the return type. It 
also provides an optional removal. 

 

End of period  
This menu contains programs that should be run at the end of each purchase orders period 
to close it correctly. 

The PO Period Receipts Report provides a list of all purchase order receipts made during the 
period. The report may be printed by purchase order, vendor or item number. Printed 
receipts should be removed at the close of the period, from the PO receipts file, through the 
optional update. If you cannot access this report, the Use Period Receiving Report flag in the 
PO Static Control F/M is not selected. Speak with your Affiliate before activating this report or 
changing any other settings in this F/M. Report information includes the following: 

Printed by purchase order number: for each purchase order, purchase order number, 
warehouse, vendor number, name, receipt number and receipt date. The line-item 
information includes item number and description, units, cost and extension. The total 
number of PO’s listed is also included. 

Printed by vendor: the same information is included but purchase orders are grouped 
according to vendor. Totals by vendor are also printed. The total number of vendors listed is 
also included. 

Printed in item order: the information is grouped by item and includes item number and 
description, purchase order number, warehouse, vendor number, name, receipt number, 
receipt date, units, cost and extension. Totals by item are also printed. The total number of 
items listed is also included. 

The Period Invoice Receipts Report provides a report of all invoices received and entered 
into the purchase order invoice receipts system. The report may be printed in vendor or item 
order. Printed receipts should be removed at the close of the period, from the invoice receipt 
file, through the optional update. Ü If you cannot access this report, the Use Period 
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Receiving Report flag in the PO Static Control F/M is not selected. Speak with your Affiliate 
before activating this report or changing any other settings in this F/M. 

The Period Receipts Discrepancy Report provides a report showing any discrepancies 
between purchase order receipts and invoice receipts. The report may be printed in vendor 
or item order. Ü If you cannot access this report, the Use Period Receiving Report flag in the 
PO Static Control F/M is not selected. Speak with your Affiliate before activating this report or 
changing any other settings in this file maintenance. 

While invoice receipts are being entered in Invoice Receipts Entry program, both the 
invoiced amounts and the actual received amounts are stored in the invoice receipts file. 

When you run the Invoice Receipts Register, the extension (cost multiplied by the units 
invoiced) of each line-item on the invoice is compared to the extension (cost multiplied by the 
units received) of each line-item on the received purchase order. Any discrepancies in the 
two extensions are recorded in the period receipts discrepancy file. These records are 
available to be printed at any time by this report. The optional update following this report 
removes all of the records that appear on the report. 

You can specify: print order - vendor or item, beginning and ending order choice, period and 
branch to print and whether to include freight and tax discrepancies. 

Report information includes vendor, document (invoice) number, document date, item 
number, description, units received, units invoiced, cost at time of receipt, cost on the invoice 
and the dollar amount of the discrepancy. Totals by vendor or by item are also printed. The 
total number of vendors or items listed are also included. 

The purchase order End-of-Period Update closes the current purchase orders period by 
setting the period-to-date purchase figures in the vendor/item file to zero and incrementing 
the current period by one. 

See the End of Period Checklist Explanation for more information 

File maintenances and infrequent file maintenances 
The File Maintenance programs allow you to enter, change and delete data. These programs 
are used to enter the initial data required to set up the system. You can also add, change 
and delete the records in a file. 

File maintenance programs create the foundation of the FACTS system. They enable users 
to enter file information (such as customer, item and vendor files) and control how the 
system processes information, as in SO Static Control. 

File Maintenance programs are also referred to as F/Ms for short, these programs often 
function the same way. Infrequent file maintenance programs often play a role in installation 
and then they are rarely used after that. 

You will use some file maintenance programs, such as Vendor/Item F/M, more often than 
you use others. In fact, some file maintenance programs, such as PO Static Control F/M, are 
only used during installation. These programs are accessible from the Infrequent File 
Maintenances menu. In most cases, changes to these file maintenances after initial 
installation can have a negative impact on the system, your data and your business. 
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Infor highly recommends that you talk to your Affiliate prior to making any changes to the 
Nonstatic and Static Control F/Ms in this module. 

You can access the following programs from the PO File Maintenances menu: 

Vendor/Item F/M (POF910), which is used to create, store and maintain information on items 
purchased from each vendor. You can enter information for this program on the General and 
History screens. This program is most useful when you want to create individual records. If 
you need to create large groups of records for a vendor or an item, you can save time by 
using the Create Vendor/Item Records program. Information in the Vendor/Item F/M includes 
vendor number, item number, vendor-item number, lead time, manual and last costs and last 
purchase order number and date. Also stored is the number of units purchased, number of 
units returned, dollar amount purchased, dollar amount returned, number of receipts and 
average days late for the MTD, YTD and PYR. The Receipt Register updates the MTD, YTD 
and PYR information. You can quickly access the information entered through this program 
in the PO Vendor Inquiry program, the Vendor/Item Listing and the Vendor/Item History 
Report. 

NOTE: Only records created through this program or the Create Vendor/Item Records 
program will be updated as to MTD, YTD and PYR through the Receipt Register. Therefore, 
you must create all needed vendor-item combination records in the vendor/item file prior to 
beginning normal purchase order operations. 

Ship-From F/M (POF930), which is used to create and maintain alternate vendor ship-from 
addresses. Purchase orders are normally sent to the vendor address stored in AP Vendor 
F/M. If the vendor uses different billing and shipping addresses, enter the vendor address 
where you send the purchase order as the address on this screen. You can also enter an 
unlimited number of ship-from addresses for each vendor. 

Create Vendor/Item Records (POU910), which is used to create, store and maintain vendor 
item information on a range of vendors and/or items. You can create these records by item 
number, alpha, vendor number or item class. The vendor-item number, lead time, date of last 
purchase and normal and last cost information are retrieved from the inventory control item 
file and the cost class information is retrieve from the vendor file and used in the vendor/item 
file. This program is useful during initial setup and installation of the Purchase Order module, 
or when you are adding large numbers of new vendors or items into the system. It creates 
vendor/item records only for vendor/item combinations of the primary vendor assigned to the 
item in Item F/M. You can specify: order to create—by item, alpha, vendor or item class, 
beginning and ending order choice, specific item class, if you are creating by vendor, specific 
vendor if you are creating by item, alpha or item class and warehouse(s) to create. 

Remove Vendor/Item Records (POU920), which is used to remove groups of records from 
the vendor/item file. You can specify: the order in which to remove records—by item, alpha, 
vendor or item class, the beginning and ending order choice, a specific item type or vendor 
to remove, the last purchase date to use for removing records, and the warehouse you are 
removing records from. This program is particularly useful if you need to remove all items 
related to a particular vendor or a certain item from all vendors. You can also use this 
program to purge old records. This is usually faster than trying to remove items or vendors 
individually in Vendor/Item F/M. 

Manual Cost Change Update (POU930), which is used to change the manual cost stored in 
the vendor/item file for selected items of a vendor. You can specify: the vendor for the cost 
change update, beginning and ending item numbers for the cost change update for the 
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selected vendor, item class for the cost change update, and warehouse for the cost change 
update. You can also update the manual cost using last vendor, standard, average, last or 
manual costs, or by percent. The manual cost field may also be accessed through the 
Vendor/Item F/M program. This update program provides a quick way to update large groups 
of records. 

Use Transfer/Change Vendor-Item Codes (POU950) to change the Cost Class information in 
the Vendor/item Files for a range of vendor items. 

You can access the following programs from the PO Infrequent File Maintenances menu: 

Use Buyer Code F/M (POF920) to maintain the buyer codes used in Purchase Order Entry to 
keep track of who authorized the purchase of goods. 

Use Cost Class F/M to enter cost classes used for creating cost contracts. The Cost Class is 
specific to a Vendor. Using Cost Contract Entry (POE510), you can create cost contracts for 
items from a vendor that are in a specific cost class. 

Use PO Entry Options F/M (PO915) to streamline purchase order entry, receipt entry, non-
PO receipt entry, and invoice receipt entry. PO Entry Option settings are not user-specific; 
they affect all PO Order Management Suite users. 

In this program, you define whether header, line item entry and footer inputs are: 

• required to complete a document and whether they should appear on the main 
screen. 

• not required. 
• can be initially skipped, but can be edited later if necessary. 
• can be disabled i.e un-editable but visible to the user. 

You can also select which totals appear on the entry screen. You can also set line-item 
browser flags to indicate backordered items, temporary items, non-stock items, special 
orders, direct ships, items shipping from alternate warehouses and lines that are past their 
request and promise dates or that have job number associated, and set the notes pop-up 
display for item and customer notes. 

Programs that can be modified through this file maintenance are: 

Purchase Order Entry 

Receipt Entry 

Non-PO Receipt Entry 

Invoice Receipt Entry 

Use the PO Static Control F/M to set the many flags that activate or deactivate the features 
available in the Purchase Order module. For instance, from this program you can determine 
whether or not to use job costing, store past POs, include tax and freight, just to name a few 
of the possibilities. 

Use PO to GL Posting F/M (POF970) to determine how purchase orders post to General 
Ledger after the Receipt Register is run. You can also set this program so that purchase 
orders never post to the GL automatically. This record contains information—such as journal 
and account numbers—that the system references when it automatically posts Receipt 
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Register data to the General Ledger in the Receipt Register Update. All General Ledger 
numbers must be set up in the system. 

Use PO Static Control F/M (POF980) to set up controls for that affect how the Purchase 
Orders module operates. 

Use PO Nonstatic Control F/M (POF990) to set a number of Purchase Orders controls that 
the system regularly updates during live processing. 

Rebuild PO Sort Files (POU990), which is used to rebuild sort files that may not be up to 
date with the rest of the system. Sort files are used throughout the FACTS system so users 
can report or retrieve information in an order other than the order in which the main file is 
stored. For example, the records of the vendor file are stored in vendor number order. To 
access this file in alphabetical order requires a sort file that is stored in vendor number by 
alpha lookup by vendor number. The corresponding record in the main file may then be 
accessed for the needed information. 

* indicates that changing the field after initial installation may have serious repercussions. 

Please refer to your affiliate before any changes are made. 
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Chapter 3 Transaction Procedures 

Standard procedures 
1 Recommended Operating Procedures 

An outline is provided of routine procedures on a daily, weekly, period (month, if 12 periods 
are used) and yearly basis. 

2 End-Of-Period Checklist for Purchase Orders 

The end-of-period procedures are critical to the proper functioning of the system. Certain 
programs must be run in a specific order to close the purchase orders module correctly. 

It is suggested that copies of the checklist be made and used for each period closeout to be 
filed for future reference. 

3 End-Of-Period Checklist Explanation for Purchase Orders  

A detailed account is provided of the purpose of each program on the checklist. 

Recommended operating procedures 

Daily procedures (or as needed) 
1 Run the Buyers Control Center. 

2 Enter planned special order POs for non-replenishment. 

3 Enter purchase orders as needed. 

4 Enter PO and Non-PO receipts; print/update Receipt Register. 

5 Enter invoice receipts; print/update Invoice Receipt Register. 

Weekly procedures (or as needed) 
6 Run Uninvoiced Receipts Report. 
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7 Print any purchase order management reports. 

Period procedures (or as needed) 
1 Enter final purchase orders. 

2 Enter final PO and Non-PO receipts; print/update last PO Receipt Register. 

3 Enter final invoice receipts; print/update last Invoice Receipt Register. 

4 Print/update Period Receipts Report. 

5 Print/update Period Invoice Receipts Report. 

6 Print/update Period Receipts Discrepancy Report. 

7 Run End-of-Period Update. 

Yearly procedures 
1 *Run End-of-Period Update. (already covered in period procedures—do NOT run twice) 

* Indicates the procedure is required and must be performed in the time period designated 

Transaction procedures 

Entry procedures 

Creating document numbers 
The system automatically creates a document number once you complete the header. At 
that point, the document number appears in the title bar along with the vendor’s name. You 
can also assign a document number manually if you prefer. 

1 Open Purchase Order Entry. 

2 Click File>New Document Number from the menu.  

3 Enter up to six characters to create a document number. Click OK. 

4 Begin entering the order, starting with the Vendor Number. Refer to the Creating or 
updating purchase orders procedure for additional information.  
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Creating direct -ship POs 
To access the Warehouse/Direct Ship Selection dialog box to create a direct shipment, press 
F1. If the PO is a direct ship, specify the warehouse that is to be the initiating warehouse. 
The warehouse specified for a direct ship is stored only to determine where the PO 
originated; inventory quantities and restocking controls are not affected. This becomes the 
ship-to address on the purchase order. You can press F4-backup and override the address, 
or continue to back up to the warehouse prompt. 

Importing planned special order purchase orders  
After the PO number is assigned, the system checks the planned special order orders file for 
planned special order orders for the selected vendor and warehouse to automatically add to 
the purchase order. If the system finds planned special order purchase orders it displays the 
message: Planned Special Order orders on file. Do you want to import? (Y or N) If no 
planned special order orders exist, this field is skipped. If you specify N, the cursor goes to 
the line-item portion of the screen. If you specify Y, the system displays the first line item to 
import. Press Enter to import the displayed line, F1 to skip the line item and display the next, 
F2 import all line items, or press F3 to end imports. The system adds one line item for each 
item in the planned special order purchase orders file and adds to the weight and total dollar 
amount in the header of the purchase order. 

Importing notes for planned special order POs 
You can import sales order line notes to associated purchase orders or inventory transfers 
and print the exported sales order line notes on the PO or transfer ticket. Refer to the 
Importing Notes topic for details. 

Opening existing documents 
Access an existing document before you begin entering a new one. Once you begin entering 
header information, the system does not allow to you open a document in the same window. 
You can also start another session of FACTS if you need to open a document while you are 
in the middle of entering one. 

To open an existing purchase order 

Enter the purchase order number in the Doc/Vendor field and press Enter. If the document 
number is on file, the vendor number appears in the field and the purchase order number 
appears in the title bar. 

OR 

1 Click File>Open Existing Document.  
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Search Tips:  Press F2 to perform a vendor search. You can also search by purchase 
order number and warehouse. Use the Document Search window to find the document 
you want to edit or review. 

2 Click OK to select the document and return to the main entry window. 

Deleting purchase orders 
Deleted purchase orders are not simply removed from the file. The system deletes purchase 
order line item records and if all the line items for a purchase order are deleted, then it 
changes the header record status to deleted. The purchase order then appears on the next 
purchase orders Receipt Register as deleted and is removed in the subsequent update. This 
procedure provides a complete audit trail of all purchase order numbers used.  

At any point during the PO entry-receipt process, you can view in detail the PO in its current 
state or its overview (history since it was entered) status via the PO Vendor Inquiry or 
Document Inquiry programs. 

To delete an order before the header is complete: 

1 Press F4 to back up to the Doc/Vendor field. 

2 To delete an order after the header is complete: 

3 With the purchase order open on screen, click File>Delete Document from the menu. 

4 At the prompt “Delete this entire document?” select “YES – Delete”. 

5 Click OK to delete the document. 

Editing line items  
You can edit line items on a purchase order until it is received. 

Use your mouse or arrow keys to highlight the line in the item browser and click Edit to make 
changes for the highlighted line item.  

OR 

Highlight the line and click Line Detail to access fields that do not appear in the line-item 
entry section.  

Deleting line items 
1 Use the mouse or arrow keys to highlight the line in the item browser.  

2 You can delete the highlighted PO line, or click Edit>Delete Item from the menu. 

3 At the prompt “Delete this line?”click “YES – Delete”. 

4 Click OK to delete the line. 
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Inserting line items or memos 
Use the mouse or arrow keys to highlight a line. The program inserts the new line item above 
the selected one. 

You can add a line item above the highlighted item in the browser, or click Edit>Insert Line 
from the menu.  

Adding line items 
1 Click Add. The system displays the Line Detail for Purchase Order screen, which is used 

to view and modify item descriptions, promise and request dates, item details, 
item/vendor info, and item cost info.  

2 The program automatically switches to add mode once you complete the header. This 
means the cursor appears in the Item Number field after you exit the last header field. 
The program stays in add mode until you press F4 to back out of the line-item entry 
section or click Stop at the right of the screen. 
Quick entry tip: Specify the item number, the ordered quantity and then press the Down 
Arrow key.  

3 The program uses the default information in the rest of the line-item entry fields and 
returns to the Item Number field. 

Processing returns for temporary items 
You can process returns for temporary items in the Buyers Control Center (POE400), 
Purchase Order Entry (POE120), Receipt Entry (POE210) and Non-PO Receipt (POE220) 
programs. 

Returning surplus  
1 Access PO Entry (POE120), PO Receipt Entry (POE210), or Non-PO Receipt Entry 

(POE220).  

2 Specify the header information. 

3 To return surplus, click Options>Return Surplus to import items from 1 of 6 options: 

1. buyer long term surplus (buyer specific -always uses displayed 
buyer/whse/vendor specific) 
2. buyer short term surplus (buyer specific -always uses displayed 
buyer/whse/vendor specific) 
3. vendor long term surplus (not buyer specific -always uses displayed 
whse/vendor specific) 
4. vendor short term surplus (not buyer specific -always uses displayed 
whse/vendor specific) 
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5. whse long term surplus (not buyer nor vendor specific -always uses displayed 
whse specific) 
6. whse short term surplus (not buyer nor vendor specific -always uses displayed 
whse specific) 

2 Click OK to display the Import Program (POE151) with the surplus (per the number 1-6 
selected) displayed. 

3 Click Toggle to select the lines for return. 

4 Specify the quantity to return in the Return Units prompt. 

5 Click Save.  

6 Click Done to return to the BCC Detail screen. 

Creating or updating purchase orders  
1 Click Purchase Orders >PO Entry. 

Complete steps 2-9 to enter PO header information. 

2 In the Doc/Vendor field, specify the vendor or the purchase order.  

3 (Optional) To access the Warehouse/Direct Ship Selection dialog box to create a direct 
shipment, press F1.  
Click Creating direct -ship POs for details. 

4 For a valid vendor code, the system displays the vendor name and address, ship-to and 
ship-from warehouses, and terms code and the Vendor Info dialog box, which contains 
the vendor’s message, balance, the user’s customer number from the vendor, contacts 1 
and 2, and the phone number.  
You can modify these fields. 
Ship-From-Specify the vendor ship-from number.  
Ship-To Warehouse-Specify the warehouse code where the goods should be shipped.  

5 In the Ordered Date (entry date of the PO), Request Date (requested date of delivery), 
and Promise Date (date the vendor promises delivery) fields, the system displays the 
current date as the default. You can modify this date, or press Enter to accept the 
current date.  

6 Update payment terms code and buyer if needed. 

7 Check the Confirmed check box to indicate the PO has been confirmed by the vendor 
and the Replenishment Doc check box to indicate this is a normal replenishment 
purchase order.  

8 (Optional) The system displays an optional information dialog box, complete these fields: 
Freight-Indicate whether freight is B-bill later, P-prepaid , C-collect, or A prepay/add.  
Ship Via-Specify up to 15 characters for the carrier. Press Enter to initially default to the 
ship via in the ship- from file for the selected vendor. 
Lead Time-Click the Lead Time check box to indicate whether the lead-time from this 
document (number of days from the ordered date to the date of the first receipt) should 
update the average lead-time for the item in the warehouse/item file. The system 
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performs this update during the Receipt Register update.  
F.O.B.-Specify up to 15 characters for freight on board. Press Enter to initially default to 
the F.O.B. in the ship-from file for the selected vendor. 
Reference Number-Specify the optional reference number (up to 30 characters). For 
direct ship orders, press Enter to initially default to the related SO number. 
Click OK. 

9 After the PO number is assigned, the system checks the planned special order orders file 
for planned special order orders for the selected vendor and warehouse to automatically 
add to the purchase order. If the system finds planned special order purchase orders it 
displays the message: Import planned special order POs? If no planned special order 
orders exist, this field is skipped. Click Importing planned special order POs for details. 

Complete steps 10-15 to add line items on a purchase order: 

10 In the Item field, specify the item you want to purchase.  

11 The system displays the Item Information dialog box, which contains the vendor relation, 
last lead-time, vendor-item number, item class, standard package size, buying weight, 
and inventory quantities.  

12 In the Units field, specify the quantity to be ordered in the displays default unit of 
measure. The system displays the label for the default unit of measure for the item, such 
as EA or BX. 
Multiple UMs 
For items with multiple UMs, the system displays a dialog box where you can select to 
display warehouse quantities, perform an item catalog, service item, or standard parts 
search. Select W to display inventory quantities for this item that are currently in each 
warehouse. The warehouse number is displayed, as well as the on hand, committed, 
available, backorder and on order (not including the line displayed) quantities and their 
corresponding units of measure. 

13 The system displays the Cost info dialog box for the item. This dialog box contains the 
manual item cost, the manual vendor cost, contract cost, and the last vendor cost. 

14 In the Cost field, specify the cost per displayed costing unit of measure.  
Depending on the Default PO Cost flag set in the PO static control record, press Enter to 
default to the manual cost of the item from item file or the last cost of the item from the 
vendor/item file. This field is only used when the Cost flag in the PO Entry Options 
record is set to Y or B.  
When a new line is being created, the system automatically calculates the default cost. 
After the cost is entered, the system captures the origin of the cost. If you select a cost 
other than the default cost, the system sets the cost override flag. The system also 
displays Contract to indicate whether the displayed cost is from a contract.  
You can access cost details from the View >Cost Origin menu option. 

15 The system returns you to the Item field to add another line item for the PO. You can add 
more items or click Cancel to end line entry.  

16 When you are finished with line items, click Done. 

Complete steps 17-20 to specify purchase order footer information: 

17 The system displays the Footer Detail for PO Number dialog box. 
These fields are optional.  
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Memo-Specify the memo to print on this PO.  
Freight--If freight is included, specify the freight amount (.00-9999.99).  
Tax %-- If tax is included, specify the tax percent. The amount is calculated and 
displayed.  
Acknowledgment and Confirmation—Indicates you want the words Acknowledgment 
only or Confirmation requested to print on the purchase order, select the appropriate 
check boxes.  
Click OK. 

18 The system displays the message: Print purchase order now?( If the PO has already 
been printed then the prompt asks you if the PO should be added to the PO reprint file.)   

19 Click Yes to print the PO or No to save for batch printing. Click OK. 

20 Click Done to exit the program. 

Entering return (Negative qty) POs for temporary items 
Note: You add temporary item returns PO lines from the PO Entry (POE120), Receipt Entry 
(POE210) and Non-PO Receipt (POE220) programs. 

1 Click Purchase Orders >Purchase Order Entry >PO Entry. 

2 Complete the header information as needed. Refer to How to enter or change purchase 
orders information procedure and complete steps 2-6 to specify purchase order header 
information. 

3 To add a return (negative) PO line for a temporary item, click Add. 

4 Specify the temporary item number. 

5 Answer Yes, when the system asks: Is this a temporary item? 

6 The Required Line Fields (POC999) screen is displayed so you can specify information 
for the temporary item. Specify the following: item description, weight, UM, item class, 
and whether the item is taxable. (Note the vendor is defaulted from the header 
information.) 

7 Click OK to add the temporary item. 

8 Specify the ordered quantity in the Units field. Note that this must be a negative amount 
for temporary items entered in this program. 

9 Specify the temporary item cost. 

10 You can manage additional PO lines as needed.  

Responding to exceptions 
1 Click PO>Exception Control Center. 

2 Specify the buyer code for reviewing exceptions. 
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3 (Optional) You can further limit the browser display of alerts by specifying the following 
additional information: 
Alert Codes—using the drop down list, specify a specific alert code for exceptions. 
To and From Warehouse, Vendor, Purchasing Line—specify any of these parameters 
to narrow the exception display in the browser. 

4 (Optional) In the Item Filters section you can also specify an item number and/or 
ranking as well as whether to display replenished items. 

5 Highlight the exception alert line in the browser and select from the following: 
Buyer Settings to access Buyer Code F/M (POF920) to view settings for the specified 
buyer code. Close the screen to return to the ECC. 
Respond to Exception to view the work order, past purchase order, shipment, transfer 
or document the exception is linked to. Close the screen to return to the ECC. 
Alert Details to view detail information about the alert, including the alert name and 
extended description, alert delivery method and available subscription values. Press OK 
to return to the ECC. 

6 Click Close All to close all Alert Detail & Respond to Exception windows. 

7 Click Close to exit the screen. 

Managing PO document holds 
1 Click Purchase Orders>Entry>Purchase Order Review.  

2 Specify the warehouse.   

3 In the Hold Status drop-down list, specify whether to display documents that are H-All 
documents on hold, D-documents on debit hold, S-documents on service hold, N-
documents not on hold or A-all documents. The program defaults to H. 

4 In the Status drop-down list, specify the purchase order status to display: E-Entered, P-
Printed, or R-Received, or A-All. 

5 In the Priority drop-down list, select the purchase orders priority to display: N-normal, R-
rush or B-both.                    

6 In the Type field, specify the types of purchase orders to display. You can select from 
entered, received or all purchase orders.  

7 Header- Displays the Change Filters dialog box which is used to modify the selection 
criteria in the upper portion of the screen.  

8 In the Buyer drop-down list, specify the buyer to display.   

9 In the Origin drop-down list, specify the origin of purchase orders to display: N-non-
remote, W-web, R-remote or A-all documents. 

10 In the Req. cutoff field, specify the request date to display through.   

11 You have these options. 

• Svc Hold -Places the highlighted documents on service hold. The selected document 
is placed on hold until the user releases it.  
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• Debit Hold -Places the highlighted documents on debit hold. The selected document 
is placed on hold until the user releases it.  

• Release - Releases the highlighted document. The selected document is no longer 
on hold. The system re-displays the purchase order documents in the browser. 

• Document- Displays PO Document Inquiry (POI620) for the selected document. 
• Access Note Entry (SME710) for the customer or sales order header record specified 

in the program.  Tip: At the List From field, specify the beginning document number 
to list in the browser or display the first document selected or next available 
document. 

12 When you have managed PO document holds, click Done. 

Buyers Control Center procedures 

Importing/Exporting Item Quantities in the Buyers Control 
Center 
You can use the right-click menu option, Export current contents to Excel¸ from the grid on 
the Buyers Control Center (POE400) and the Buyers Control Center Detail (POE405) 
screens to export the contents of the grid to Microsoft Excel®. 

Using the Buyers Control Center Detail (POE405) screen you can also import item 
quantities. The right-click function, Import quantities from Excel, works with Microsoft Excel® 
and the right-click BCC grid function, Export current contents to Excel.  

The import function can also be used with an Excel spreadsheet created with these specific 
requirements. 

• The first row is a header row. 
• There must be columns for the item number, purchase quantity, and quantity UM. 
• The Excel column header/title must match exactly the corresponding BCC grid 

column header/title. 
• There can be no blank column headers prior to the required columns (when the 

import process attempts to identify the relevant columns, processing stops when it 
encounters a blank column header). 

• Additional columns will be ignored. 
• Row order doesn’t matter except that following the first row, there should be no rows 

with a blank item number (when importing lines, when the import process encounters 
a blank item number, it assumes it is at the end of the list and stops). 

• The worksheet to import must be “Sheet1” –no attempt to import a worksheet with 
any other name will be made. 

• These are important limitations that should be noted when using the import process: 
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• The import process will not add items to the BCC grid – it only changes purchase 
quantities. This helps prevent you from accidentally importing a spreadsheet for the 
wrong vendor, for example. 

• The import process will not change anything but the quantity (i.e. it will not change 
the item number or the quantity UM). 

• The quantity UM from the spreadsheet must match the quantity UM in the grid or the 
line will be skipped. 

• Special order lines will always be skipped, as you are not allowed to change the 
purchase quantity on a special order line. 

• The import process will not import quantities for lines that have the Override checked 
in the BCC grid. These lines will be skipped. 

• When the import process updates a line, if the Buy check box it not selected, it will be 
changed to be checked. 

• To use a spreadsheet to update BCC quantities, these are suggestions to make the 
process work more smoothly: 

• Prior to importing, be sure all of the items are visible in the BCC grid. This can be 
done by selecting all of the filters, including “Items Above Line Point”. 

• The exception is that you may consider un-checking the “Spec Order” filter so that 
special order items are not visible. Special order lines will not be changed even if 
they are visible. 

• Turn off all of the buy flags in the grid using the right-click option, “Set All Buy to No”. 
This ensures that only the items you import will be set to Buy. 

• If there are additional items on the spreadsheet that are not in the replenishment 
path you are working on, you can manually add them to the grid prior to importing. 

When you are ready to import, open the spreadsheet you wish to import, and be sure it is the 
only spreadsheet open. Then access the Buyers Control Center Detail screen for the correct 
vendor, right-click on the BCC grid, and select “Import quantities from Excel.” 

The import process will notify you of any errors it encounters. 

Creating Transfers in the Buyers Control Center  
1 Click Inventory Control>Entry> Buyers Control Center Transfer. 

2 Specify the Buyer code. 

3 For Activity Type, Transfers is displayed by default. 

4 The warehouse transfers that need actions are displayed in the browser. 

5 (Optional) Specify the To warehouse to use. 

6 (Optional)In the Filter Section, you can further define the browser line display by 
specifying whether to display the achieved amount, weight and cubes as a quantity or a 
percentage of the targets. 
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7 For the Show setting, specify the type of activity to display in the browser: All Activity or 
Actionable activity to indicate whether to display lines that do not require replenishment 
so you can initiate on demand purchase orders. 

8 In the Include section, the checked prioritization categories default the types of orders 
that are displayed in the Lines browser for the specified ARP. Click Change ARP Filter 
to modify what is included in the Lines display.  

9 You can double click a line to access the Buyers Control Center Detail screen to view 
detailed information about the replenishment path; make changes, or create transfers. 
Refer to the following task options for details: 
Generating Transfers from the Buyers Control Center Detail screen Adjusting the Review 
Cycle for Transfers from the Buyers Control Center Detail screen Modifying usage for a 
transfer item on the Buyers Control Center Detail Screen Using surplus inventory to fill 
replenishment transfers. 
Adding transfer items on the Buyers Control Center Detail screen 
Reviewing and updating lead time for transfer items on the Buyers Control Center Detail 
screen 
Modifying transfer quantity information for a line item on the Buyers Control Center Detail 
screen 
Reviewing order or backorder details for an item on a Transfer  

10 When you return to the Buyers Control Center from the Buyers Control Center Detail 
screen, the transfer lines you accessed display at the top of the browser with the 
warehouse highlighted. 

11 When you have finished generating transfers, exit the program.  

Note: To process transfers created by the Buyers Control Center, you must run the IC 
Transfer Receipt Register program. 

Creating vendor returns in the Buyers Control Center 
13 Click Purchase Orders> Entry> Buyers Control Center Return. 

14 Specify the Buyer Code. 

15 For Activity Type, Returns is displayed by default. 

16 The vendors that need actions are displayed in the browser. 

17 (Optional) Specify the warehouse to use. 

18 After you specify information in the header portion of the screen, vendor return lines for 
the warehouse specified are displayed in the browser. 

19 You can double click a line to access the Buyers Control Center Detail screen to view 
detailed information about the replenishment path; make changes, or create returns. 
Refer to the following task options for details:  
Generating Return Purchase Orders 
Adding return items 
Adjusting freight values for returns  
Modifying vendor return quantity information 
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20 When you return to the Buyers Control Center from the Buyers Control Center Detail 
screen, the return lines you accessed display at the top of the browser. 

21 When you have finished generating return purchase orders, exit the program. 

Note: To process return purchase orders created by the Buyers Control Center, you must run 
the PO Receipt Register program. 

Procuring replenishment items from the Buyers Control 
Center 
1 Click Purchase Orders> Entry> Buyers Control Center Purchase. 

2 Specify the Buyer Code. The warehouse and vendors that need actions are displayed in 
the browser. 

3 (Optional) Specify the warehouse to use. 

4 Procurement displays as the default activity. 

5 (Optional) In the Filter Section, you can further define the browser line display by 
specifying vendor code, whether to display the achieved amount, weight and cubes as a 
quantity or a percentage of the targets.  

6 For the Show setting, specify the type of activity to display in the browser: All Activity or 
Actionable activity to indicate whether to display lines that do not require replenishment 
so you can initiate on demand purchase orders.  

7 After you enter information in the header portion of the screen, replenishment lines for 
the warehouses and vendors specified are displayed in the browser. Priority categories 
are determined by a product’s availability in relation to the Order Point, Line Point, Lead 
Time, and Safety Allowance levels. 

8 (Optional) In the Include section, the checked prioritization categories default the types of 
orders that are displayed in the Lines browser for the specified ARP. Click Change ARP 
Filter to modify what is included in the Lines display. Refer to Changing ARP filters in the 
Buyers Control Center for details. 

9 You can double click a line to access the Buyers Control Center Detail screen to view 
detailed information about the replenishment path; make changes, or create purchase 
orders. Refer to the following task options for details: 
Generating Purchase Orders from the Buyers Control Center Detail screen 
Adjusting the Review Cycle from the Buyers Control Center Detail screen 
Adjusting freight values from the Buyers Control Center Detail screen 
Modifying usage for an item 
Using surplus inventory to fill replenishment 
Adding items on the BCC Detail Screen 
Reviewing and updating lead time 
Modifying purchasing quantity information 
Reviewing order or backorder details for an item 
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10 When you return to the Buyers Control Center from the Buyers Control Center Detail 
screen, the replenishment lines you accessed display at the top of the browser with the 
warehouse highlighted. 

11 You can highlight a line and click Recalculate Line to recalculate the activity (the 
achieved amount, achieved weight, and achieved cubes) for the highlighted line or click 
Recalculate All to recalculate all of the activity for the buyer. 

12 Click Done to enter another buyer code; click Done again to exit the program. 

Buyers Control Center detail procedures 

Generating purchase orders from the Buyers Control Center 
Detail screen 
1 Click Purchase Orders> Entry> Buyers Control Center and use the Procuring items 

for replenishment using the Buyers Control Center procedure to specify the necessary 
information. 

2 Double click the desired line in the Buyers Control Center to access the Buyers Control 
Center Detail screen. 

3 The buyer, warehouse, vendor, and purchasing line (if any), display in the header, as 
well as target and current information in dollars weight and cubes and the variances, and 
percentage of the target that has been achieved. 
Note: For returns and purchases (procurement), the GL Department is required if PO to 
GL Posting F/M is using the department for any setting. 

4 (Optional) In the Options/Header Values section you can limit the browser display using 
the following options: 
Click the Include Non-Replenish Items check box to include/not include non-
replenishment items in the browser lines below. 
Click the Import Planned Special Order Special Orders check box to include/not 
include planned special order purchase order lines in the browser lines below. 
Click the Show Items Above Line Point check box to include/not include items in the 
browser lines below that are not ready to purchase and/or the on-hand quantity for the 
item is above line point. 

5 (Optional) The Last Replenishment Doc field displays the last PO Number and Order 
Date for the document. Use the drill down icon for quick access to the source document. 

6 (Optional) You can also modify the adjusted review cycle value. Press F1 to restore the 
adjusted review cycle value. 

7 Specify the Replenishment action you want to perform:  
Line Buy-Normal replenishment based on the current system values / settings for an 
ARP, 
Emergency Line Buy-A purchase / transfer that is based on the remaining days in the 
review cycle to fill an urgent need, or 
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Below Order Point-The items within an ARP that are below the Order Point will be 
included in the buy / transfer. All other items for the selected ARP will be excluded. This 
can be used for daily purchasing / transfers. 

8 (Optional) Specify the freight cost. 

9 The items that have approved replenishment sources for the buyer, warehouse, vendor, 
and purchasing line (if any) are displayed. 

10 You can complete these tasks: 
Adjusting the Review Cycle 
Modifying usage 
Viewing warehouse quantities 
Using surplus inventory to fill replenishment 
Adding items 
Reviewing and updating lead time 
Modifying purchasing quantity information 
Reviewing order or backorder details for an item 

11 (Optional) Click Show Math as needed to display the replenishment calculations such as 
Usage, Order Point, Line Point, Average Lead Time (LT), Safety Stock, ASQ, (average 
sales quantity), Recommended Order Quantity (ROQ), Economic Order Quantity (EOQ), 
Calculated ROQ, and Effective OQ. 

12 Once you are satisfied with your buying target values, click the Buy and Override (as 
needed) check boxes for each line you want to generate purchase orders for. 

13 Optionally, check the Rush check box to increase the order priority. To create a rush PO 
you must ensure the Build check box is checked only for the PO lines that are rush. If a 
PO contains both rush and normal priority PO lines then the PO is not set to rush. If you 
are entering a special order PO using the Special Order check box, and the special PO 
line is a Rush priority then the Rush check box is automatically selected. 

14 Click Create PO. 

15 Click Yes to generate purchase orders and display a dialog where you can select to 
display them or continue. 

16 The system returns you to the Buyers Control Center, where the replenishment lines with 
purchase orders generated display at the top of the browser with the warehouse 
highlighted with the Rank color codes assigned on the Buyers Control Center view of PO 
Static Control F/M. 

17 (Optional) You can repeat this process to generate additional purchase orders. 

18 When you have finished generating purchase orders, exit the program. 

Note: To process purchase orders created by the Buyers Control Center, you must run 
the PO Receipt Register program. 
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Generating return purchase orders from the Buyers Control 
Center Detail screen 
1 Click Purchase Orders> Entry> Buyers Control Center Return and use the Creating 

returns in the Buyers Control Center procedure to specify the necessary information. 

2 Double click the desired line in the Buyers Control Center to access the Buyers Control 
Center Detail screen. 

3 The buyer, warehouse, vendor, and purchasing line (if any) display in the header, as well 
as target and current information in dollars weight and cubes and the variances. 
Note: For returns and purchases (procurement), the GL Department is required if PO to 
GL Posting F/M is using the department for any setting. 

4 (Optional) In the header you can specify the freight value. 

5 The items that have returns for the buyer, warehouse, vendor, and purchasing line (if 
any) are displayed. 

6 You can complete the following tasks: 
Viewing warehouse quantities  
Adding return items 
Adjusting freight values for returns 
Modifying vendor return quantity information 

7 Once you are satisfied with your returns, check the Return check box for each line you 
want to generate return purchase orders for. 

8 Click Create POs to generate return purchase orders. 

9 A dialog box is displayed. Click View to display the return POs or Continue to return to 
the Buyers Control Center 

10 (Optional) You can repeat this process to generate additional return purchase orders. 

11 (Optional) You can highlight a line and click Options>Recalculate Line to recalculate 
the activity (the achieved amount, achieved weight, and achieved cubes) for the 
highlighted line or click Recalculate All to recalculate all of the activity for the buyer. 

12 Click Done and specify another buyer code or click Done again to exit the program. 

13 When you have finished generating purchase orders, exit the program. 

Note: To process return purchase orders created by the Buyers Control Center, you must 
run the PO Receipt Register program. 

Returning surplus in the BCC 
1 Click Purchase Orders> Entry> Buyers Control Center Return and use the Creating 

Vendor Returns in the Buyers Control Center procedure to specify the necessary 
information. 

2 Double click the desired line in the Buyers Control Center to access the Buyers Control 
Center Detail screen. 
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3 The buyer, warehouse, vendor, and purchasing line (if any) display in the header, as well 
as target and current information in dollars weight and cubes and the variances. 
Note: For returns and purchases (procurement), the GL Department is required if PO to 
GL Posting F/M is using the department for any setting. 

4 The items that have approved returns for the buyer, warehouse, vendor, and purchasing 
line (if any) are displayed. 

5 To return surplus, click Return Surplus to import items from 1 of 6 options: 

1. buyer long term surplus (buyer specific -always uses displayed 
buyer/whse/vendor specific) 
2. buyer short term surplus (buyer specific -always uses displayed 
buyer/whse/vendor specific) 
3. vendor long term surplus (not buyer specific -always uses displayed 
whse/vendor specific) 
4. vendor short term surplus (not buyer specific -always uses displayed 
whse/vendor specific) 
5. whse long term surplus (not buyer nor vendor specific -always uses displayed 
whse specific) 
6. whse short term surplus (not buyer nor vendor specific -always uses displayed 
whse specific) 

6 Click OK to display the Import Program (POE151) with the surplus (per the number 1-6 
selected) displayed. 

22 Click Toggle to select the lines for return. 

23 Specify the quantity to return in the Return Units prompt. 

24 Click Save.  

25 Click Done to return to the BCC Detail screen. 

Generating transfers from the Buyers Control Center Detail 
screen 
1 Click Inventory Control>Warehouse Transfers>Buyers Control Center Transfer and 

use the Transferring items for replenishment using the Buyers Control Center procedure 
to specify the necessary information. 

2 Double click the desired line in the Buyers Control Center to access the Buyers Control 
Center Detail screen. 

3 The buyer, from warehouse, to warehouse, and purchasing line (if any), and review cycle 
information display in the header, as well as target and current information in dollars 
weight and cubes and the variances, and percentage of the target that has been 
achieved. 

4 (Optional) Use the Rank drop down for stocked and replenished items to filter the display 
by a specified rank. 
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5 (Optional) In the Options/Header Values section you can limit the browser display using 
the following options: 
Replenish - to include Items where PNA is at or below order point in the browser lines 
below. 
Spec Ord - to include planned special order purchase order lines in the browser display. 
Items Above Line Point - to see all of the items in this ARP, even if they are not ready 
to be ordered. Items that are not ready to be ordered will be displayed with a Purchase 
Quantity of 0, but it can be useful to see all of the items in the ARP, and it allows you to 
investigate why FACTS is not recommending you purchase an item. 
Backorder – to include items that have open backorders. 
Critical – for items where PNA is less than safety stock quantity. 
Neg PNA –for items where PNA is negative. (i.e. if all open purchase orders arrived now, 
there would still not be enough to fill current needs) 
Rank - filter the display by a specified rank, for stocked and replenished items. 

6 (Optional) The Last Replenishment Doc field displays the last Transfer document 
number and Order Date for the document. Click the drill down icon for quick access to 
the source document. 

7 (Optional) You can also modify the adjusted review cycle value. Press F1 to restore the 
adjusted review cycle value. 

8 Specify the ship via for the carrier for the transfer. You can leave this field blank, 
however, a blank field will not create a transfer when you click Create Transfer because 
a valid Ship Via must be provided in order to create a transfer. The Ship Via value will 
pass to the created transfer ticket. 

9 Specify the Replenishment action you want to perform: 
Line Buy--Normal replenishment based on the current system values / settings for an 
ARP, 
Emergency Line Buy--A purchase / transfer that is based on the remaining days in the 
review cycle to fill an urgent need, or 
Below Order Point--The items within an ARP that are below the Order Point will be 
included in the buy / transfer. All other items for the selected ARP will be excluded. This 
can be used for daily purchasing / transfers. 

10 The items that have approved replenishment sources for the buyer, from warehouse, to 
warehouse, rank, and purchasing line (if any) are displayed. 

11 You can complete the following tasks: 
Adjusting the Review Cycle for transfer items 
Modifying usage for transfer items 
Viewing warehouse quantities 
Using surplus inventory to fill replenishment transfers 
Adding items to transfers 
Reviewing and updating lead time for transfers 
Modifying transfer quantity information 
Reviewing order or backorder details for a transfer items 

12 (Optional) Click Show Math as needed to display the replenishment calculations such as 
Usage, Order Point, Line Point, Average Lead Time (LT), Safety Stock, ASQ, (average 
sales quantity), Recommended Order Quantity (ROQ), Economic Order Quantity (EOQ), 
Calculated ROQ, and Effective OQ. 
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13 Once you are satisfied with your target values, select the Transfer and Override (as 
needed) check boxes for each line you want to generate transfers for. 

14 Optionally, check the Rush check box to increase the order priority. To create a rush 
transfer you must ensure the Transfer check box is checked only for the transfer lines 
that are rush. If a transfer contains both rush and normal priority transfer lines then the 
transfer is not set to rush. If you are entering a special order transfer using the Special 
Order check box, and the special order transfer is a Rush priority then the Rush check 
box is automatically selected. 

15 Click Create Transfer. 

16 Click Yes to generate transfers and display a dialog where you can select to display 
them or continue. 

17 The system returns you to the Buyers Control Center, where the replenishment lines with 
transfers generated display at the top of the browser with the warehouse highlighted with 
the Rank color codes assigned on the Buyers Control Center view of PO Static Control 
F/M. 

18 (Optional) You can repeat this process to generate additional transfers. 

19 When you have finished generating transfers, exit the program. 

Note: To process transfers created by the Buyers Control Center, you must run the IC 
Transfer Receipt Register program. 

Modifying purchasing quantity information for a line item on 
the Buyers Control Center Detail screen 
1 Click Purchase Orders> Entry> Buyers Control Center Purchase and use the 

Procuring items for replenishment using the Buyers Control Center procedure to specify 
the necessary information. 

2 Double click the desired line in the Buyers Control Center to access the Buyers Control 
Center Detail screen. 

3 The buyer, warehouse, vendor, and purchasing line (if any), display in the header, as 
well as target and current information in dollars weight and cubes and the variances, and 
percentage of the target that has been achieved. 

4 To modify the purchase quantity for an item, highlight the Purchase field and specify the 
new value. 

5 Once you are satisfied with your buying target values, click the Buy and Override (as 
needed) check boxes for each line you want to generate purchase orders for. 

6 Click Create PO. 

7 Click Yes to generate purchase orders and display a dialog where you can select to 
display them or click Continue. 

8 The system returns you to the Buyers Control Center, where the replenishment lines with 
purchase orders generated display at the top of the browser with the warehouse 
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highlighted with the Rank color codes assigned on the Buyers Control Center view of PO 
Static Control F/M. 

9 (Optional) You can repeat this process to generate additional purchase orders. 

10 When you have finished generating purchase orders, exit the program. 

Note: To process purchase orders created by the Buyers Control Center, you must run the 
PO Receipt Register program. 

Modifying transfer quantity information for a line item on the 
Buyers Control Center Detail screen 
1 Click Inventory Control>Warehouse Transfers>Buyers Control Center Transfer and 

use the Transferring items for replenishment using the Buyers Control Center procedure 
to specify the necessary information. 

2 Double click the desired line in the Buyers Control Center to access the Buyers Control 
Center Detail screen. 

3 The buyer, from warehouse, to warehouse, and purchasing line (if any), and review cycle 
information display in the header, as well as target and current information in dollars 
weight and cubes and the variances, and percentage of the target that has been 
achieved. 

4 Specify the ship via for the carrier for the transfer. You can leave this field blank, 
however, a blank field will not create a transfer when you click Create Transfer because 
a valid Ship Via must be provided in order to create a transfer. The Ship Via value will 
pass to the created transfer ticket. 

5 To modify the transfer quantity for an item, highlight the Transfer field and specify the 
new value. 

6 Once you are satisfied with your target values, click the Transfer and Override (as 
needed) check boxes for each line you want to generate transfers for. 

7 Click Create Transfer. 

8 Click Yes to generate transfers and display a dialog where you can select to display 
them or select Continue. 

9 The system returns you to the Buyers Control Center 

10 (Optional) You can repeat this process to generate additional transfers. 

11 When you have finished generating transfers, exit the program. 

Note: To process transfers created by the Buyers Control Center, you must run the IC 
Transfer Receipt Register program. 



Transaction Procedures 

66 | Infor Distribution FACTS Purchase Orders User Guide 

Modifying usage for an item on the Buyers Control Center 
Detail screen 
1 Click Purchase Orders> Entry> Buyers Control Center Purchase and use the 

Procuring items for replenishment using the Buyers Control Center procedure to specify 
the necessary information. 

2 Double click the desired line in the Buyers Control Center to access the Buyers Control 
Center Detail screen. 

3 The buyer, warehouse, vendor, and purchasing line (if any), display in the header, as 
well as target and current information in dollars weight and cubes and the variances, and 
percentage of the target that has been achieved. 

4 The items that have approved replenishment sources for the buyer, warehouse, vendor, 
and purchasing line (if any) are displayed. 

5 To modify usage for an item in the browser, click the icon beside the AMU (usage) field 
to access the Usage View of the Buyers Control screen. 

6 Click the Usage month you want to review. 

7 Click Usage Review to display the Usage Review program for the item, warehouse and 
month you selected. 

8 In the Beginning Date field, specify the beginning date for the browser display, and in 
the Days to Display field specify the number of days (30, 60, 90, or 120) to display. 

9 (Optional) Check the Abnormal check box to only display those usage lines that are 
Abnormal (both High and Low). 

10 In the browser, double click the usage line in the browser to display the Usage Review 
Detail (ICE556) program. You can to change qualified usage for any document that has 
recorded usage for the selected warehouse and item combination you specified. 

11 (Optional) You can apply a set of filters to define the usage lines displayed in the 
browser. In the Beginning Date field, you can filter for the beginning date for the display. 

12 (Optional) In the Days to Display field specify the number of days (30, 60, 90, or 120) to 
display. 

13 (Optional) You can also select the For Usage Warehouse from list box with the user-
specified warehouse, along with all the warehouses that are replenished from the 
specified warehouse/item and the type of usage to display-- Exceptional Usage, Not 
Exceptional Usage, or All, and the document types for the display: AD – adjustment, SO 
– Sales Order/Invoice, MC – BOM Ticket, MF – Formulation Ticket, MP – Formulation 
Packaging, MI – Formulation Ingredients, PO – Purchase Order, CR – Credit of usage 
for Customer/Vendor Returns, and LS – Lost Sale. 

14 Highlight a disbursement line in the browser and click Edit.  

15 Check the Update Usage check box to update usage. 

16 In the Usage Date field specify the date for the usage change. 

17 In the Qualified Usage field, specify the new usage value for the warehouse/item on the 
document line. 
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18 Once you have modified the qualified usage and save your changes, click Done to return 
to Usage Review (ICE555). 

19 Click Recalculate Usage on Usage Review (ICE555) to recalculate qualified usage for 
specified warehouse/item. 

20 Click Done to specify additional qualified usage. 

21 Click Done again to exit the program and return to the BCC Detail screen. 

Modifying usage for a transfer item on the Buyers Control 
Center Detail screen 
1 Click Inventory Control>Warehouse Transfers>Buyers Control Center Transfer and 

use the Transferring items for replenishment using the Buyers Control Center procedure 
to specify the necessary information. 

2 Double click the desired line in the Buyers Control Center to access the Buyers Control 
Center Detail screen. 

3 The buyer, buyer, from warehouse, to warehouse, and purchasing line (if any), rank, and 
review cycle information, display in the header, as well as target and current information 
in dollars weight and cubes and the variances. 

4 The items that have approved replenishment sources for the buyer, buyer, from 
warehouse, to warehouse, and purchasing line (if any), rank, and review cycle 
information are displayed. 

5 To modify usage for an item in the browser, click the icon beside the Usage field to 
access the Usage View of the Buyers Control screen. 

6 Click the Usage month you want to review. 

7 Click Usage Review to display the Usage Review program for the item, warehouse and 
month you selected. 

8 In the Beginning Date field, specify the beginning date for the browser display, and in 
the Days to Display field specify the number of days (30, 60, 90, or 120) to display. 

9 (Optional) Check the Abnormal check box to only display those usage lines that are 
Abnormal (both High and Low). 

10 In the browser, double click the usage line in the browser to display the Usage Review 
Detail (ICE556) program. You can to change qualified usage for any document that has 
recorded usage for the selected warehouse and item combination you specified. 

11 (Optional) You can apply a set of filters to define the usage lines displayed in the 
browser. In the Beginning Date field, you can filter for the beginning date for the display. 

12 (Optional) In the Days to Display field specify the number of days (30, 60, 90, or 120) to 
display. 

13 (Optional) You can also select the For Usage Warehouse from list box with the user-
specified warehouse, along with all the warehouses that are replenished from the 
specified warehouse/item and the type of usage to display: Exceptional Usage, Not 



Transaction Procedures 

68 | Infor Distribution FACTS Purchase Orders User Guide 

Exceptional Usage, or All, and the document types for the display: AD – adjustment, 
SO – Sales Order/Invoice, MC – BOM Ticket, MF – Formulation Ticket, MP – 
Formulation Packaging, MI – Formulation Ingredients, PO – Purchase Order, CR – 
Credit of usage for Customer/Vendor Returns, and LS – Lost Sale. 

14 Highlight a disbursement line in the browser and click Edit to modify information 

15 Click the Update Usage check box to update usage. 

16 In the Usage Date field specify the date for the usage change. 

17 In the Qualified Usage field, specify the new usage value for the warehouse/item on the 
document line. 

18 Once you have modified the qualified usage and save your changes, click Done to return 
to Usage Review (ICE555). 

19 Click Recalculate Usage on Usage Review (ICE555) to recalculate qualified usage for 
specified warehouse/item. 

20 Click Done to specify additional qualified usage. 

21 Click Done again to exit the program and return to the BCC Detail screen. 

Modifying vendor return quantity information for a line item 
on the Buyers Control Center Detail screen 
1 Click Purchase Orders> Entry> Buyers Control Center Return and use the Creating 

vendor returns in the Buyers Control Center procedure to specify the necessary 
information. 

2 Double click the desired line in the Buyers Control Center to access the Buyers Control 
Center Detail screen. 

3 The buyer, warehouse, vendor, and purchasing line (if any) display in the header, as well 
as target and current information in dollars weight and cubes and the variances. 

4 (Optional) In the header you can specify the freight value. 

5 To modify the return quantity for an item, click the Return Qty field and specify the new 
value. 

6 Once you are satisfied with your returns, click the Return check box for each line you 
want to generate return purchase orders for. 

7 Click Create PO to generate return purchase orders. 

8 FACTS displays a dialog where you can select to display the return POs or click 
Continue to return to the Buyers Control Center 

9 (Optional) You can repeat this process to generate additional return purchase orders. 

10 (Optional) Click a line and click Options>Recalculate Line to recalculate the activity 
(the achieved amount, achieved weight, and achieved cubes) for the highlighted line or 
select Recalculate All to recalculate all of the activity for the buyer. 
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11 Click Done to specify another buyer code or click Done again to exit the program. 

Note: To process return purchase orders created by the Buyers Control Center, you must run 
the PO Receipt Register program. 

Adding items on the Buyers Control Center Detail screen 
1 Click Purchase Orders> Entry> Buyers Control Center Purchase and use the 

Procuring replenishment items from the Buyers Control Center procedure to specify the 
necessary information. 

2 Double click the desired line in the Buyers Control Center to access the Buyers Control 
Center Detail screen. 

3 The buyer, warehouse, vendor, and purchasing line (if any), display in the header, as 
well as target and current information in dollars weight and cubes and the variances, and 
percentage of the target that has been achieved.  
Note: For returns and purchases (procurement), the GL Department is required if PO to 
GL Posting F/M is using the department for any setting. 

4 The items that have approved replenishment sources for the buyer, warehouse, vendor, 
and purchasing line (if any) are displayed. 

5 To add an item, click the icon beside the item field on an empty line in the browser. 

6 Select an item from the Item Search screen to add to the procurement process. 

7 The item and all of its replenishment parameter information are added to the browser. 

8 Optionally, click View>Warehouse Quantities Display to view quantity information for 
each warehouse.  

9 Once you are satisfied with your buying target values, select the Buy and Override 
check boxes (as needed) for each line you want to generate purchase orders for. 

10 Optionally, check the Rush check box to increase the order priority. To create a rush PO 
you must ensure the Build check box is checked only for the PO lines that are rush. If a 
PO contains both rush and normal priority PO lines then the PO is not set to rush.If you 
are entering a special order PO using the Special Order check box, and the special 
PO line is a Rush priority then the Rush check box is automatically selected.Click Create 
POs. 

11 Click Yes to generate purchase orders and display a dialog where you can select to 
display them or click Continue. 

12 The system returns you to the Buyers Control Center, where the replenishment lines with 
purchase orders generated display at the top of the browser with the warehouse 
highlighted with the Rank color codes assigned on the Buyers Control Center view of PO 
Static Control F/M. 

13 (Optional) You can repeat this process to generate additional purchase orders. 

14 When you have finished generating purchase orders, click Done  
Click Done again to exit the program. 
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Note: To process purchase orders created by the Buyers Control Center, you must run the 
PO Receipt Register program. 

Adding return items on the Buyers Control Center Detail 
screen 
1 Click Purchase Orders> Entry> Buyers Control Center Return and use the Creating 

Vendor Returns in the Buyers Control Center procedure to specify the necessary 
information. 

2 Double click the desired line in the Buyers Control Center to access the Buyers Control 
Center Detail screen. 

3 The buyer, warehouse, vendor, and purchasing line (if any) display in the header, as well 
as target and current information in dollars weight and cubes and the variances. 
Note: For returns and purchases (procurement), the GL Department is required if PO to 
GL Posting F/M is using the department for any setting. 

4 The items that have approved returns for the buyer, warehouse, vendor, and purchasing 
line (if any) are displayed. 

5 To add an item, click the icon beside the Item field on an empty line in the browser. 

6 Select an item from the Item Search screen to add to the returns process. 

7 The item is added to the browser. 

8 Once you are satisfied with your buying target values, select the Return check box for 
each line you want to generate return purchase orders for. 

9 Click Create PO to generate return purchase orders. 

10 A dialog box displays where you can select view the return POs or click Continue to 
return to the Buyers Control Center. 

11 (Optional) You can repeat this process to generate additional return purchase orders. 

12 (Optional) You can highlight a line and click Options>Recalculate Line to recalculate 
the activity (the achieved amount, achieved weight, and achieved cubes) for the 
highlighted line or click Recalculate All to recalculate all of the activity for the buyer. 

13 Click Done to specify another buyer code; click Done again to exit the program. 

Note: To process return purchase orders created by the Buyers Control Center, you must run 
the PO Receipt Register program. 

Adding transfer items on the Buyers Control Center Detail 
screen 
1 Click Inventory Control>Warehouse Transfers>Buyers Control Center Transfer and 

use the Transferring items for replenishment using the Buyers Control Center procedure 
to specify the necessary information. 
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2 Double click the desired line in the Buyers Control Center to access the Buyers Control 
Center Detail screen. 

3 The buyer, from warehouse, to warehouse, and purchasing line (if any), and review cycle 
information display in the header, as well as target and current information in dollars 
weight and cubes and the variances, and percentage of the target that has been 
achieved. 

4 The items that have approved replenishment sources for the buyer, from warehouse, to 
warehouse, and purchasing line (if any), rank, and review cycle information are 
displayed. 

5 Specify the ship via for the carrier for the transfer. You can leave this field blank, 
however, a blank field will not create a transfer when you click Create Transfer because 
a valid Ship Via must be provided in order to create a transfer. The Ship Via value will 
pass to the created transfer ticket. 

6 To add an item click the icon beside the item field on an empty line in the browser. 

7 Select an item from the Item Search screen to add to the procurement process. 

8 The item and all of its replenishment parameter information are added to the browser. 

9 Once you are satisfied with your target values, select the Transfer and Override check 
boxes (as needed) for each line you want to generate transfers for. 

10 Optionally, check the Rush check box to increase the order priority. To create a rush 
transfer you must ensure the Transfer check box is checked only for the transfer lines 
that are rush. If a transfer contains both rush and normal priority transfer lines then the 
transfer is not set to rush. If you are entering a special order transfer using the Special 
Order check box, and the special order transfer is a Rush priority then the Rush check 
box is automatically selected. 

11 Click Create Transfer. 

12 Click Yes to generate transfers and display a dialog where you can select to view them 
or select Continue. 

13 The system returns you to the Buyers Control Center. 

14 (Optional) You can repeat this process to generate additional transfers. 

15 When you have finished generating transfers, click Done; click Done again to exit. 

Note: To process transfers created by the Buyers Control Center, you must run the IC 
Transfer Receipt Register program. 

Adjusting freight values for returns from the Buyers Control 
Center Detail screen 
1 Click Purchase Orders> Entry> Buyers Control Center Return and use the Creating 

vendor returns in the Buyers Control Center procedure to specify the necessary 
information. 
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2 Double click the desired line in the Buyers Control Center to access the Buyers Control 
Center Detail screen. 

3 The buyer, warehouse, vendor, and purchasing line (if any) display in the header, as well 
as target and current information in dollars weight and cubes and the variances. 

4 In the header you can specify the freight value for the items. 

5 When you have finished modifying freight values you can save your work or generate 
return purchase orders. 

Adjusting freight values from the Buyers Control Center 
Detail screen 
1 Click Purchase Orders> Entry> Buyers Control Center Purchase and use the 

Procuring items for replenishment using the Buyers Control Center procedure to specify 
the necessary information. 

2 Double click the desired line in the Buyers Control Center to access the Buyers Control 
Center Detail screen. 

3 The buyer, warehouse, vendor, and purchasing line (if any), review cycle information 
display in the header, as well as target and current information in dollars weight and 
cubes and the variances. 

4 In the header you can specify the freight value for the items and adjust buying target 
values. 

5 When you have finished modifying freight values you can save your work or generate 
purchase orders. 

Adjusting the review cycle for transfers from the Buyers 
Control Center Detail screen 
1 Click Inventory Control>Warehouse Transfers>Buyers Control Center Transfer and 

use the Transferring items for replenishment using the Buyers Control Center procedure 
to specify the necessary information. 

2 Double click the desired line in the Buyers Control Center to access the Buyers Control 
Center Detail screen. 

3 The buyer, from warehouse, to warehouse, and purchasing line (if any), rank, and review 
cycle information display in the header, as well as target and current information in 
dollars weight and cubes and the variances. 

4 The items that have approved replenishment sources for the buyer, buyer, from 
warehouse, to warehouse, and purchasing line (if any), rank, and review cycle 
information are displayed. 

5 Specify the ship via for the carrier for the transfer. You can leave this field blank, 
however, a blank field will not create a transfer when you Create Transfer because a 
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valid Ship Via must be provided in order to create a transfer. The Ship Via value will pass 
to the created transfer ticket. 

6 In the lower portion of the detail screen, the Target, Current and variance (+/-) values 
indicate whether the current value is too far above or below target amount. 

7 If the current amount is too high, specify a lower value for the Adjusted Review Cycle to 
modify the Recommended transferring quantity. To increase a target, specify a higher 
Adjusted Review Cycle value. 
Note: The Adjusted Review Cycle will then establish a Temporary Line Point and 
redisplay the Recommended transfer quantity if needed. New items will appear in the 
listing if their replenishment needs fall into the new Temporary Line Point. Consequently, 
if an item’s parameters do not fall into the Temporary Line Point, it will be removed from 
the list. When indicated in the Item F/M, the ROQ for an item will be applied to the 
Recommended Quantity. Items that have been flagged as “Required” will remain in the 
BCC for processing unless remove by the buyer directly or a full Refresh is performed for 
the To Warehouse / From Warehouse. 

8 Once you are satisfied with your target values, click the Transfer and Override check 
boxes (as needed) for each line you want to generate transfers for. 

9 Click Create Transfer. 

10 Click Yes to generate transfers and display a dialog where you can select to display 
them or click Continue. 

11 The system returns you to the Buyers Control Center 

12 (Optional) You can repeat this process to generate additional transfers. 

13 When you have finished generating transfers, click Done to exit the program. 

Note: To process transfers created by the Buyers Control Center, you must run the IC 
Transfer Receipt Register program. 

Adjusting the review cycle from the Buyers Control Center 
Detail screen 
1 Click Purchase Orders> Entry> Buyers Control Center Purchase and use the 

Procuring items for replenishment using the Buyers Control Center procedure to specify 
the necessary information. 

2 Double click the desired line in the Buyers Control Center to access the Buyers Control 
Center Detail screen. 

3 The buyer, warehouse, vendor, and purchasing line (if any), display in the header, as 
well as target and current information in dollars weight and cubes and the variances, and 
percentage of the target that has been achieved. 

4 The items that have approved replenishment sources for the buyer, warehouse, vendor, 
and purchasing line (if any) are displayed. 

5 In the lower portion of the detail screen, the vendor Target, Current and Short values 
indicate whether the current value is too far above or below vendor target amount. 
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6 If the current amount is too high, specify a lower value for the Adjusted Review Cycle to 
modify the Recommended buying quantity. To increase a target, specify a higher 
Adjusted Review Cycle value. Press F1 to restore the original value. 
Note: The Adjusted Review Cycle will then establish a Temporary Line Point and 
redisplay the Recommended buying quantity if needed. New items will appear in the 
listing if their replenishment needs fall into the new Temporary Line Point. Consequently, 
if an item’s parameters do not fall into the Temporary Line Point, it will be removed from 
the list. When indicated in the Item F/M, the ROQ for an item will be applied to the 
Recommended Quantity. Items that have been flagged as “Required” will remain in the 
BCC for processing unless remove by the buyer directly or a full Refresh is performed for 
the Vendor / Warehouse. 

7 Once you are satisfied with your buying target values, click the Buy and Override check 
boxes(as needed) for each line you want to generate purchase orders for. 

8 Click Create PO. 

9 Click Yes to generate purchase orders and display a dialog where you can select to 
display them. 

10 The system returns you to the Buyers Control Center, where the replenishment lines with 
purchase orders generated display at the top of the browser with the warehouse 
highlighted with the Rank color codes assigned on the Buyers Control Center view of PO 
Static Control F/M. 

11 (Optional) You can repeat this process to generate additional to purchase orders. 

12 When you have finished generating purchase orders, click Done to exit the program. 

Note: To process purchase orders created by the Buyers Control Center, you must run the 
PO Receipt Register program. 

Reviewing and updating lead time for transfer items on the 
Buyers Control Center Detail screen 
1 Click Inventory Control>Warehouse Transfers>Buyers Control Center Transfer and 

use the Creating Transfers in the Buyers Control Center procedure to enter the 
necessary information. 

2 Double click the desired line in the Buyers Control Center to access the Buyers Control 
Center Detail screen. 

3 The buyer, from warehouse, to warehouse, and purchasing line (if any), and review cycle 
information display in the header, as well as target and current information in dollars 
weight and cubes and the variances, and percentage of the target that has been 
achieved. 

4 The items that have approved replenishment sources for the buyer, from warehouse, to 
warehouse, and purchasing line (if any), rank, and review cycle information are 
displayed. 
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5 To modify lead time for an item in the browser, click the icon beside the Lead Time field 
to access the Transfer History View of the Buyers Control screen the item, warehouse 
and you selected. 

6 The transfers shipment lines and purchase order receipt lines are displayed in the 
browser so you can modify the lead time information as needed. 

7 Highlight the line you want to modify and click Edit. 

8 (Optional) Check the Ignore check box to prevent this lead time from be included in 
average lead time calculations. 

9 (Optional) Check the Abnormal check box to flag a Lead Time as abnormal if it is more 
than 50% different from the average or if the ARP Lead Time minimum or maximum 
threshold has been reached. 

10 Specify the qualified lead time that represents the correct lead time value that is to be 
used in calculations in the system. 

11 Click Save. 

12 You have these options.  
Restocking-Opens the Restocking View (POC417) screen for the selected 
warehouse/item; if the header warehouse/item is not used it will use the warehouse/item 
of the line in the browser. 
Usage-Opens the Usage View (POC416) for the selected warehouse/item; if the header 
warehouse/item is not used it will use the warehouse/item of the line in the browser. 
View Doc-View the doc selected in the browser. 
Replen F/M--Accesses Replenishment Parameter Maintenance for the selected 
warehouse/item or for the warehouse/item of the highlighted line in the browser. 
-Or- 
Highlight the next receipt to specify qualified usage and repeat steps 7-10. 

13 Click Done to enter a another warehouse and item to use for the receipt document 
display or click Done again to exit the program. 

Reviewing and updating lead time for a line item on the 
Buyers Control Center Detail screen 
1 Click Purchase Orders> Entry> Buyers Control Center Purchase, and use the 

Procuring items for replenishment using the Buyers Control Center procedure to enter 
the necessary information. 

2 Double click the desired line in the Buyers Control Center to access the Buyers Control 
Center Detail screen. 

3 The buyer, warehouse, vendor, and purchasing line (if any), display in the header, as 
well as target and current information in dollars weight and cubes and the variances, and 
percentage of the target that has been achieved. 

4 The items that have approved replenishment sources for the buyer, warehouse, vendor, 
and purchasing line (if any) are displayed. 
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5 To modify lead time for an item in the browser, click the icon beside the Lead Time field 
to access the Purchase Order History View of the Buyers Control screen the item, 
warehouse and you selected. 

6 The transfers shipment lines and purchase order receipt lines are displayed in the 
browser so you can modify the lead time information as needed. 

7 Highlight the line you want to modify and click Edit. 

8 (Optional) Check the Ignore check box to prevent this lead time from be included in 
average lead time calculations. 

9 (Optional) Check the Abnormal check box to flag a Lead Time as abnormal if it is more 
than 50% different from the average or if the ARP Lead Time minimum or maximum 
threshold has been reached. 

10 Specify the qualified lead time that represents the correct lead time value that is to be 
used in calculations in the system. 

11 Click Save. 

12 Now have these options: 
Restocking-Opens the Restocking View (POC417) screen for the selected 
warehouse/item; if the header warehouse/item is not used it will use the warehouse/item 
of the line in the browser. 
Usage-Opens the Usage View (POC416) for the selected warehouse/item; if the header 
warehouse/item is not used it will use the warehouse/item of the line in the browser. 
View Doc-Views the doc selected in the browser. 
Replen F/M-Accesses Replenishment Parameter Maintenance for the selected 
warehouse/item or for the warehouse/item of the highlighted line in the browser. 
-Or- 
Highlight the next receipt to specify qualified usage and repeat steps 7-10. 

13 When you are finished entering qualified usage, click Done to enter a another 
warehouse and item to use for the receipt document display or click Done again to exit 
the program. 

Reviewing order or back-order details for an item 
1 Click Purchase Orders> Entry> Buyers Control Center Purchase and use the 

Procuring items for replenishment using the Buyers Control Center procedure to enter 
the necessary information. 

2 Double click the desired line in the Buyers Control Center to access the Buyers Control 
Center Detail screen. 

3 The buyer, warehouse, vendor, and purchasing line (if any), display in the header, as 
well as target and current information in dollars weight and cubes and the variances, and 
percentage of the target that has been achieved. 

4 To review the on order, backorder or available quantities for an item, click the icon in the 
appropriate field (On Order, Backorder or Available) to access the Open Docs view of the 
Buyers Control Center. 
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5 To review the details for a document line, double click the line in the browser. 

6 Click Close to return to the Open Docs view where you can other view more document 
line details; click Done to return to the Buyers Control Center Detail screen. 

Reviewing order or back order details for an item on a 
transfer 
1 Click Inventory Control>Warehouse Transfers>Buyers Control Center Transfer and 

use the Transferring items for replenishment using the Buyers Control Center procedure 
to enter the necessary information. 

2 Double click the desired line in the Buyers Control Center to access the Buyers Control 
Center Detail screen. 

3 The buyer, from warehouse, to warehouse, and purchasing line (if any), and review cycle 
information display in the header, as well as target and current information in dollars 
weight and cubes and the variances, and percentage of the target that has been 
achieved. 

4 To review the surplus, on order, back order or available quantities for an item, click the 
icon in the appropriate field (Surplus, On Order, Backorder or Available) to access the 
Open Docs view of the Buyers Control Center. 

5 To review the details for a document line, double click the line in the browser. 

6 Click Close to return to the Open Docs view where you can other view more document 
line details or click Done to return to the Buyers Control Center Detail screen. 

Using surplus inventory to fill replenishment 
1 Click Purchase Orders> Entry> Buyers Control Center Purchase and use the 

Procuring items for replenishment using the Buyers Control Center procedure to enter 
the necessary information. 

2 Double click the desired line in the Buyers Control Center to access the Buyers Control 
Center Detail screen. 

3 The buyer, warehouse, vendor, and purchasing line (if any), display in the header, as 
well as target and current information in dollars weight and cubes and the variances, and 
percentage of the target that has been achieved. 

4 To use surplus inventory, click the Surplus. 
Note: Surplus selection is enabled by setting the Use Surplus flag in PO Static Control 
F/M. When the flag is set, the Buyers Control Center will display an additional column for 
Surplus for each item. 

5 Specify the quantity to use from surplus. 

6 Click Create Transfer. 

7 Specify the ship-via. 
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8 You can optionally update the transfer quantity and a document notes. 

9 Click OK. 

10 Click the transfer ticket created message to return to the BCC Detail screen with the 
surplus quantities applied. 

11 Once you are satisfied with your buying target values, select the Buy and Override check 
boxes (as needed) for each line you want to generate purchase orders for. 

12 Click Create PO. 

13 Click Yes to generate purchase orders and display a dialog where you can select to 
display them. 

14 The system returns you to the Buyers Control Center, where the replenishment lines with 
purchase orders generated display at the top of the browser with the warehouse 
highlighted with the Rank color codes assigned on the Buyers Control Center view of PO 
Static Control F/M. 

15 (Optional) You can repeat this process to generate additional purchase orders. 

16 When you have finished generating purchase orders, exit the program. 

Note: To process purchase orders created by the Buyers Control Center, you must run the 
PO Receipt Register program. 

Using surplus inventory to fill replenishment transfers 
1 Click Inventory Control>Warehouse Transfers>Buyers Control Center Transfer and 

use the Transferring items for replenishment using the Buyers Control Center procedure 
to enter the necessary information. 

2 Double click the desired line in the Buyers Control Center to access the Buyers Control 
Center Detail screen. 

3 The buyer, from warehouse, to warehouse, and purchasing line (if any), and review cycle 
information display in the header, as well as target and current information in dollars 
weight and cubes and the variances, and percentage of the target that has been 
achieved. 

4 Specify the ship via for the carrier for the transfer. You can leave this field blank, 
however, a blank field will not create a transfer when clicking Create Transfer because a 
valid Ship Via must be provided in order to create a transfer. The Ship Via value will pass 
to the created transfer ticket. 

5 To use surplus inventory, click Surplus.  
Note: Surplus selection is enabled by setting the Use Surplus flag in PO Static Control 
F/M. When the flag is set, the Buyers Control Center will display an additional column for 
Surplus for each item. 

6 Specify the quantity to use from surplus. 

7 Click Create Transfer. 

8 Specify the ship-via. 
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9 You can optionally update the transfer quantity and a document notes. 

10 Click OK. 

11 Click the transfer ticket created message to return to the BCC Detail screen with the 
surplus quantities applied. 

12 Once you are satisfied with your target values, check the Transfer and Override check 
boxes (as needed) for each line you want to generate transfers for. 

13 Click Create Transfer. 

14 Select Yes to generate transfers and display a dialog where you can select to display 
them or select Continue. 

15 The system returns you to the Buyers Control Center. 

16 (Optional) You can repeat this process to generate additional transfers. 

17 When you have finished generating transfers, exit the program. 

Note: To process return transfers created by the Buyers Control Center, you must run the IC 
Transfer Register program. 

Viewing warehouse quantities 
1 Access the Buyers Control Center for the appropriate activity, and use the Procuring 

replenishment items from the Buyers Control Center, Creating Transfers in the Buyers 
Control Center or Creating Vendor Returns in the Buyers Control Center procedures to 
specify the necessary information. 

2 Double click the desired line in the Buyers Control Center to access the Buyers Control 
Center Detail screen. 

3 The buyer, warehouse, vend or, and purchasing line (if any), display in the header, as 
well as target and current information in dollars weight and cubes and the variances, and 
percentage of the target that has been achieved. Note: For returns and purchases 
(procurement), the GL Department is required if PO to GL Posting F/M is using the 
department for any setting. 

4 The items that have approved replenishment sources for the buyer, warehouse, vendor, 
and purchasing line (if any) are displayed. 

5 To view warehouse quantities, click View>Warehouse Quantities Display. 

6 For each warehouse, the available on-hand, committed, on-order, back-ordered and 
surplus quantities are displayed. 

7 (Optional) Click Change UM to view other available units of measure that are defined for 
the item in UM F/M. Select another UM and click OK to view the quantities in an 
alternate unit of measure. 

8 When you are finished viewing warehouse quantities, click OK. The system returns you 
to the Buyers Control Center Detail screen. 
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Creating BOM production tickets in the Buyers Control 
Center  
1 Click Manufacturing Control> Bill of Materials> Buyers Control Center BOM. 

2 Specify the Buyer Code. 
For Activity Type, Build BOM is displayed by default. 

3 Optionally, specify the warehouse to use. 

4 Optionally, click Add MC Whse to manually add a warehouse for this buyer. 

5 Click Recalculate All to generate BCC lines from Normal/Active status BOM planning 
records for this buyer.  
 
The grid displays the warehouses containing viable planning records existed to be pulled 
into the BCC. 

6 Double click a warehouse line to display the BCC Detail Build BOM (POE407) screen.  
 
If there are no finished items entered for the specified BOM, the BOM Item lookup is 
outlined in red. 

7 Optionally, click the Planning lookup to display the Production Planning Requirements 
(MCE121) for this finished item. 

8 Optionally, modify the Build Qty. 

9 Optionally, check the Rush check box to increase the order priority. To create a rush 
transfer you must ensure the Transfer check box is checked only for the transfer lines 
that are rush. If a transfer contains both rush and normal priority transfer lines then the 
transfer is not set to rush. If you are entering a special order transfer using the Special 
Order check box, and the special order transfer is a Rush priority then the Rush check 
box is automatically selected. 

10 Check the Build check box to select BOM planning records. 

11 Click Create BOM to display the create document message. 

12 Click Yes to create MC BOM tickets for checked lines and the reset planning records 
status to E - Ticket entered. 

13 After each detail line is processed, the completion screen is displayed with the created 
BOM ticket numbers and messages. 

14 Optionally, click to the ticket number to view it in Production Entry (MCE130), where you 
can edit or delete the ticket. 

15 Click OK. 
 
If ticket numbers are not displayed the process was unsuccessful.  
 
The Build check box is automatically unchecked. 
 
If detail lines exist the BOM BCC Detail screen is refreshed for any further action. 
When no more detail lines exist, the main BCC screen is displayed and refreshed.  
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Note: To process BOM production tickets created by the Buyers Control Center, you must 
run the Production Confirmation (MCE140) program. 

Creating formulation production tickets in the Buyers Control 
Center  
1 Click Manufacturing Control> Bill of Materials> Buyers Control Center BOM. 

2 Specify the Buyer Code. 
For Activity Type, Build FML is displayed by default. 

3 Optionally, specify the warehouse to use. 

4 Optionally, click Add MC Whse to manually add a warehouse for this buyer. 

5 Click Recalculate All to generate BCC lines from Normal/Active status FML planning 
records for this buyer.  
 
The grid displays the warehouses containing viable planning records existed to be pulled 
into the BCC. 

6 Double click a warehouse line to display the BCC Detail Build FML (POE408) screen.  
 
If there are no finished items entered for the specified formulation, the Finished Item 
lookup is outlined in red. 

7 Optionally, click the Planning lookup button to display the Production Planning 
Requirements (MCE231) for this finished item. 

8 Optionally, modify the Build Qty. 

9 Optionally, check the Rush check box to increase the order priority. Since production 
ticket lines create individual tickets, production tickets can contain both rush and normal 
priority production ticket lines. If you are entering a special order formulation production 
ticket using the Special Order check box, and the special production ticket  line is a 
Rush priority then the Rush check box is automatically selected. If you are entering a 
special order formulation ticket using the Special Order check box, and the special order 
is a Rush priority then the Rush check box is automatically selected. 

10 Check the Build check box to select FML planning records. 

11 Click Create BOM to display the create document message. 

12 Click Yes to create MC FML tickets for checked lines and the reset planning records 
status to E - Ticket entered. 

13 After each detail line is processed, the completion screen is displayed with the created 
FML ticket numbers and messages. 

14 Optionally, click to the ticket number to view it in Production Entry (MCE240), where you 
can edit or delete the ticket. 

15 Click OK. 
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If ticket numbers are not displayed the process was unsuccessful.  
 
The Build check box is automatically unchecked. 
 
If detail lines exist the FML BCC Detail screen is refreshed for any further action. 
When no more detail lines exist, the main BCC screen is displayed and refreshed.  

Note: To process FML production tickets created by the Buyers Control Center, you must run 
the Production Confirmation (MCE250) program. 

Receiving procedures 

Creating receipt numbers 
The system automatically creates a receipt number once you complete the header. At that 
point, the document number appears in the title bar along with the vendor’s name. You can 
also assign a document number manually if you prefer. 

To assign document numbers manually: 

1 Open Receipt Entry. 

2 Specify the PO number you are receiving, and the system displays the default header 
information for the PO  

3 In the Receipt Number field, enter up to six characters to create a document number. 
You can manually enter receipt numbers, or set the system to automatically assign them.  

4 To continue receiving the PO, refer to the Entering or changing PO receipt information 
procedure for additional information.  

Receiving Direct Ship POs 
If this PO is a direct ship, then the warehouse displayed is the initiating warehouse. The 
warehouse entered for a direct ship is stored only to determine where the PO originated, 
inventory quantities and restocking controls are not affected. The customer number and 
address on file in the sales order selected at Vendor field is displayed. 

Opening existing documents 
You can access existing purchase order documents that have not been received. Once you 
begin receiving a purchase order, the system does not allow to you receive a document in 
the same window. You can also start another session of FACTS if you need to receive 
another PO while you are in the middle of receiving one. 

To receive an existing purchase order: 
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Specify the purchase order number in the PO Number field and press Enter. If the document 
number is on file, the vendor number appears in the field and the purchase order number 
information displays in the header. 

OR 

1 Click File>Open Existing Document.  

Search Tips: Use the Document Search window to find the document you want to edit or 
review. 

2 Click OK in the search window to select the document and return to the main entry 
window. 

Deleting purchase orders receipts 
Deleted purchase order receipts are not simply removed from the file. The system voids 
purchase order line item records and if all the line items for a purchase order are deleted, 
then it changes the header record status to deleted. The purchase order then appears on the 
next purchase orders Receipt Register as deleted and is removed in the subsequent update. 
This procedure provides a complete audit trail of all purchase order numbers used.  

At any point during the PO entry-receipt process, you can view in detail the PO in its current 
state or its overview (history since it was entered) status via the PO Vendor Inquiry or 
Document Inquiry programs. 

To delete an order before the receipt header is complete: 

• Press F4 to back up to the Doc/Vendor field. 

To delete an order after the header receipt is complete: 

1 With the purchase order open on screen, click File>Delete Document from the menu. 

2 At the prompt “Delete this entire document?” select “YES – Delete”. 

3 Click OK to delete the document. 

Editing line item receipts  
You can edit line items on a purchase order receipt. 

To edit an existing line item receipt: 

• Use your mouse or arrow keys to highlight the line in the item browser and press select 
the Edit icon to make changes for the highlighted line item. Press Enter.  
OR 

• Highlight the line and click Line Detail to access fields that do not appear in the line-item 
entry section.  
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Deleting line item receipts 
1 Use the mouse or arrow keys to highlight the line in the item browser.  

2 Click Delete to delete the highlighted PO line receipt, or choose Edit>Delete Item from 
the menu. 

3 At the prompt “Delete this line?” select “YES – Delete”. 

4 Click OK to delete the line or Cancel to exit without deleting. 

Inserting PO receipts line items or memos 
Use the mouse or arrow keys to highlight a line. The program inserts the new line item above 
the selected one. 

Click Insert to add a line item above the highlighted item in the browser, or click Edit>Insert 
Line from the menu. Click Cancel to stop entering line items. 

Finding items in the PO receipt item browser 
This feature may be helpful when you need to find an item you entered on a long order. It 
eliminates the need to scroll up and down in the list browser. 

1 Click Edit>Find Line Item from the menu.  

2 Specify the item number you want to locate. Press Enter to access the first occurrence 
of that item in the item browser on the main screen. Press F2 to find a different item or 
F4 to exit the Find Item window. 

Adding PO receipt line items 
1 Click Add to add a PO receipt line. The system displays the Line Detail for Purchase 

Order screen, which is used to view and modify item descriptions, promise and request 
dates, item details, item/vendor info, and item cost info.  

The program automatically switches to add mode once you complete the header. This 
means the cursor appears in the Item Number field after you exit the last header field. 
The program stays in add mode until you press F4 to back out of the line-item entry 
section or click Stop at the right of the screen. 

Quick entry tip: Specify the item number, the ordered quantity and then press the Down 
Arrow key.  

2 The program uses the default information in the rest of the line-item entry fields and 
returns to the Item Number field. 
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Returning temporary items  
You can process returns for temporary items in the Buyers Control Center (POE400), 
Purchase Order Entry (POE120), Receipt Entry (POE210) and Non-PO Receipt (POE220) 
programs.  

Receiving multiple receipts on a PO 
The Update feature in PO Receipt Entry and Non-PO Receipt Entry allows more than one 
receipt on a PO without running the PO receipt register in between. The Update feature also 
allows on-hand inventory to be updated during PO receipt processing. This processing 
allows the received items to be sold or shipped immediately. Once you click Update and 
complete the security required based on your PO Static Control F/M settings, the system 
updates the on-hand and committed amounts in various files and returns you to the PO# 
prompt in PO Receipt Entry or Non-PO Receipt Entry for more processing. 

Purchase Orders with receipts that were updated in PO Receipt Entry or Non-PO Receipt 
Entry still need to go through the Receipt Register to update GL and invoice files. For 
purchase orders updated in PO Receipt Entry and Non-PO Receipt Entry, the Receipt 
Register skips updating inventory but updates all other files in the register. If a receipt was 
not updated in PO Receipt Entry or Non-PO Receipt Entry, the Receipt Register updates on-
hand inventory files as well as GL and invoice files. 

The Update feature is controlled through a series of prompts in PO Static Control F/M 
(POF980). The prompts ask if you want to implement the receipt entry update feature. If you 
answer is "Y" the next prompt ask for the security code you must have to be allowed to 
access and use the Update. You can also enter a password in PO Static Control F/M that will 
allow the Update processing if the current user in PO Receipt Entry or Non-PO Receipt Entry 
doesn’t have proper security.  

Displaying Purchase Orders 
If you completely receive a purchase order in Receipt Entry (POE210) and Non-PO Receipt 
Entry (POE220) and update it from the entry program, that PO will not appear in the PO Doc 
search feature or in the Document Inquiry (POI620) program. After you run the Receipt 
Register (POR230), the PO will appear in the Past Doc search window and PO Doc Inquiry 
for Past Documents if the proper controls are set in PO Static Control F/M (POF980). 

If the "Update in Receipt Entry" option is set to yes in PO Static Control F/M (POF980), the 
PO Search window contains an Updated PO button that displays a search window containing 
purchase orders that been completely updated in the PO Receipt Entry or Non-PO Receipt 
Entry programs. If you select a purchase order from this search, the system PO Receipts 
Search Window where you can select to view receipts. 
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PO Receipts Search window 
If you try to pull up a purchase order with updated receipts in PO Receipt Entry or Non-PO 
Receipt Entry before the receipt register is run, the system displays the PO Receipts Search 
window with a list of outstanding receipts for that purchase order, an indicator that tells you 
whether the receipt has been updated, the date (if any) of the update, and the received 
amount. When you access this window, the receipt that has not been updated (if any) will be 
highlighted and listed first. After that, receipts will be listed in descending order. 

From this window, you can either select an existing receipt or create a new receipt.  

1 To select a receipt, highlight and click OK. If you select a receipt that has been updated, 
you can only view the receipt in PO Receipt Entry or Non-PO Receipt Entry. Receipts are 
not editable once they have been updated in PO Receipt Entry or Non-PO Receipt Entry.  

2 If all existing receipts have been updated, click New Receipt to create a new receipt for 
the PO. All existing receipts must be updated before you can create a new receipt.  

3 If a PO has never been updated, PO Receipt Entry or Non-PO Receipt Entry programs 
do not display the PO Receipts Search window. 

4 After you create a receipt and access the footer section of PO Receipt Entry or Non-PO 
Receipt Entry, the system displays the Update option when you click Update, depending 
on how the update processing fields of PO Static Control F/M are set. Based on those 
settings, the system may ask for the password you must have to be allowed to access 
and use the Update.  

5 The Update window displays the extension, freight, tax, document total and factor type 
entered in the footer section for the receipt. In the lower portion of the window the system 
displays the message: Inventory quantities will get updated and no further changes will 
be allowed to this receipt. Continue with update? 

6 Answer No—Do not update or Yes—Update. If you select No, the system returns you 
to the footer window. If you select Yes, the update runs (with an hourglass indicator), the 
footer window closes, and the system returns you to the PO prompt in the header portion 
of the screen to await further entries. 

Entering or changing PO receipt information 
1 Click Purchase Orders > Receiving > PO Receipt Entry. 

Complete steps 2-5 to specify PO receipt header information: 

2 In the PO Number field, specify the order number to be received. If you need to change 
or delete an existing PO receipt, specify the existing PO receipt number in this field to 
open it. Press F2 to search. You can search by purchase order number, vendor, and 
ship-from location. 
If you try to pull up a purchase order with updated receipts in PO Receipt Entry or Non-
PO Receipt Entry before the receipt register is run, the system displays the PO Receipts 
Search window with a list of outstanding receipts for that purchase order. From this 
window, you can either select an existing receipt or create a new receipt. Refer to the PO 
Receipts Search window for detailed information about this feature. 
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3 The vendor for the PO displays in the Vendor field. For valid PO numbers, the system 
displays the Ship-from, Warehouse, and Ship-to Codes for the purchase order. The ship-
from and Ship warehouse displayed is where the goods received. If this PO is to be a 
direct ship, then the warehouse displayed is the initiating warehouse. The warehouse 
entered for a direct ship is stored only to determine where the PO originated; inventory 
quantities and restocking controls are not affected. The customer number and address 
on file in the purchase order is displayed. 

4 For new purchase orders receipts, the system displays the Purchase Order dialog box.  
In the Receipt # field, manually specify the receipt number or press Enter to allow the 
system to automatically assign it. The system assigns receipt numbers for each 
purchase order beginning with 00001 and incrementing by one for each receipt up to 
00099. 
In the Received Date field, the system displays the current date as the default for the 
date the purchase order was received. Click OK accept the system date or specify the 
date you received this purchase order. 
At this point, you can receive the entire purchase order in one step. Select the Assume 
receipt? check box to set all received quantities equal to the ordered quantities. The 
system displays this check box selected as the default. If you want to receive the 
purchase order manually, un-select this check box. NOTE: For serial/lot items to be 
received, the system does not assume receipt. Serial/lot numbers must be entered and 
the system prompts you to do so. 
Click OK. 

5 For either manual or automatic receipts, the system displays the vendor, ship-to address, 
buyer, terms code, freight code, ship via, F.O.B. and reference number are displayed in 
the header portion of the screen. You can access the Header Detail for Purchase Order 
screen to modify header fields except vendor number, purchase order number, and ship-
to number by clicking Header in the lower portion of the screen. In the browser, each line 
item is displayed including item number, description, ordered quantity, received quantity, 
back-ordered quantity, buying unit of measure, cost and extension.  
Complete steps 6-16 to specify line items on a purchase order receipt: 

6 To add a line to the PO receipt, click Add.  
For valid item numbers, the system displays item Description 1 and Description 2 fields 
so you can modify the item description lines as necessary. Press Enter to default to the 
existing values in the Item F/M. When you are satisfied with the descriptions, click OK.  

7 In the Ordered field, specify the ordered quantity for the item. 

8 In the Received field, specify the quantity of the item received. Press Enter to accept the 
current value. Press F1 to change the received amount to the ordered quantity. 

9 Receiving serial/Lot items: 
(Optional) For Serial/Lot items, the system displays the Serial/Lot Entry # dialog box. You 
must specify the serial/lot numbers you are receiving and their quantities. *For serialized 
items, specify one serial number for each unit being received. If entering multiple serial 
numbers, specify the first serial number and press F1-Auto Assign to have the system 
generate the remaining numbers. The automatic serial number assignment will increment 
the last series of numeric digits found within the entered serial number. *For lotted items, 
specify the lot number and the quantity. In either case, the serial/lot quantities entered 
must equal the amount in the received column.  
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You have these options. 
 
List-to display the available serial/lot numbers and quantities to be received. 
Add-to add another serial/lot number for the item. 
Cancel-to stop your additions. 
OK-to accept the serial/lot numbers and quantities you have entered. The system checks 
to see if you have entirely distributed the items received.  
 

10 In the Backordered field, specify the quantity of the item that was not received. Press 
Enter to set the back order quantity equal to the ordered quantity minus the received 
quantity. The Allow Backorders flag in the PO Static Control F/M establishes whether 
back orders are permitted. If back orders are not permitted, this field is skipped. This field 
is only used when the Backordered flag in the Purchase Orders Entry Options record is 
set to Y or B.  

11 In the Cost field, the system displays the cost per displayed costing unit of measure.  
 
Press F2 to search for cost contracts for the vendor/item combination. If the current cost 
is not a contract or the standard PO cost, the cost search program will highlight the 
default cost, otherwise the cost currently on the line will be highlighted. 
The system displays (if on file): the manual cost from the item file, the average and last 
costs from the warehouse/item file, the manual and last costs or the contract cost (if 
available) from the vendor/item file. Depending on the Default PO Cost flag set in the PO 
static control record, pressing Enter to default to the manual cost of the item from item 
file or the last cost of the item from the vendor/item file. This field is only used when the 
Cost flag in the PO Entry Options record is set to Y or B.  
 
When a new line is being created, the system automatically calculates the default cost. 
After the cost is entered, the system captures the origin of the cost. If you select a cost 
other than the default cost, the system sets the cost override flag. The system also 
displays Contract to indicate whether the displayed cost is from a contract.  
 
You can access cost details from the View >Cost Origin menu option. 

12 The system displays a dialog box for items. Enter information in the following fields: 
 
Requested-This field is used only when the Requested/Promised Dates flag in the 
purchase PO Entry Options record is set to Y or B. Enter the date you want to request 
receipt for this item. The requested date in the header section is the displayed default 
value. 
 
Promised Date-This field is only used when the Requested/Promised Dates flag in the 
PO Entry Options record is set to Y or B. Enter the date this item is promised for delivery. 
The requested date is the displayed default value. 
 
Lead Time-This check box is used only when the Lead Time flag in the PO Entry 
Options control record is set to Y or B. Select the check box to use this document to 
update the item’s lead-time in the Receipt Register. Press Enter to default to the lead-
time field in the header portion of the screen. If the quantity is a negative amount, this 
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check box is not checked and skipped. 
 
Tax-This field is used only when the Taxable flag in the PO Entry Options record is set to 
Y or B. Select the check box to charge tax on this line-item. Press Enter to default to 
selected. 
 
GL-This field is used only when the GL Table flag in the PO Entry Options record is set 
to Y or B. Enter the GL posting table to use in the Receipt Register to post this line-item 
to GL. Press Enter to default to the GL posting table for the selected item in the item file. 

13 The system displays the Job Number dialog box. At the question: Enter the job number? 
Answer Yes to specify valid job number to post this entry against. Entering a valid job 
number displays the job name, customer number and name, and billing type. Select No 
to not specify a job number and exit the dialog box. 

14 When you have completed these fields, click OK. 

15 You have these options. 
Edit to make changes for the highlighted line item.  
Add to add a PO line. 
Delete to delete the highlighted PO line.  
Insert to add a line item above the highlighted item in the browser.  
Save to save your changes. 
Header Detail to access the Header Detail for Purchase Order Screen, which is used to 
view and modify header information. 
Line Detail to access the Line Detail for Purchase Order screen, which is used to view 
and modify item descriptions, promise and request dates, item details, item/vendor info, 
and item cost info.  
V to access Note Entry (SME710) for the vendor specified in the program. 
I to access Note Entry (SME710) for the item highlighted in line item browser. 
D to access Note Entry (SME710) for the purchase order header record specified in the 
program. 
L to access Note Entry (SME710) for purchase order line records in the line item 
browser.  

16 Click Stop Receipt to the receipt process for this PO.  
 
Complete steps 17-18 to specify PO receipt footer information: 

17 Click Done to display the Footer for Purchase Order dialog box. Enter information in the 
following fields: 
 
Freight-If freight is included, specify the freight amount (.00-9999.99). Press Enter to 
default to 0. Through the Include Freight flag in the purchase orders static control record, 
you establish whether freight is to be entered. If the flag is set to N, no freight is included 
and this field is skipped.  
Tax %- If tax is included, specify the tax percent. The amount is calculated and 
displayed. Through the Include Tax flag in the purchase orders static control record, you 
indicate whether tax should be entered. If the flag is set to N, no tax is included and this 
field is skipped. If the Taxable flag in the PO Entry Options is set to N then only items 
with the taxable flag in the inventory item file set to Y are subject to tax, otherwise only 
those lines that a Y was entered for field #24 are subject to tax.  
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Factor-Indicate the means to factor the freight; i.e., divide the freight equally over the 
line-item costs. The freight factor is stored and not displayed in the screen. The freight 
factor is applied to the cost of line items during the Receipt Register. Specify U-to divide 
the freight by the total units, W-to divide the freight by the total pounds, $-to divide the 
freight by the dollar amount, or N-to not factor the freight at all. Press Enter to initially 
default to the Default Freight Factor flag value stored in the purchase orders static 
control record.  
 
 When you have completed these fields, you can click: 
OK to return to the PO Receipt Entry header portion of the screen. 
Backup to step back through the footer fields. 
Update to update the receipt, which will adjust item and warehouse quantities. Refer to 
the Update Window topic for detailed information about this optional feature. 

Entering return (Negative qty) PO receipts for temporary 
items 
Note: You add temporary item returns PO lines from the PO Entry (POE120), Receipt Entry 
(POE210) and Non-PO Receipt (POE220) programs. 

1 Click Purchase Orders >Receiving> PO Receipt Entry. 

2 Complete the header information as needed. Refer to Creating or changing PO receipt 
information and complete steps 2-5 to enter PO receipt header information. 

3 To add a return PO receipt line for a temporary item, click Add. 

4 Specify the temporary item number. 

5 Answer Yes, when the system asks: Is this a temporary item? 

6 The Required Line Fields (POC999) screen is displayed so you can enter information for 
the temporary item. Specify the following: item description, weight, UM, item class, and 
whether the item is taxable. (Note the vendor is defaulted from the header information.) 

7 Click OK. 

8 In the Ordered, Received and Backordered fields, specify the negative quantities for 
the temporary item. Note that the Ordered quantity must equal the total of the Received 
and Backordered quantities. 

9 Specify the temporary item cost. 

10 You can manage additional PO receipt lines as needed. Refer to Creating or changing 
PO receipt information procedure and continue with step 6 to add additional PO receipt 
lines and complete the purchase order receipt. 

Creating or changing non-PO receipt information 
1 Click Purchase Orders > Receiving >Non-PO Receipt Entry. 

Complete steps 2-6 to specify non-PO receipt header information  
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2 In the Doc/Vendor field, specify the non-purchase order number to be received or the 
vendor for the purchase order receipt. If you need to change or delete an existing non-
PO receipt, specify the existing non-PO receipt number in this field to open it. 

3 Specify a valid vendor code to display all the non-purchase orders for that vendor. You 
can then select a non-PO for correction or inquiry, or press F4--backup to return to the 
non-purchase order number field (#1).  

4 (Optional) To access the Warehouse/Direct Ship Selection dialog box to create a direct 
shipment, press F1. If the non-PO is a direct ship, specify the warehouse that is to be the 
initiating warehouse. The warehouse entered for a direct ship is stored only to determine 
where the PO originated; inventory quantities and restocking controls are not affected. 
For new non-PO receipts, specify the number of the vendor from whom you are 
requesting the items.  

5 If you specify a valid vendor number, the system displays the vendor name and address, 
ship-to and ship-from warehouses, and terms code. You can modify these fields. 
 
Freight--Specify whether freight is B-bill later, P-prepaid, C-collect or A prepay/add. 
Press Enter to default to the freight code in the ship-from file (if specified) or the freight 
code entered in Vendor F/M for the selected vendor. Also, if the ship-from warehouse is 
changed from any value to SAME, the freight code reverts back to the vendor default 
freight code.  
 
Lead Time--Select the Lead Time check box to indicate whether the lead-time from this 
document (number of days from the ordered date to the date of the first receipt) should 
update the average lead-time for the item in the warehouse/item file. The system 
performs this update during the Receipt Register update.  
 
The system defaults the lead time value from the PO header information when you 
initially create a line item on a PO document. Selecting the PO header Lead Time check 
box optionally allows for updating the lead time for all items on the PO to match the 
header lead time just entered. Note that the header Lead Time check box value entered 
here does not override the PO line item’s Lead Time check box value. 
 
F.O.B.--Specify up to 15 characters for freight on board. Press Enter to initially default to 
the F.O.B. in the ship-from file for the selected vendor. 
 
Reference Number-Specify the optional reference number (up to 30 characters). 
 
When you are have completed these fields, click OK. 

6 The system displays the Vendor Info dialog box, which contains the vendor’s message, 
balance, the user’s customer number from the vendor, contacts 1 and 2, and the phone 
number.  
Complete steps 7-15 to specify line items on a non-PO receipt: 

7 (Optional) For Serial/Lot items, the system displays the Serial/Lot Entry # dialog box. You 
must specify the serial/lot numbers you are receiving and their quantities. *For serialized 
items, specify one serial number for each unit being received. If entering multiple serial 
numbers, specify the first serial number and press F1-Auto Assign to have the system 
generate the remaining numbers. The automatic serial number assignment will increment 
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the last series of numeric digits found within the entered serial number. *For lotted items, 
specify the lot number and the quantity. In either case, the serial/lot quantities entered 
must equal the amount in the received column.  
You have these options:  
List-to display the available serial/lot numbers and quantities to be received. 
Add -to add another serial/lot number for the item. 
End-to stop your additions. 
Click OK to accept the serial/lot numbers and quantities you have entered. The system 
checks to see if you have entirely distributed the items received.  

8 Click Add to add a line to the PO receipt.  

9 To process returns for temporary items in the Non-PO Receipt Entry (POE220) program, 
refer to Entering return (Negative qty) Non-PO receipts for temporary items for step-by-
step instructions.  
The system displays the Cost info dialog box for the item. This dialog box contains the 
manual item cost, the manual vendor cost, and the last vendor cost 

10 In the Cost field, specify the cost per displayed costing unit of measure. The system 
displays (if on file): the manual cost from the item file, the average and last costs from 
the warehouse/item file, and the manual and last costs from the vendor/item file. 
Depending on the Default PO Cost flag set in the PO static control record, you can press 
Enter to default to the manual cost of the item from item file or the last cost of the item 
from the vendor/item file. This field is only used when the Cost flag in the Purchase 
Orders Entry Options record is set to Y or B.  

11 You have these options: 
Stop entering line items. 
Line Detail to access the Line Detail for Purchase Order screen, which is used to view 
and modify item descriptions, promise and request dates, item details, item/vendor info, 
lead-time update flag, and item cost info.  
Header Detail to access the Header Detail for Purchase Order Screen, which is used to 
view and modify header information. 
Stop Receipt to stop the receipt process for the document lines. 

Edit to make changes for the highlighted line item.  
Delete to delete the highlighted PO line.  
Insert to add a line item above the highlighted item in the browser.  
Click Save. 
When you are finished with line items, click Done. 

Complete steps 12-19 to specify non-PO receipt footer information: 

12 The system displays the Footer Detail for PO Number dialog box. You can specify 
information in the following fields:  
Freight-- If freight is included, specify the freight amount (.00-9999.99). Press Enter to 
default to 0. Through the Include Freight flag in the purchase orders static control record, 
you establish whether freight is to be entered. If the flag is set to N, no freight is included 
and this field is skipped.  
 
Tax %-- If tax is included, specify the tax percent. The amount is calculated and 
displayed. Through the Include Tax flag in the purchase orders static control record, you 
indicate whether tax should be entered. If the flag is set to N, no tax is included and this 
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field is skipped. If the  Taxable flag in the purchase orders static control is set to N then 
only items with the taxable flag in the inventory item file set to Y are subject to tax, 
otherwise only those lines that a Y was entered for field #24 are subject to tax.  
 
Factor--Specify the means to factor the freight; i.e., divide the freight equally over the 
line-item costs. The freight factor is stored and not displayed in the screen. The freight 
factor is applied to the cost of line items during the Receipt Register. Specify U-to divide 
the freight by the total units, W-to divide the freight by the total pounds, $-to divide the 
freight by the dollar amount, or N-to not factor the freight at all. Press Enter to initially 
default to the Default Freight Factor flag value stored in the purchase orders static 
control record.  
 
Click OK. 

13 The system displays the PO Date Change dialog box; check the Update Lead Time 
check box to update the lead-time for all line items on the PO. The Update request date 
and Update promised date check boxes are displayed only when the 
Requested/Promised Dates flag in the PO Options Entry record is set to Y or B. If you 
change dates in the header section of the screen, the system also displays this dialog 
box. 

14 When you have completed these fields, you can click: 

OK to return to the PO Receipt Entry header portion of the screen. 
Backup to step back through the footer fields. 
Update to update the receipt, which will adjust item and warehouse quantities. Refer to 
the Update Window topic for detailed information about this optional feature. 

Entering return (Negative qty) Non-PO receipts for 
temporary items 
Note: You add temporary item return PO lines from the PO Entry (POE120), Receipt Entry 
(POE210) and Non-PO Receipt (POE220) programs. 

1 Click Purchase Orders >Receiving> Non-PO Receipt Entry (POE220). 

2 Complete the header information as needed. Refer to Creating or updating non-PO 
receipt information and complete steps 2-6 to enter non-PO receipt header information. 

3 To add a return non-PO receipt line for a temporary item, click Add. 

4 Specify the temporary item number. 

5 Answer Yes, when the system asks: Is this a temporary item? 

6 The Required Line Fields (POC999) screen is displayed so you can enter information for 
the temporary item. Specify the following: item description, weight, UM, item class, and 
whether the item is taxable. (Note the vendor is defaulted from the header information.) 

7 Click OK. 
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8 In the Ordered, Received and Backordered fields, specify the negative quantities for 
the temporary item. Note that the Ordered quantity must equal the total of the Received 
and Backordered quantities. 

9 Specify the temporary item cost. 

10 You can manage additional non-PO receipt lines as needed. Refer to the Creating or 
changing non-PO receipt information procedure and continue with step 7 to add 
additional non-PO receipt lines and complete the non-PO receipt. 

Running the Receipt Register 
1 Click Purchase Orders >Receiving>Receipt Register. 

2 In the Warehouse field, specify the 2-character code to indicate the warehouse to use 
for the Receipt Register print. Press Enter to default to the warehouse assigned to the 
terminal.  

3 In the Date field, specify the purchase orders Receipt Register date. This date is used to 
determine the correct period in which to post in the inventory control, purchase orders 
and general ledger systems. The date must be within the current or next GL period. 
Press Enter to default to the system date. Note: The system displays the current PO, 
AP, and GL periods in the upper left portion of the screen as a reference.  

4 In the PO field, specify the purchase order number(s) to process.  

5 Click OK. 

6 If you are printing the GL distribution, the system displays the following message: 
Receipt Register. OK to Print GL Distribution?  
 
After printing the Receipt Register, verify the printout. If you need to correct the register 
data, click Cancel to exit the program. After you make the correction, you can rerun the 
Receipt Register. If everything is correct, click OK to continue. The program then prints 
the GL distribution.  
 
Once the GL distribution is printed, the program displays the message: Check Gl 
Distribution. OK to Update? 
 
After printing the distribution, verify the printout. If everything is correct, click OK to 
continue. The program proceeds with the update. If you need to make a correction, click 
Cancel to exit the program. After you correct the information the correction is made, re-
run the entire register process—meaning run the register first, then print the GL 
distribution, followed by the optional update. 
 
OR 
 
If you are not printing the GL distribution, the program displays the message: Receipt 
Register. OK to Update? 
 
After printing the Receipt Register, verify the printout. If you need to make a correction, 
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click Cancel to exit the program. After you make corrections, rerun the register. If 
everything is correct, click OK to continue. 

Non-PO receipt procedures 

Creating Non-PO Receipt document numbers 
The system automatically creates a document number once you complete the header. At 
that point, the document number appears in the title bar along with the vendor’s name. You 
can also assign a document number manually if you prefer. 

To assign document numbers manually: 

1 Open Non-PO Receipt Entry. 

2 Click File>New Document Number from the menu.  

3 Specify up to six characters to create a document number. Click OK or press Enter. 

4 Begin creating the order, starting with the Vendor Number. Refer to the Entering or 
changing purchase orders information procedure for additional information.  

Assigning document numbers automatically 
You can specify non-purchase order numbers or have them automatically assigned by the 
system. For manual non-purchase order receipt numbers, specify any number up to 999999. 
The system displays information for non-purchase order numbers already on file. To use 
automatic non-purchase order numbers, select File>New Document Number to access the 
Assign non-PO Number dialog box and click Assign. You can manually select anon-PO 
receipt number to assign, or the system assigns the next available number. The system 
displays the word NEXT at the top of the screen until the header portion is completed. 

Creating direct ship POs 
To access the Warehouse/Direct Ship Selection dialog box to create a direct shipment, press 
F1. If the Non-PO receipt is a direct ship, enter the warehouse that is to be the initiating 
warehouse. The warehouse entered for a direct ship is stored only to determine where the 
PO originated; inventory quantities and restocking controls are not affected. This becomes 
the ship-to address on the purchase order. You can press F4-backup and override the 
address, or continue to back up to the warehouse prompt. 
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Returns for temporary items  
You can process returns for temporary items in the Buyers Control Center (POE400), 
Purchase Order Entry (POE120), Receipt Entry (POE210) and Non-PO Receipt (POE220) 
programs. Refer to the PO Returns Processing for Temporary Items topic for details. 

Invoice receiving procedures 

Entering or changing invoice receipt information 
1 Click Purchase Orders >Invoice Receiving > Invoice Receipt Entry. 

Complete steps 2-6 to enter invoice receipt header information 

2 In the Period field, the system displays the current system period. This is the period to 
which this invoice receipt information posts (PPYY). The current accounts payable period 
is displayed in the upper right corner of the screen and is the default value. The period 
cannot be before the current accounts payable period and must be either the current or 
next general ledger period.  

3 In the Vendor field, enter the number of the vendor for the invoice.  
 
The system displays the vendor name, address, message, GL table, document group, 
branch (if used) and terms code from the vendor’s record in the accounts payable vendor 
file. 
 
Search Tips: 
Press F2 to perform a document search by vendor. You can also search by invoice 
receipt numbers.  
You can search for invoice receipt documents. You can enter the beginning vendor to 
search for. If you press Enter, the program lists in document order any existing invoice 
receipt documents that exist. Also displayed are the date entered, due date, amount, and 
vendor number and name.  

4 In the Document field, enter the document number for the invoice receipt.  

5 You can enter or modify information in the following fields: 
 
GL Tbl--Specify the number of the accounts payable General Ledger posting table to be 
used for this invoice. The general ledger posting table number stored with the vendor is 
the displayed default value. The entry must be a valid GL posting table. This table is 
used in the line-item portion of the entry to provide default values for the General Ledger 
account number field. 
 
Doc Grp--Specify the document group number that applies to this invoice. The program 
defaults to the group code created in the vendor’s record in AP Vendor F/M. This group 
number is stored with the Accounts Payable document record when it is created by the 
Invoice Receipt Register update. Document group numbers are used by several 
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Accounts Payable reports to categorize documents. 
 
Branch--Specify the valid branch number that applies to this invoice. Press Enter to 
default to the branch assigned to the terminal. 
 
Terms Code--Specify the valid payment terms code that applies to this invoice. The 
terms code stored with the vendor is the displayed default value. The terms code is used 
to determine the due date and discount amount. 
 
Doc Amount--Specify the document (invoice) total amount (+/-9,999,999.99). 
 
When you add invoice receipt lines in the lower portion of the screen, you can modify the 
Doc Amount value via the Header button to distribute the costs for the additional lines.  
 
Doc Dis--At the bottom of the screen, enter the amount on which to compute a discount. 
Press Enter to default to the document amount. (Freight may not be discountable.) 
 
Document Date--Specify the document (or invoice) date. The system date is the 
displayed default value. 
 
Due Date--Specify the due date for this document (invoice). Press Enter to allow 
automatic calculation of the due date based on the terms code and to proceed to field 
#14. 
 
Discount--If the automatic date and amount calculation were selected in field #11, this 
entry is skipped. Otherwise, enter the invoice discount. The discount may be entered as 
a dollar amount or a percent of the invoice amount. Entry of a discount percent must 
include the percent symbol (%) after the number. The discount amount is calculated and 
displayed. The default value is the amount calculated by the system based on the 
entered terms code. Any amount less than or equal to the invoice amount is accepted. It 
is not necessary to enter the negative symbol (-) for normal discount amounts. 
 
Discount Due Date--If automatic date and amount calculation are to be selected in field 
#11, this entry is skipped. Specify the date by which payment must be made to be 
eligible for the discount. Press Enter to initially default to the date calculated by the 
system based on the given terms code. 
 
Memo--Specify the document memo (up to 25 characters). Press Enter to skip this 
entry. The memo entered appears on the stub portion of the accounts payable check, 
generated through the entry of this invoice, the Invoice Receipt Register and the normal 
accounts payable check selection process. 
This concludes entry of the header portion of the invoice receipt. After the record is 
created, all fields except #1-3 are accessible through the change header routine. Fields 
#1-3 can only be changed by deleting and re-entering the invoice. 
 
In the lower portion of the screen the system displays any existing PO receipt lines for 
the invoice receipt  

6 Complete steps 6-15 to enter invoice receipt lines 
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7 You have these options. 

Highlight the line you want to delete then click Delete PO. The system verifies you want 
to delete the selected PO receipt line item before completing the process.  

Click Header to modify header information invoice receipt. Refer to Header Detail for PO 
Invoice Receipt Entry topic for field descriptions.  

Highlight an existing PO receipt line item and click Line Detail to access the Line Detail 
for PO Invoice Receipt Entry screen.  

Click Edit to make changes for the highlighted line item.  

Click New PO to access the New PO dialog box, which is used to enter new PO Receipt 
line items for invoice receipt. From the New PO dialog box, you can select to import all 
line items from a specified PO receipt or only selected PO lines. If you select to import 
selected lines, the system displays the Receipt Item Selection Screen so you can select 
PO receipt lines to import for invoice receipt. 
 
The line-item entry portion of the program allows the field of up to 999 line-items to 
complete the invoice receipt. Line numbers are assigned automatically beginning with 
001 and incrementing by one for each additional line-item up to 999. In the rare case 
where 999 line-items have been entered on a single invoice, the program refuses further 
entries. The fields for entering new POs are the same as for adding received purchase 
orders. Refer to step 11 for field descriptions.  

Click Add to add an invoice line to the PO invoice receipt, or click Insert to add a line 
item above the highlighted item in the browser. Enter information in the following 
fields: 
 
PO #  
For received POs, enter the received purchase order number. 
 
Receipt # 
For received POs, enter the receipt number that was entered during Receipt Entry for 
this purchase order. The number displayed is default value. Press Enter to default to 
the receipt number entered on the previous line (if applicable). 
 
WH (Warehouse) 
If the PO and receipt number entered are the same as the previous line, this field is 
skipped and the warehouse is set to the same warehouse as the previous line. Enter 
the warehouse the item on this PO was received at. Press Enter to default to the 
warehouse assigned to the purchase order. 
 
Item  
Enter the item number. If the item is not a valid item, the system checks to see if it is 
an interchange or a vendor-item number; if either of the latter are true the system 
automatically prints the valid item number and sets its defaults. Entering a valid item 
number displays the vendor relation, last lead-time, vendor-item number, item class, 
standard package size, and buying weight. The relation is considered primary if this 
vendor number is stored with the item in the inventory control item file. If not a 
primary relationship, the relation is considered secondary when there is record of 
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purchase of the item from this vendor. Otherwise, the relation is considered unlisted.  
 
Description 
This field is initially skipped except for non-stocked items. Enter the item description. 
Press Enter to default to the displayed value. 
 
G/L # 

Enter a GL account number. The entry must be a valid GL account number. This is 
the GL account number that the Invoice Receipt Register expenses the cost of the 
item against. 
 
Units 
Enter the quantity of items to be received. The entered amount should be equal to 
the invoice quantity. Press Enter to default to displayed value. 
 
Cost 
Enter the cost per displayed costing unit of measure. Displayed if on file is: the 
manual cost from the item file, the average and last costs from the warehouse/item 
file, and the manual and last cost from the vendor/item file. Depending on the Default 
PO Cost flag set in the PO static control record, Press Enter to default to the manual 
cost of the item from the item file or the last cost of the item from the vendor/item file. 
This field is only used when the Cost flag in the Purchase Orders Entry Options 
record is set to Y or B.  
The system displays: Enter Job Number Y or N. If you select Y, the system displays 
the Job Posting Entry screen. Enter the valid job number to post this entry against. 
Press Enter to default to the last job number entered (if any). For valid job numbers, 
the system requests customer code, you can enter a value or search. The system 
then requests a memo for the posting entry. You can indicate whether you want this 
memo to print on the PO invoice. Note: If the Use Job Cost flag is set to N in the 
purchase orders static control record or if the item is a special order or the purchase 
order is a direct ship, the system skips this field. If you enter Y, fields #11-17 must be 
entered. 
 
Job number 
Enter the valid job number to post this entry against. Entering a valid job number 
displays the job name, customer number and name, and billing type. Press Enter to 
default to the last job number entered (if any). 
 
Price Message 
If the billing type for the job entered is fixed, contract or time and material, this field is 
skipped. If the billing type is cost + (plus) or no charge, the program displays the 
price (bill rate) that will be used to calculate the extension. If the job is no charge, 
then the markup method can be changed if the allow billing override flag for the cost 
code is set to Y and neither the bill rate nor extension will be affected. Press Enter to 
continue. 
 
Cost code 
Enter a valid cost code (up to 4 characters). Entering a valid cost code displays the 
cost code description and the cost type. If the cost code is not set up to use units 



Transaction Procedures 

100 | Infor Distribution FACTS Purchase Orders User Guide 

(unit of measure field is blank in Cost Code F/M), the program displays a message 
displaying this information. The cost sets the defaults for markup method (for all jobs 
that are not billed as cost plus) and the billing rate for jobs that are billed as a fixed 
contract or as time and material. If the billing type is not cost plus, the cost code also 
determines whether the user is able to override the markup method and or bill rate. 
The item entry determines the units, unit of measure and cost rate/extension. 
 
Markup 
This field is initially skipped and set to the markup assigned to the cost code. This 
may only be entered for jobs which are time and materials or fixed contracts and the 
Allow Override Of Billing flag is set to Y in the cost code record. This may also be 
changed for no charge jobs but the bill rate is not affected. 
Enter the markup method to use for this posting entry. You can enter one of the 
following: 

#  

Enter the markup amount (0-9999999.99). Entering a number tells the system to 
mark up the cost by a dollar amount. The system marks up the cost rate by the dollar 
amount and calculates the bill extension. 

#+%  

Enter the percentage (0-9999999.99%) to mark up the cost. To enter a percentage, 
the user must enter an amount and then the percentage sign. If no percentage sign 
is present, the system assumes the entered amount is a dollar amount. The system 
marks up the cost rate by the percentage amount and calculates the bill extension. 

M Enter the bill rate manually. Entering M displays the word MANUAL and the 
program proceeds to the bill rate field. 

The fixed markup method is unavailable for selection, but can be used. To utilize the 
fixed method, select a cost code whose markup method is fixed. 

Enter initially defaults to the markup method (amount/percentage) from the cost code 
record. 

 
Bill rate 
This field is unavailable if the Allow Billing Override flag in the cost code record is set 
to N. This field is initially skipped unless the markup method of the cost code is 
manual. Enter the price per displayed unit of measure. The bill extension is 
calculated and displayed. Press Enter to initially default to 0. 
 
Memo 
Enter the memo to post for this job cost transaction and to print on the job cost 
invoice (if applicable - see next field). Press Enter to initially default to blanks. 
 
Print memo on job cost invoice? 
This field is initially skipped and set to N. Enter N or Y to indicate whether to print the 
memo (entered in the previous field) on the job cost invoice. The field may only be 
set to Y if the billing detail for the cost type (that the cost code is assigned to) is set to 
A for all transactions in the Job Entry program. Press Enter to initially default to N. 
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Enter -continue, F4-backup 
Press Enter to continue, accept the line or press F4 backup. 

16 Save your changes.  

17 You have these options. 

Cancel to stop entering line items.  

Delete to delete the highlighted PO receipt line.  

18 Click Done, and the system checks to ensure the undistributed amount of the invoice 
equals zero then processes the invoice receipt. The undistributed amount of the invoice 
must equal zero to end the program. If no line items were entered, the program may not 
be ended. 

Running the Invoice Receipt Register 
1 Click Purchase Orders> Invoice Receiving>Invoice Receipt Register. 

2 In the Beginning Vendor field, enter the starting vendor code for the register.  

3 In the Ending Vendor field, enter the ending vendor code for the register.  

4 In the Branch field, enter the branch number for which to run the register. The program 
defaults to the branch assigned to the terminal.  

5 Click OK to print the register. The system prints the register for the selected vendors.  

6 The system displays the message: Invoice Receipt Register: OK to Update? 
 
After printing the Receipt Register, verify the printout. If you need to correct the register 
data, click Cancel to exit the program. After you make the correction, you can rerun the 
Invoice Receipt Register. If everything is correct, click OK to continue. The program then 
prints the GL distribution.  
 
NOTE: This register does not print a GL distribution or post to General Ledger. During 
the update, the program writes documents to the AP document entry file. You should run 
the AP Document Entry and Adjustment Register immediately following this update. The 
AP register prints the documents to post into the open payables file and prints the GL 
distribution (if used). The update posts documents to the open payables file and 
optionally posts to General Ledger. 

Cost contracts procedures 

Managing vendor cost contracts 
1 Click Purchase Orders >Cost Contracts> Contract Entry. 

2 In the Vendor field, specify the vendor for the cost contract.  
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3 To add a contract for this vendor, click Add. To edit a contract, highlight it in the browser 
and click Edit to display the Cost Contract Information screen where you edit the contract 
expiration date, costing information, or memo. To delete a contract, highlight it in the 
browser and click Delete.  

4 For new contracts specify the following: 
the warehouse for this contract. Press F1 for All, F4 to backup, F2 to search for 
warehouses. 

the effective contract date 

the item scope of the contract. You can select from I Specific Item, C Cost Class, or A All 
Items. Press Enter to accept A, the default. If you select I, the next prompt is Item. If you 
select C, the next prompt is Cost Class. If you select A, the system disables the next 
prompt. 
 
Specify the item for this contract. Press F2 to search or F4 to back up. 
-OR- 
Specify the cost class for this contract. Press F2 to search or F4 to back up. 
 
Specify customer number for contracts used for special orders (i.e. a purchase order tied 
to sales order). If you specify a customer number for the cost contract, then it is available 
only for special orders for the customer indicated. Press F1 to specify N/A, F2 to search 
for customers, or F4 to backup. 

5 Press Enter to display the Cost Contract Information screen to specify contract detail 
information.  

6 Specify the contract expiration date. Press F1 to specify None or F4 to backup. If the 
date causes the contract to overlap another contract with the same scope, a message 
will be given, and a new date must be entered. 

7 Select the Required check box to indicate that this is the required cost when selling to 
this customer. 

8 Select the Quantity Breaks check box to include quantity breaks.  
 
If you select the Quantity Breaks check box, for level 1: 

Specify the quantity for break 1. Press F1 to specify None or F2 to change the UM, or F4 
to backup. You can leave the quantity blank, and if it is, all remaining breaks are disabled 
and blanked. If this is the first break and the value is left blank, you can still specify a 
cost. But if you specify a blank in the quantity of subsequent breaks, you cannot specify 
a cost. The quantity must be greater than the previous break’s quantity. The cost entered 
should be lower than the previous break’s cost, and if it isn’t, the system displays a 
message indicating this. 

9 You can press F2-Change UM only for the first break and only when the scope is for a 
specific item. Press F1 to set the field to blank and move on to next field.  
 
Press F2 to select any valid buying UM for the item. If quantities are already entered, the 
system converts the quantities to the new UM. 
 
For Break 1, you can press F1 to specify Basis/Multiplier instead. Press F4 to backup.  
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OR 
 
Enter the basis for the contract cost. You can press F1 to specify a Fixed Cost or F4 to 
backup. For the Basis you can select from: M--Manual Cost, L--List Price, 1--Quantity 
Break 1, 2--Quantity Break 2, 3--Quantity Break 3,4--Quantity Break 4, or 5--Quantity 
Break 5 (if available). 

10 If you specify M, L, or P, the system goes to the Multiplier prompt. The default value is L 
for the first break, but subsequent breaks default to the previous break’s basis. Options 
1-5 are only valid for breaks 2 through 6, and the only ones available are the breaks prior 
to the current break, so for break 4, you have the option of breaks 1 through 3 as the 
basis. 

 
OR 
 
Enter a Fixed Cost for the contract cost. The Fixed Cost field is only available if the 
scope is for a specific item. 

11 Specify the contract memo. Press F4 to backup. 

12 Click OK when you have entered the contract costs details. The system returns you to 
the Contract Entry screen, where you can add, edit or delete contracts for the specified 
vendor.  

13 When you have finished with contracts for this Vendor, click Done. You can specify 
another vendor or click Done (again) to exit the program.  

Inquiries procedures 

Viewing vendor information 
1 Click Purchase Orders >Inquiries >PO Vendor Inquiry. 

2 In the browser in the upper portion of the screen, the system displays the available 
vendors in the system. You can select a vendor by double clicking it in the browser. You 
can enter a specific vendor in the Go To to locate a specific vendor to use as the 
beginning display in the browser. The Go to field is case sensitive. This means that if you 
specify v100 to lookup a vendor number when someone entered it as V100, the 
customer record you are looking for will not appear in the browser. 

3 In the center section of a screen, select the view that contains the type of information you 
want to see for this specified vendor. You can select from these views: 
 
Items, which displays the item number, item description and vendor/item number. In the 
view area, select the line that you want more detail on and click Line Detail, or you can 
double click the icon at the beginning of that line. The Item Detail window provides 
information on last receipt, manual cost, month-to-date, year-to-date and prior year 
history. 
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Past purchase orders, which displays past PO information including PO number, receipt 
number, date received, warehouse code, ship-to, warehouse or direct ship type, buyer 
and amount. In the view area, select the line that you want more detail on and click Line 
Detail, or you can double click the icon at the beginning of that line. The Past Purchase 
Order detail window provides document header information, line items and gives you 
access to receipts. 
 
Purchase orders, which displays purchase order information including document number, 
type (purchase order, backorder, non-invoiced receipt), status (entered but not printed, 
printed, received, deleted, voided after received), confirmation setting, requested date, 
promised date, warehouse, ship-to location, buyer code and the amount. Job Cost users: 
If the item was purchased for a job, the job number, cost code, entry memo and bill 
extension also appears in the view area. In the view area, select the line that you want 
more detail on and click Line Detail, or you can double click the icon at the beginning of 
that line. The Purchase Order detail window provides header and line item information. 
You can choose to view the status of the purchase order since it was created (Overview), 
including any received quantities, or you can view it as it appears in the entry program 
(Current), with extended cost. 
 
Receipts, which displays purchase order receipts information in its entirety including, 
document number, receipt number, received date, warehouse, terms code, amount 
(original cost), and invoice. In the lower view portion of the screen, the system displays 
all lines for the receipt. In the view area, select the line that you want more detail on and 
click Line Detail, or you can double click the icon at the beginning of that line. The 
Receipts detail window enables you to view line details for items that appear on the 
receipt. The detail information includes the status of the line, located in the ‘S’ column 
(blank is ‘open’ and C is ‘complete’), as well as the invoice number that a line is attached 
to. 
 
Ship-from addresses, which displays ship-from information from the vendor ship-from file 
including ship-from code, vendor name, contact person and phone number. In the view 
area, select the line that you want more detail on and click Line Detail, or you can double 
click the icon at the beginning of that line. The Ship-from detail window provides address 
information, both contacts, ship via method, F.O.B., and buyer code. 
 
Planned Special Order purchase orders, which displays planned special order PO 
information including item number, item description, warehouse code, units, unit of 
measure, order number, line number for which the planned special order PO was created 
and planned special order PO type (R-restocking or S-special order). In the view area, 
select the line that you want more detail on and click Line Detail, or you can double click 
the icon at the beginning of that line.  
 
Contracts, which displays all cost contracts on file for the vendor. 
 
Costing, which displays the vendor’s default cost class, cost hierarchy, and use lowest 
cost flag. 
 
Notes, which displays the notes for the specified vendor. 
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User-Defined, which displays data from the User-Defined view of Customer Inquiry 
comes from the User-Defined view of Vendor F/M (APF910P).  

Contacts, which displays the vendor’s phone numbers, contacts, email addresses, 
Vendor company web site, and any message entered about the vendor (on the Vendor 
F/M Miscellaneous screen). 

4 When you are finished reviewing information for vendors, click Exit to close the Vendor 
Inquiry program. 

Viewing item information 
1 Click Purchase Orders >Inquiries >Item Inquiry. 

2 In the browser in the upper portion of the screen, the system displays the available items 
in the system. You can select an item by double clicking it in the browser. You can enter 
a specific item number in the Go To field to locate a specific item to display detail 
information in the browser. The Go to field is case sensitive. This means that if you 
specify i100 to lookup an item number when someone entered it as I100, the item record 
you are looking for will not appear in the browser. 

3 In the center section of a screen, select the view that contains the type of information you 
want to see for this specified item. You can select from these views. 
 
The Activity view displays current period item activity from the warehouse/item file 
including the warehouse, beginning on hand, receipts, production, adjustments, sales, 
transfer in/out, current on-hand, month-to-date, year-to-date, and prior year sales units 
and dollars, last sale date, lowest on-hand for the period and the 12 period average. The 
out-of-balance (*) quantity is the difference between the actual on-hand and the 
calculated on hand. The out-of-balance is caused by the fact that many transactions 
update the actual on-hand and provide an after-the-fact audit trail which later updates the 
sales or the adjustments figures listed on this screen. During normal processing in a 
period, many items are out-of-balance. All items should be in balance however just prior 
to the end of the period after all registers have been run and updated. 
 
For sales orders, the Blanket SO view displays order information including document 
number, warehouse, type (O-open work orders, B-backorders, I-invoices, C-credit 
memos and S-counter sales), status (E-workorder entered, not printed, W-workorder 
printed, C-confirmed invoice, I-invoice printed, R-invoice released, D-deleted sales order 
and V-voided invoice), entry date, units ordered, units backordered, selling unit of 
measure, price, pricing unit of measure and customer number. For equipment rentals, 
the system displays information for sales from equipment rental including the contract 
number, warehouse, document type (C-rental contract, D-invoice/credit memo), status 
code (E-entered, P-printed, R-returned, I-invoiced, D-deleted, V-voided), line number on 
which the item appears, entry date, number of units, stocking unit of measure, price, and 
customer name. 
 
The Cost view displays costing information including standard, average, last, manual, 
markup percent, suggested (if on file), and date of last cost change.  
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The General view displays general file information including vendor, item class, 
sequence number, vendor-item number, GL table, freight class, date established, 
substitute items, taxability, status codes (update inventory, misc. sale, manufactured, 
serial/lot) and commission percent (no priority indicates commission percent for item is 
not used). 
 
The Interchange view displays all interchange items and memos for the item. 
 
The Ledgercards view displays ledgercard information including warehouse, sequence 
number, date, transaction type, units affecting inventory, new on hand quantity, 
document number and register number. 
 
If LIFO or FIFO costing information is maintained, the LIFO/FIFO view displays up to the 
last 10 levels stored of LIFO/FIFO costing is displayed along with a weighted average of 
the costing layers. 
 
If Material Safety Data Sheets (MSDS) information is maintained, the MSDS view 
displays the MSDS ID and description, the hardcopy literature location, electronic 
(online) file location and print code, the revision date, and the requirements for 
distributing the MSDS.  
 
For sales orders, the Orders view displays order information including document number, 
warehouse, type (O-open work orders, B-backorders, I-invoices, C-credit memos and S-
counter sales), status (E-work order entered, not printed, W-work order printed, C-
confirmed invoice, I-invoice printed, R-invoice released, D-deleted sales order and V-
voided invoice), entry date, units ordered, units backordered, selling unit of measure, 
price, pricing unit of measure and customer number. For equipment rentals, the system 
displays information for sales from equipment rental including the contract number, 
warehouse, document type (C-rental contract, D-invoice/credit memo), status code (E-
entered, P-printed, R-returned, I-invoiced, D-deleted, V-voided), line number on which 
the item appears, entry date, number of units, stocking unit of measure, price, and 
customer name. 
 
The Package view displays packaging information including units of measure, conversion 
factors, standard pack (buying unit of measure) and weight. 
 
The Price view displays pricing information including standard current and suggested (if 
on file) price, pricing unit of measure, standard and suggested (if on file), pricing for 
levels used by the system (1-6 as set in the IC static control record), date of last price 
change, and effective date of suggested prices (if applicable) as well as quantity break 
information, including the effective date, for all units of measure displayed. 
 
The Purchasing view displays purchase order information including purchase order 
number, type (P-purchase order, B-backorder, R-noninvoiced receipt), status (E-entered 
but not printed, P-printed, R-received, D-deleted, V-voided after received), vendor, 
warehouse, requested date, promised date, received date, units, buying unit of measure, 
cost and costing unit of measure. 
 
The Receipts view displays receipt information for the last 5 receipts including the PO 
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number, received date, units received, stocking unit of measure, received cost, costing 
unit of measure, lead time, lead time status (abnormal, normal, or ignored) and the 
vendor. 
 
The Restocking view displays restocking information including warehouse, movement 
class, seasonality (N-nonseasonal, H-high seasonal, or L-low seasonal), usage rate, 
restocking type-order point, line point or minimum stock, maximum stock, order quantity 
method, order quantity, restocking warehouse, average lead time, frozen date, periods 
frozen and controls frozen (restocking amounts, order quantity, lead time and/or safety 
allowance). 
 
The Serial/Lot view displays the serial information including the warehouse, serial/lot 
number, DOC number, received date, vendor purchased from, received cost, on-hand 
quantity and location in warehouse. In the Start From field, specify beginning serial/lot 
number to list or specify the line number to display in detail. Detailed serial/lot information 
includes availability ( YES, NO or in EQUIPMENT RENTAL inventory), expiration, memo 
and last usage 
 
The Warehouse view displays warehouse information for all warehouses from the 
warehouse/item file including warehouse, on hand quantity, quantity committed, quantity 
available, quantity backordered, quantity on order, stocking unit of measure, date of last 
physical, (bin) location, movement class and seasonality (N-nonseasonal, L-low 
seasonal or H-high seasonal). 
 
The Transfer view displays transfer information including ticket number, status (E - 
entered, P - printed, S - shipped, T - transferred and R - received), From warehouse, To 
warehouse, entry date, units shipped, units received, stocking unit of measure, and 
memo. 
 
The Turns view displays turn information including for each of the last 12 periods, the 
usage and end-of-period on hand quantity. Summary information displays the 12 period 
usage and the 12 period average on hand and calculates the number of turns. 
 
The Usage view displays usage information including qualified and actual usage, 
stocking unit of measure, number of stock-out days, the percentage dip below the safety 
stock for the current period and the last 12 periods and the stock-out date. 
 
The DOT view displays the DOT code, freight class, ERG#, technical or chemical name.  
 
The STD Part Number view displays the source code, standard part number and code.  
 
The Production view displays production information including ticket number, warehouse, 
type (B-bill of material and F - formulation), status (E - entered, P - printed and C - 
confirmed) units, stocking unit of measure, scheduled date, production date, and memo 
(component or finished item) and number produced or finished item. 
 
The Vendor view displays vendor information including warehouse, vendor number and 
name, vendor-item number, manual cost, last receipt information, and history information 
including month-to-date, year-to-date and prior year units and dollars. 
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The Companions view displays the companion items and memos defined for the item 
being inquired upon.  
 
The Notes view displays notes information for the specified item. In the browser in the 
lower portion of the screen the system displays the date the note was created, note 
category, urgent note indicator, and subject. You can double click a note line in the 
browser to display the View Note screen, which lists the note subject and text, note type, 
category, date created, and date edited. You can access the Notes Entry (SME710) 
program from the Options->1 Item Note Entry to enter or modify notes for the specified 
item. 

4 When you are finished reviewing information for vendors, click Exit to close the Item 
Inquiry program.  

End of period procedures 

End-of-period checklist: purchase orders 
Period ________ Year ________ 

User Date Menu Description 

_____ _____ Receiving 1. Complete all PO 
entry/receipts and print/update 
last Receipt Register 

______ _____ Invoice Receiving 2. Complete all invoice receipts 
and print/update last Invoice 
Receipt Register  

______ _____ EOP 3. Print/update Period Receipts 
Report 

______ _____ EOP 4. Print/update Invoice 
Receipts Report 

______ _____ EOP 5. Print/update Receipts 
Discrepancy Report 

_____ _____ EOP 6. Run End-of-Period Update 
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End-of-period checklist explanation for purchase orders 
1 Complete all purchase order entry and receipts and print/update last Receipt Register. 

2 Complete all invoice receipts and run print/update last Invoice Receipt Register. 

If the above procedures are not complete, then the purchase figures will not be an 
accurate accounting of the period. 

3 Print/update the Period Receipts Report.  The Period Receipts Report lists all purchase 
order receipts for the period. After you print and review the report, you should remove the 
records just printed to clear the file. (You must print for all options; e.g., all warehouses, 
all branches, all vendors, etc., to access the optional update.) You should keep all Period 
Receipts Reports as an audit trail. 

4 Print/update the Period Invoice Receipts Report.  The Period Invoice Receipts Report 
lists all invoice receipts for the period. After you print and review the report, you should 
remove the records just printed to clear the file. (You must print for all options; e.g., all 
warehouses, all branches, all vendors, etc., to access the optional update.) You should 
keep all Period Invoice Receipts Reports as an audit trail. 

5 Print/update the Period Receipts Discrepancy Report.  The Period Receipts Discrepancy 
is Report lists all discrepancies between the purchase orders received and the invoices 
received for those purchase orders. After you print and review the report, you should 
remove the records just printed to clear the file. (You must print for all options; e.g., all 
warehouses, all branches, all vendors, etc., in order to access the optional update.) You 
should keep all Period Receipts Discrepancy Reports as an audit trail. 

6 Run the End-of-Period Update. You must run the End-of-Period Update program to close 
Purchase Orders for the period. This program resets the month-to-date, year-to-date, 
and prior year sales figures, as necessary, in the vendor/item file. The program also 
increments the current period. 

Step 6 is the last step to closing the Purchase Orders module’s current period and should 
only be run after you have completed all of the above procedures (steps 1-5). This program 
clears month-to-date vendor/item information and closes the current period. If it is the last 
period of the year, year-to-date figures are rolled to prior year. When this program is 
complete, you can begin daily procedures in Purchase Orders in the new (current) period. 
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